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About this manual

This user guide is supplied to users of all Xerox Elixir
Suite ElixiForm products.

Where to find the information you need

The following table shows the organization of this
guide.

The left column shows the ElixiForm products this
user guide supports. The tabbed section of this
guide titled "Basics" contains material common to
all  products (collectively referred to as
ElixiForm).

The middle column shows the printers supported
by each ElixiForm product.

The right column shows sections in this guide
which correspond to one or more printer types.
Tabbed sections include information particular to
the printer family.



ABOUT THIS MANUAL

Check the table below to determine the tabbed sec-
tion(s) applicable to your ElixiForm product.

ElixiForm product Supported printers Section

ElixiForm/ElixiSys 2700, 3700**, 4045, 4050, 4090, 4135, | 4135
4235, 4650*, 4700, 4850***,4890*** 4235
9135, 87xx, 97xx, HP, PostScript 4700

ElixiForm Editor For Xerox Dis-| 2700, 3700**, 4045, 4235, 4700, HP, 4235

tributed Printers PostScript 4700
ElixiForm for HighLight Color 2700, 3700**, 40xx, 4135, 4235, HLC
Option (requires ElixiSys) 4650%, 4700, 4850, 4890, 87xx, 97xx, | 4135
HP, PostScript 4235

4700

ElixiForm for HighLight Color 2700, 3700**, 40xx, 4135, 4235, HLC
Plus 4650%, 4700, 4850, 4890, 87xx, 97xx, | 4135
HP, Postscript 4235

4700

* the 4650 is supported only in 300 dpi mode
** the 3700 is supported only in 2700 mode
*** Black and white only
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1. Introduction

ElixiForm is an interactive forms design tool that al-
lows you to create and edit forms in WYSIWYG (What
You See Is What You Get) mode using an IBM PC
AT, PS/2, or compatible computer, a mouse, a sup-
ported monitor, and an optional proof printer.

If you have previously used GEM-based versions of
ElixiForm, you will find the Windows-based version
contains the functionality of the GEM versions plus ad-
ditional features and a new interface. You can easily
import forms created in previous versions of ElixiForm
and edit them in this version.

If you have never used ElixiForm before, you will find
ElixiForm highly intuitive and easy to use.

ElixiForm overview

A form created with ElixiForm is the static (or boiler
plate) component of a form, and contains elements
like lines, boxes, text, and images. The static form is
then merged with variable data for printing on Xerox
production or distributed printers.

The static data adds meaning to the variable data with
which it is merged. For example, the following variable
data from a credit application form:

X 123-456-789 9876.23
X 985-234-980 11813.34

is more meaningful when it is merged with static data
and viewed together:
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INTRODUCTION

Applicant Account Account #  Account Balance
Savings X 123-456-789 $ 9876.23
Checking O $

Money Market 3 985-234-980 $11813.34

CD, IRA ] $

Visa O $

MasterCard [} $

Previously, creating and editing static forms for print-
ing on Xerox production or distributed printers was the
responsibility of applications personnel working on
mainframe computers, who defined form elements us-
ing Forms Source Language (FSL), a language that
describes the location of line, box, text, and image
elements, as well as page size and layout.

Limitations to this approach are:

® Defining and revising an FSL form is complicated
and time-consuming

® Changes to the form are not apparent when add-
ing FSL statements

® The completed FSL file must be compiled on and
proof printed on the high-speed printer.

With ElixiForm, you can see each static form element
as you add or revise the element. With an optional
desktop proof printer, you can generate proofs at your
desk, and using the Converter in the Elixir Desktop,
you can compile your forms on your PC, thus freeing
your Xerox printer from these tasks.

Depending upon the ElixiForm product you have in-
stalled, your screens and options may differ from the
figures displayed in this manual.

1-2
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INTRODUCTION

Customer support

Elixir customer support centers provide telephone
technical assistance for Elixir users during business
hours.

® If you have purchased your Elixir product directly
from Xerox Corporation then you should contact
the Xerox customer support center telephone
number provided by Xerox.

® If you have purchased your Elixir product directly
from Elixir Technologies then contact one of the
support center hotlines.

See the Elixir Getting Started Guide for information
about contacting your support center.

Who should use this guide

This guide is intended for users familiar with Windows
and with Xerox printer and font management
operations.

Users should be familiar with PC peripherals and have
access to reference manuals for PC software and
hardware and for the Xerox printer(s) used.

Conventions

This section describes the following:
e display conventions

® typographical conventions
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Display conventions

ElixiForm adheres to Microsoft Windows conventions
for using menus, menu commands, dialog boxes,
command buttons, icons, and a mouse. See your
Windows manual for more information.

Typographical conventions

The following typographical conventions are used
throughout this guide:

Keystrokes are shown enclosed in < > (angle
brackets). For example:

<Enter>.

Key combinations are denoted by a plus sign be-
tween keys. For example:

<Shift> + <F1> indicates simultaneously pressing
the <Shift> and <F1> keys.

Menu titles are shown in bold. Menu options are
enclosed in [ ] (square brackets). For example:

Select [New] from the File menu.

Commands, options, actions and parameters that
require description are shown in bold, followed on
the next line by the description.

For example:

Delete
Deletes the selected files.

Steps in a procedure are shown in numbered bold
paragraphs. For example:

At the prompt, enter the file name and
extension.

Comments relating to a step (such as this para-
graph) are shown in regular text following the bold
paragraph.

1-4
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e Commands you enter at the DOS prompt display
in larger text. Within DOS commands, variable
names and keys you press are shown in italics.
For example:

CD \ELIXIR <Enter>

On-line help

ElixiForm uses the Microsoft Windows Help program
to provide on-line Help functions.

For more information about Windows Help, either se-
lect the [How to Use Help] option on the Desktop Help
menu or refer to your Microsoft Windows
documentation.

You can display on-line Help from the Desktop in the
following ways:

Bubble Help

Click on an icon with the right mouse button to show
its properties (if applicable) or to display "bubble help”.
Bubble Help is a short description of the icon function
that displays in a bubble extending from the icon.

Context sensitive Help

Click on an icon and press <F1>. If available, the ap-
propriate Help topic displays. If no specific topic is
available, the Help table of contents displays.

Help menu
Select [Help] from the ElixiForm menu bar and choose
one of the displayed topics.

Dialog box HelpDialog box Help

Click on the [Help] button in a dialog box to view an
associated Help topic. Under Windows 95 and Win-
dows NT, right-click on a dialog box option to display
an associated Help topic.
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Help pop-ups and jumps

Within Help topic text, words or phrases underlined in
green are pop-ups or jumps. When you click on a
pop-up topic, a box displays with additional informa-
tion. When you click on a jump, a related Help topic
displays.

Help hypergraphics

Hypergraphics are special graphics within Help files
that contain "hot spot" pop-up topics or jumps. They
most commonly appear either as dialog boxes with
pop-up definitions, Toolboxes with topic jumps, or
menus with topic jumps or pop-up definitions.

Move the cursor over a hypergraphic until a hand dis-
plays, then click on the hot spot to display a pop-up
topic or jump. To close a pop-up topic, click the
mouse button. To return to the original Help topic from
a jump, click on <Back> in the Help file menu.

Organization of this manual

This manual is organized into two main sections:

® Common ElixiForm operations
®  Printer-specific ElixiForm operations.

Common ElixiForm operations section

The front section describes operations common to all
ElixiForm variants and contains the following
chapters:

Chapter 1, "Introduction," is an overview of ElixiForm
software and documentation.

Chapter 2, "ElixiForm basics," provides an overview of
ElixiForm and describes the basic operations for cre-
ating a form.

Chapter 3, "Menu bars", provides information on the
ElixiForm and Work area menu bars.

1-6

ELIXIFORM USER GUIDE



INTRODUCTION

Chapter 4, "ElixiForm defaults," describes how to set
the defaults for your form.

Chapter 5 through 7, "Lines and boxes," "Text opera-
tions," and "Images," are reference sections that de-
scribe in detail how to create and edit elements using
every icon in the Toolbox.

The following appendices and glossary appear at the
back of the book:

Appendix A, "Keyboard shortcuts,” lists all keyboard
shortcuts.

Appendix B, "Conversion chart," shows the supported
conversions for Elixir (.ELX) forms.

Glossary

Printer-specific ElixiForm operations section

Each tabbed section contains ElixiForm information
applicable to the printer type specified by the tab
name. At the time of publication, tabbed sections are
available for the following printers:

4135 - describes ElixiForm functions particular to
printing forms on Xerox 4135 printers, including large
paper support.

4235 - describes ElixiForm for Xerox Distributed Print-
ers functions and capabilities including large paper
size support and gray shade capability which can be
printed on Xerox 4235 distributed printers.

4700 - describes ElixiForm functions particular to
printing forms on Xerox 4700 printers, including full-
color form composition.

HLC - describes ElixiForm functions and capabilities
that include highlight colors which can be printed on
Xerox HighLight Color printers.
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Starting ElixiForm

To start ElixiForm from the Elixir Desktop, double-
click on the ElixiForm icon. The ElixiForm main screen
displays.

Exiting ElixiForm

To exit ElixiForm and return to the Desktop either:

® press <Alt> + <F4>

® select [Exit] from the File menu

®  double-click on the [Close] button (the top left cor-
ner of the screen)
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2. ElixiForm basics

This chapter describes the ElixiForm Work area and
basic operations.

Starting ElixiForm

To view the ElixiForm main screen, open the Elixir
Desktop and double-click on the ElixiForm icon.

The ElixiForm window displays.

Toolbox Work Area Message Work Area ElixiForm
Toolbar

menu bar menu bar

Area

18503 11.00

Work area

Figure 2-1. ElixiForm window
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ElixiForm window

The ElixiForm windows contains the following
features:

Toolbox

Toolbar

ElixiForm menu bar
Work area menu bar
Message area

Work area

Toolbox <F10>

The Toolbox displays on the left of the main Work
area and contains the Select/Edit, Line, Path, Box,
Circle, Text and Image tools.

If you cannot see the Toolbox, pull down the Window
menu and select [Toolbox] or press <F10>.

Tools

Message
areal

Tool options

Preview
panel

Figure 2-2. Toolbox

Select a tool to display its options in the Toolbox. A
short description of the tool displays in the Message
area, and the Preview panel displays your option
selections.

2-2

ELIXIFORM USER GUIDE



ELIXIFORM BASICS

Select tool

Color options may or may not display, depending on
the color selected in the Page Properties dialog box.

Selects form or data elements for editing.

Copy

Copies any form element or design object.

Delete

Deletes the selected element(s). When a data ele-
ment is deleted, it is only removed from the Work
area. The entry in the Document window is preserved.

If you inadvertently delete an element, immediately

select [Undo] from the Edit menu to restore the de-
leted element to your form.

Group filter options

The Group Filter options from left to right are: [Line],
[Box], [Text], [Data Tag], and [Image].

Select one or more options to exclude the correspond-
ing element from group options such as moving or de-
leting. Select the option(s) a second time to turn the
filter off. See the "Grouping elements" section for in-
formation on grouping elements.

Number of Copies

Specify a value by clicking on the up or down arrows
or click in the numeric display box and enter a
number.

Press and hold <Ctrl> while clicking to
increase/decrease the value by 10.
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Movement Selection

Select a movement direction for moving or copying
elements:

® [Horizontal only] - cursor moves horizontally with
element(s) attached

® [Vertical only] - cursor moves vertically with ele-
ment(s) attached

®* [Free] - cursor moves in any direction with ele-
ment(s) attached

Copy - Horizontal Distance

Specify a value by clicking on the up or down arrows
or click in the numeric display box and enter a
number.

Press and hold <Ctrl> while clicking to
increase/decrease the value by 1.

Copy - Horizontal Distance - On/Off

Enables the [Copy - Horizontal Distance] option. Se-
lect this option a second time to disable this feature.

Sticky Lines - On/Off

Perpendicular lines with ends that connect remain
stuck together when you move one of the lines. Lines
attached to box sides remain connected when you
resize the box.

Select this option a second time to disable this fea-

ture. See the “Lines and boxes” chapter for more
information.

Copy - Vertical Distance

Specify a value by clicking on the up or down arrows
or click in the numeric display box and enter a
number.

2-4
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Line tool

Press and hold <Ctrl> while clicking to
increase/decrease the value by 1.

Copy - Vertical Distance - On/Off

Enables the [Copy - Vertical Distance] option. Select
this option a second time to disable this feature.

Draws horizontal, vertical, and free lines; and specifies
line properties. See the "Lines and boxes" chapter for
more information on the options described below.

Line - Direction

Select the drawing line’s direction: [Horizontal only],
[Vertical only], [Horizontal and Verticall], or [Free].

Custom Line/Border Thickness

Specify a value (in dots) by clicking on the up or down
arrows or click in the numeric display box and enter a
value (maximum 99 dots).

You can also select: standard [Thin] 2 dot, [Medium] 4
dot, or [Thick] 6 dot line widths.

Line - Style

Select the line style: [Solid], [Dashed], or [Dotted].

Line - Color

Select a box border color from the palette in the Color
dialog box, then click on [Close]. The selected color
displays in the bottom half of the icon.
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Box tool

Draws boxes and specifies box properties. See the
"Lines and boxes" chapter for more information on the
following options.

Box Predefined Shape

Select the box corner style: [All corners square], [All
corners rounded], [Top rounded/bottom square], [Top
square/bottom  rounded], [Left rounded/bottom
square], or [Left square/right rounded].

Box - Positioning - Center/Top Left

Select the top half of this option to center the top left
corner of the box on grid coordinates. Select the bot-
tom half of the option to snap the top left corner of the
box flush to grid coordinates.

Box - Shape - Oblong/Square

Select the top half of this option to draw boxes as rec-
tangles. Select the bottom half of this option to draw
boxes as squares.

Box - Diagonals

Select the diagonal line pattern for inside the box:
[None], [Left], [Right], or [Both].

Custom Line/Border Thickness

Specify a value (in dots) by clicking on the up or down
arrows or click in the numeric display box and enter a
value (maximum 99 dots). Specify [0] to apply an in-
visible border to a shaded box. Unshaded boxes
must have a border width of [1] or higher.

You can also select: [Thin], [Medium], or [Thick] box
line widths.
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Box - Line/Border Style

Select the line style: [Solid], [Dashed], or [Dotted].

Box - Border/Split Thickness and Style

Select width and style options:

®* [Border] - sets the width and style of the box
border

® [Horizontal Splits] - sets the width and style of the
horizontal box splits

® [Vertical Splits] - sets the width and style of the
vertical box splits

Box - Horizontal Split

Select this option, then click on the up or down arrows
or enter a value in the numeric display box to specify
the number of equal horizontal portions to divide the
box into. The minimum value is 1 (hollow) and the
maximum value is 40.

Select this option a second time to disable horizontal
box splits.

Box - Vertical Split

Select this option, then click on the up or down arrows
or enter a value in the numeric display box to specify
the number of equal vertical portions to divide the box
into. The minimum value is 1 (hollow) and the maxi-
mum value is 40.

Select this option a second time to disable vertical box
splits.

Box - Color

Select a box border color from the palette in the Color
dialog box, then click on the [Close] button. The se-
lected box color displays in the bottom half of the icon.
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Text tool

Box - Fill Color

Right-click to select a box fill color from the palette in
the Color dialog box, then click on the [Close] button.
The selected box fill color displays in the bottom half
of the icon.

Object Fill Pattern/Shading

Select a shade pattern from the Pattern dialog box. All
boxes you draw contain this shading until you change
it, using the same procedure. Select [Hollow] for no
shading.

Box - Corner Radius

Specify a value by clicking on the up or down arrows
or click in the numeric display box and enter a value
(maximum 299 pels).

You can also select: [Small] 10 pels, [Medium] 20
pels, [Large] 30 pels, or [Maximum]. This option does
not apply when all corner styles are 90 degrees.

Select text attributes for form elements. See the "Text
operations" chapter for more information on the fol-
lowing options.

Text - Direction

Select a text display direction:

[Across] - left to right
[Down] - top to bottom
[Back] - right to left
[Up] - bottom to top
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Text - Inter-character/Inter-word Spacing

Select a display spacing option:

® [Inter-character] - justifies all text blocks by in-
creasing or decreasing the amount of space be-
tween characters. This makes the form easier to
read when converted to OGL, but takes longer for
the form to print.

® [Inter-word] - justifies all text blocks by increasing
or decreasing the amount of space between
words.

These options are global features. Selected options
apply to all text blocks on the form.

The [Inter-character] or [Inter-word] options apply to a
form only when you convert the .ELX file, when this is
a valid option for your conversion. See your ElixiSys
Desktop and Converters User Guide for more
information.

Text - Word Wrapping

Wraps text between the boundaries set in the [Col-
umn Width] option. You can also select the [Box Text]
option and draw a visual box on your form to contain
the text. Select this option when text is justified.

Text - Remove Redundant Spaces

Removes redundant spaces, relative shifts and car-
riage returns from text blocks that have the [Text -
Word Wrapping] option selected.

Text - Split String

Splits a single block of text into two separate text
blocks.
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Text - Justification

Specify the justification for each text block: [Left Justi-
fication], [Center Justification], [Right Justification], or
[Full Justification].

The [Wrap Text] and [Box Text] or [Column Width] op-
tions must be selected for text justification.

Text - Positioning

When the [Wrap Text] and [Box Text] options are se-
lected, specify the vertical positioning of a text block
as [Top], [Center], or [Bottom].

Use this option with the [Text Justification] and [Box

Text] options to place text in nine positions within the
box.

Text - Lines per Inch

Specify a vertical lines per inch (LPI) value by clicking
on the up or down arrows or click in the numeric dis-
play box and enter a number. Press and hold <Ctrl>
while clicking to increase/decrease the value by 1.0.
This value you affects the current block of text and
any subsequent blocks of text entered using the same
font.

To return the lines per inch to the default for the cur-

rent font, use the down arrow to decrease the LPI
value to [0] or press <Del>.

Text - Lines per Inch - ON/OFF

Enables the [Text - Lines per Inch] option. Select this
option a second time to disable this feature.

Text - Text Color

Select a text color from the palette in the Color dialog
box, then click on the [Close] button. The selected
color displays in the bottom half of the icon.
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DocuTag/DataMerge - Data Tags - ON/OFF

Displays the Data Tagging dialog box which allows
you to add data tags to forms for use with Elixir's
DocuTag or DataMerge products. Select this option a
second time to disable this feature.

See your Elixir DocuTag User Guide or Elixir Da-

taMerge User Guide for more information on creating
data tags and tag lists.

Text - Column Width

Specify the width for a text block by clicking on the up
or down arrows or click in the numeric display boxes
and enter a number. Press and hold <Ctrl> while
clicking to increase/decrease the value by 1.0. Values
that exceed the form limits are not accepted.

You must select the [Wrap] text option when using
these options. When these options are set to [0.00],
text entered is bound only by the width and height of
the form.

Select the [Box Text] option along with these options

to display a visual guide box with the width and height
dimensions you specify.

Text - Draw Column Box Boundaries

Select this option after selecting the [Box Text] option
to define column boundaries for text by drawing a vis-
ual box in the Work area. Place the cursor in the
Work area and press and hold down the mouse but-
ton. Drag the box that displays and release the
mouse button at the bottom right of the box. This box
does not print.

Select the [Wrap Text] option to wrap text at the
boundary of the text box defined by this option. Select
the [Text Positioning] option to position text within the
text box.
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Text - Column Height

Specify the height for a text block by clicking on the up
or down arrows or click in the numeric display boxes
and enter a number. Press and hold <Ctrl> while
clicking to increase/decrease the value by 1.0. Values
that exceed the form limits are not accepted.

You must select the [Wrap Text] option when using
these options. When these options are set to [0.00],
text entered is bound only by the width and height of
the form.

Text - Set Column Width/Height to Define Box -
ON/OFF

Select this option when using the [Draw Text Box] or
[Column Width] and [Column Height] options to enter
text in predefined areas or "boxes." Select this option
a second time to enter free text which is bound only by
the width and height of the form.

Box boundaries are defined by entering values in the
[Column Width] and [Column Height] options or by
drawing a box manually using the [Draw Text Box]
option.

Font Type

Click on this button until the desired font type displays:
® [f] - Elixir-version fonts

® [T]- True Type fonts
®* [a]- ATM fonts

Text - Add/Remove Font from List

Select a font action. The dialog box that displays de-
pends on your selection in the [Font Type] option.

® [+] - displays the Add Fonts, Select True Type
fonts, or Select ATM fonts dialog box; select a
font(s) to add to the current Font List, then click
on the [ADD] button
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® |[-] - displays the Replace Font, Select True Type
Fonts, or Select ATM Fonts dialog box; select a
font(s) to remove from the current Font List, then
click on the [DEL] button. If the font is in use on
the form, select a replacement font from the Re-
place Font dialog box.

Text - Load Font List/Merge Font List/Save Font
List

Select a Font List action:

® [down arrow] - displays the Load Font List dialog
box

® [double arrows] - displays the Merge Font List dia-
log box; add fonts to the current Font List by load-
ing another Font List

® [up arrow] - displays the Save Font List dialog

box; enter a new file name for the current font list,
or rename an existing font list

Text - Soft Keyboard

Enters characters that are not available on a standard
keyboard. See the "Text operations" chapter for more
information on using the soft keyboard.

Font Preview Panel

Displays the fonts available in the current Font List.
Click on the up or down arrow or use the scroll bar to
scroll through the list to change the current font.

Fonts in use on a form are denoted by a diamond
character to the left of the font name.
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Image tool

Adds Elixir-format screen (.LP3) or printer (.LW8) im-
ages, bitmaps (.BMP), or logos to a form. See the "Im-
ages" chapter for more information on the options
described below.

Image - Name

Displays the name of the selected image.

Image - Size
Horizontal/Vertical

Displays the horizontal and vertical sizes of the image
in the units selected in the Ruler in the Toolbar. See
the "Toolbar" section for more information.

Image - Color

Select an image border color from the palette in the
Color dialog box, then click on the [Close] button. The
selected image color displays in the bottom half of the
icon.

Image - Fill Color

Right-click to select an image fill color from the palette
in the Color dialog box, then click on the [Close] but-
ton. The selected image fill color displays in the bot-
tom half of the icon.

Image - Load

Select an image to add to your form from the Load Im-
age dialog box.
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Toolbar
The Toolbar displays across the top of the Work area
and contains the following options:
[t e [EE 3 1% e Ra Rl L= B
Figure 2-3. Toolbar
Digital ruler

Displays the horizontal and vertical position of the
screen pointer relative to the top left corner of the
screen (0,0).

Current object - Shape

Displays an icon representing the element type the
cursor is currently closest to.

Current object - Start Coordinates

Displays the x,y coordinates of the currently selected
element.

Current object - Dimensions

Displays the width and height of the currently selected
element.

Graphic ruler <F3>

The graphic ruler displays along the top and left edges
of the Work area in the units selected in the [Ruler
measure] option.

To display the graphic ruler either:

® click on the Toolbar Graphic Ruler
® select [Ruler] from the View menu
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A check mark appears in the menu next to the se-
lected option.

Select this option a second time to remove the graphic
ruler.

Right-click on the Ruler in the Toolbar to display the
Ruler Options dialog box.

Grid Display <F4>

The grid helps you place and align form and data ele-
ments accurately. It overlays the Work area to allow
exact placement of elements, but does not print.

To display the grid in your Work area either:
® click on the Toolbar Grid Display icon

® press <F4>

® select [Grid] from the View menu

A check mark appears in the View menu next to the
selected option.

Select this option a second time to remove the grid.

Right-click on the Toolbar Grid Display icon to display
the Grid Setting dialog box.

Snap to Grid <F5>

Places elements accurately on the grid.
To use the snap to grid option either:

® click on the Toolbar Snap to Grid icon
® press <F5>
® select [Snap to Grid] from the Options menu

Select this option a second time to disable this feature
- elements become free floating and are moveable
anywhere on the screen.

Right-click on the Toolbar Grid icon to display the Grid
Setting dialog box.
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Long Crosshair <F6>

Zoom in/out

Displays horizontally and vertically from the cursor on
the form, and helps you place elements on the form
more precisely.

To display the long crosshair:

® click on the Toolbar Long Crosshair icon
® press <F6>
® select [Long Crosshair] from the View menu

A check mark appears next to the option in the menu
when it is selected. Select this option a second time
to remove the long crosshair.

Undo/Redo

To zoom in on (magnify) an area of the Work area,
click on the [+] button on the right side of the Zoom
icon in the Toolbar. The highest magnification is [8x].

To zoom out on (reduce the magnification of) an area
of the Work area, click on the [-] button on the left side
of the Zoom icon in the Toolbar. The lowest reduction
is [-8x].

You can also use the <+> and <-> keys on the nu-
meric keyboard to zoom in and out.

To cancel your most recent operation:

® click on the Toolbar Undo icon
® press <Ctrl> + <Z>
® select [Undo] from the Edit menu

To cancel your most recent Undo operation:
® click on the Toolbar Redo icon

press <Shift> + <Ctrl> + <Z>
® select [Redo] from the Edit menu
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Spell Check

Checks the spelling of the active form. See the "Text
operations" chapter for more information.

Show/hide Toolbox

Hides the Toolbox.

To redisplay the Toolbox:

® click on this icon a second time

® press <F10>

® select [Toolbox] from the Window menu

User preferences are described in the "ElixiForm de-
faults" chapter.

Menu bars

ElixiForm provides two menu bars for accessing
options:

®  ElixiForm menu bar
® \Work area menu bar

Select a menu to display its options, then select an
option from the pull-down menu.

See the "Menu bars" chapter for more details and
information.

Creating a form

Following are suggestions you should consider when
creating a form.
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Designing a new form

Sketching the form on paper before drawing it on the
screen makes element sizing and placement easier.

Reproducing an existing form

If you are creating a form from an existing form, have
the original form in front of you as you are recreating it
on the screen. Use a ruler to measure the margins,
lines and other form elements, then use the on-screen
rulers for precise placement of each element.

You can also use Elixir's ElixirScan product to scan an

existing form for conversion to Elixir format, then edit
the form using ElixiForm.

Designing a form to fit in a window envelope

If you are designing a form to fit a window envelope,
first sketch it, fold it and measure it against the enve-
lope window to ensure proper display.

Designing a form for merged data

If your form will subsequently be merged with variable
data, print the formatted data to see how it prints on
the page; it is easier to design a form around data
than to redesign the form.

Loading a form

ElixiForm allows you load a new or previously saved
form, or to merge form groups to create a new form.
Only one form at a time can be loaded into ElixiForm.
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Loading a new form <F9 >

To load a new form:

1.

Select [New Form] from the File menu.
The Page Properties dialog box displays.

See the "ElixiForm defaults" chapter for informa-
tion on the Page Properties dialog box.

Select page defaults, then click on [OK].
The Page Databasing dialog box displays.

For information on the Page Databasing dialog
box, see the "ElixiForm defaults" chapter.

Enter optional information for the new form,
then click on [OK].

A new, untitled form displays in the work area.

Loading a saved form <F8 >

If you are loading a form that was created in a GEM
version of ElixiForm, see "Loading GEM forms" in this
section before loading the form.

To load a previously saved form:

1.

Select [Load Form] from the File menu.
The Load Form dialog box displays.
Select the form to load, then click on [OK].

The form displays in the Work area.

If a referenced image is missing, a replacement im-
age displays. To delete the image from the form, se-
lect the replacement image then press <Del>.
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Merging a form

Loading GEM forms

For forms created with ElixiForm prior to version 3.0,
you can either maintain the original boxed text format-
ting or use the new Windows box text formatting. You
can also either maintain the original color mode or se-
lect a new color mode.

® For the currently loaded GEM form only, select
text formatting and color mode options using the
Text and Fonts options dialog box and the Page
Properties dialog box.

® For all subsequently loaded GEM forms, select
text formatting and color mode options using the
GEM Forms Load Defaults dialog box.

See the "ElixiForm defaults" chapter for information

about GEM Forms Load Defaults, Text and Font Op-
tions and Page Properties dialog boxes.

group

ElixiForm allows you to merge a form into the current
work area without replacing work area contents. See
the "Grouping elements" section in this chapter for
more information about saving a form group.

ElixiForm only merges objects that fit within form
boundaries. Before using the [Merge Form Group]
option, ensure that there is sufficient work area space
available to prevent the elements from overlapping or
falling outside form boundaries.

To merge a form group:

1. Select [Merge Form Group] from the File
menu.

The Load Form Group dialog box displays.
2. Select the form to merge, then click on [OK].
Although ElixiForm allows you to merge the cur-

rently loaded form with the same form, this is not
recommended as form elements may overlap.
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You cannot undo a [Merge Form Group] operation.

Loading a form template

A form template is an .ELX form file that is loaded as
an overlay or visual guide for designing a new form.
The template does not become a part of the new
form; only the new form elements are saved.

You can load more than one form file template into the
Work area, although retrieving multiple form tem-
plates requires appreciably more memory.
Proof-printing a form comprising one or more tem-
plates also prints the templates. To proof- print a form
without the templates, save and reload the form with-
out the templates, then proof-print the reloaded form.
To load a form template:

1. Select [Load Form Template] from the File
menu.

The Load Form Template dialog box displays.

2. Select the template to use, then click on [OK].

Selecting template defaults

To select form template defaults:

1. Select [Template Options] from the Options
menu.

The Template Options dialog box displays.
2. Select display defaults, then click on [OK].

The Template Options dialog box contains the follow-
ing options:

Color
Select a display color for the template from the drop-
down list.
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Object Filters

Select the form object(s) to display: [Show Lines],
[Show Boxes], [Show texts], [Show Images], [Show
Circles], or [Show Paths].

Disable template object selection
Prevents form template objects from being selected or
modified.

Lock template
Keeps the current template loaded at all times.

Adding form elements

You create forms in ElixiForm by adding elements
such as lines, paths, boxes, circles, text and images.
You can apply different attributes to any form element
by selecting options from the Toolbox. Elements can
be placed anywhere on the form.

If you need to modify an element that is already on the
form, right-click on the element and apply new proper-
ties using options in the Toolbox.

For detailed information about adding or modifying a
form element, see the "Lines", "Shapes", "Text opera-
tions" or "Images" chapters.

Using color

Form color usage depends upon the color mode of
the printer you use for final printing. You must select
ElixiForm's color mode before creating a form. This
ensures that only the colors available on your printer
are used.

To select form color mode:

1. Select [Page Properties] from the Options
menu.
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The Page Properties dialog box displays. See the
"ElixiForm defaults" chapter for more informa-
tion.

2. Select the color mode, then click on [OK].

Saving a form with a new name <F7 >

To save an existing form either with a different name
or to another directory:

1. Select [Save Form As] from the File menu.
The Save Form As dialog box displays.

2. Enter information, then click on [OK].

Saving a new form <Ctrl> + <S>

To save a new form;
1. Select [Save Form] from the File menu.

The Save Form dialog box (similar to previous fig-
ure) displays.

2. Enter a file name, then click on [OK].

If you plan to convert the form to a different for-
mat, save the form with a maximum six-letter file
name; longer file names truncate upon conver-
sion and can overwrite existing files.

Modifying a form

You can update previously-created forms or make a
new one by modifying the form and saving it with a
new name.
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Editing elements

ElixiForm allows you to edit individual elements by
moving, copying or deleting form elements, and by
changing element properties.

* To move, copy or delete an element, right-click on
the element to select it, then perform the desired
operation.

® To change the properties of an element, double
right-click on the element and make the changes
desired.

Editing procedures are similar for lines, paths, boxes,

circles, images and text, as described in later
chapters.

Shifting elements

You can shift all or selected elements on a form. It is
easier to see the elements shifting if you first select
the grid option.

To shift form elements, hold down the <Ctrl> key and
use the arrow keys to shift elements up, down, left or
right. You can also shift elements using the direction
keys on the numeric keypad by first pressing <Num
Lock>.

Grouping elements

ElixiForm groups form elements for editing purposes.
Once a group is defined, you can edit it like a single
form element.

ElixiForm undoes a group one element at a time. For
example, if you delete a group and then click on the
Undo icon, the elements comprising the group reap-
pear one at a time.
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Defining a group

To define a group:

1.
2,

Select the Select/Edit tool in the Toolbox.

Move the screen pointer near the elements
you want to group.

Click and drag the dotted line until it encloses
the desired elements, then release the mouse
button.

Boxes appear around or inside each grouped ele-
ment. Grouped text appears in square brackets.

Move, copy or delete the group as a single
element.

To change the properties of one or more grouped
elements, right-click on the element(s) and select
desired properties from the Tool box.

You can also exclude any or all occurrences of a
grouped element:

To exclude all occurrences of an element,
select a group filter option before grouping.

To exclude any one element from the group,
shift-click on the element after grouping.

To include the element again, shift-click on
the element a second time.

Saving a form group

ElixiForm allows you to select a group in an existing
form and save it as a separate form file. You can then
edit the file, or use it as a template for other forms.

This feature is helpful for reusing standard elements
such as headers and footers in other forms. You can
also merge selected elements from different forms to
create another form. See the "Merging a form group"
section in this chapter.
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To save a form group:

1.

Undol/redo feature

Define the group as described in the above
section.

Select [Save Form Group] from the File menu.

Enter a filename in the dialog box, then click
on [OK].

The form group saves to the forms directory
specified.

ElixiForm allows you to undo or redo an operation.

To cancel your most recent operation:

b

click on the Toolbar Undo icon
press <Ctrl> + <Z>
select [Undo] from the Edit menu

To cancel your most recent Undo operation:

-,

click on the Toolbar Redo icon
press <Shift> + <Ctrl> + <Z>
select [Redo] from the Edit menu

When you cancel a group operation, ElixiForm undoes
the operation one element at a time.

Deleting a form

To delete a form:

1.

Select [Delete Form] from the File menu.

The Delete Form dialog box displays.

Select the name of the form to delete, then
click on [OK]

The form deletes.
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Renaming or moving a form

To rename or move a form;

1.

Select [Rename/Move form] from the File
menu.

The Rename/Move Form dialog box displays.

Select the form you want to rename/move,
then click on [OK]

A supplemental dialog box displays the directory
and name of the form.

T arget directory doesn't exist.

From: CAFLIXIANFORMSAELIXIR\DEMOATAX ELX

To:  |CAELIKIBAFORMSAELIXIBADEMOABOND ELX

Figure 2-4. Rename/Move Form dialog box

3.

Enter a new directory name or a new file
name, then click on [OK].

The form must have an .ELX extension to load
into ElixiForm.

Proof printing a form

You can proof print your form on a PCL 4 or compati-
ble printer from the Print dialog box, or on an XES
printer using the Print Special dialog box.

Dotted and dashed lines printed on an HP or XES
proof printer may appear different when printed on a
Xerox production printer.
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Using the Print dialog box

To proof print a form:
1. Pull down the File menu and select [Print].

The Print dialog box displays.

Fent Fonty Load Fonls.
a5 Graphio + Alwags Unce  Hever

Figure 2-5. Print dialog box

2. Select/enter printer information, then click on
[OK].

The Print dialog box contains the following options:

Printer
Select a PCL 4 or compatible printer based on the fol-
lowing considerations.

®  Elixir HP Driver
Provides optimal Elixir form proof-printing, includ-
ing increased printing speed and the ability to
print shaded boxes using HP printer shading
calls, store a form as a macro and call printer-
resident fonts.

ELIXIFORM USER GUIDE 2-29



ELIXIFORM BASICS

e PCL4
PCL 4 printers print a maximum page size of 8 x
10.33 inches. If your form boundaries fill an 8.5 x
11 inches page, the outer margins of your form
will not print on a PCL 4 printer.

For accurate positioning, shift the print image on
the page using the [Page Shift] option.

® PDF format
If you installed Adobe's PDFWriter printer driver
on your PC, you can convert your form to PDF
format by selecting [PDF ON FILE:] from this win-
dow. You are then prompted for a directory and
file name.

Set Elixir HP Driver as default printer
Sets the Elixir HP Driver as the default printer.

Orientation
Select form print orientation; [Landscape] or [Portrait].

Page shift
Enter the number of dots to shift your printer output
horizontally or vertically:

® [Xshift] - image moves horizontally
® [Yshift] - image moves vertically

Use a negative shift value to shift the print output to
the left, or up; and a positive value to shift your print
output right, or down.

Copies
The number of print copies.

Print to file

Prints your file to disk for proof-printing. To print a
form to a disk file for proof-printing, all proof printer
versions of fonts used in the form must reside on the
proof printer. Click on [OK], then enter the path and
file name in the Print to File dialog box.

Autogen Output Name
ElixiForm automatically names your file.
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Print Fonts as Graphic

Rasterizes fonts as graphics. Printing fonts as graph-
ics requires less printer memory, speeding up printing
time.

Load Fonts
Select one of the following font load options:

* JAlways] - downloads fonts every time form
printed

® [Once] - downloads fonts as soft fonts identified
by index number; fonts then managed by and ac-
cessed through the Windows Control Panel

®* [Never] - calls the index number of soft fonts re-
siding on printer; no new font are downloaded

If you select [Once] or [Never], make sure to use the

same font list in your form as on the printer; if not, the
index number may represent a different font.

Elixir HP driver

The Elixir HP Driver can be used with ElixiForm and
ElixiSys desktop products only for optimal proof print-
ing of Elixir forms.

Using the Elixir HP Driver allows you to:

® increase proof-printing speed

® print light, medium and dark shaded boxes using
HP printer shading calls

® support of storing a form as a macro
®  call printer resident fonts

When you select this option, the [Load Fonts] option
displays.
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To use the Elixir HP driver:

1.

Select [Elixir HP Driver on LPT1] as your
printer in the Print dialog box, then click on
the [Setup] button.

The Elixir HP Driver dialog box displays.

Figure 2-6. Elixir HP Driver dialog box

2. Select/enter information, then click on [OK].

The Elixir HP Driver dialog box contains the following
options:

Printer Type
Select your printer type:

[HP LJ 1] - for HP LaserJet Il or compatible print-
ers (default)

[HP LJ Hll] - for HP LaserJdet Il or compatible
printers

[HP LJ 4] - for HP LaserJet 4 or compatible
printers
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Printer Port
Select the printer port: [LPT1] (default), [LPT2], or
[LPT3].

Output Mode
Select the output mode:

® [Use PCL Commands] - uses standard PCL
commands

® [Use Rasterization] - for forms that contain ele-
ments not supported by Xerox printers, such as
circles and paths (default)

Font Substitution Tables

Uses printer resident fonts on your form. Enter the
name of the font substitution table in the [Selected Ta-
ble] option or click on the [Fonts] button and select
one in the Select Font Table dialog box.

A font substitution table contains a list of font names
and the corresponding escape sequences. If there is
a match for a font in the selected font table when the
Elixir HP driver prints your form, the escape sequence
is sent the printer and the printer font is not
downloaded.

The format for each entry is:
fontname hp escape-sequence

where fontname is the name of the font and hp
escape-sequence is the escape sequence.

The following example shows a sample font substitu-
tion table. Records beginning with a semicolon are
comments only. A backslash (\) can be used in place
of the escape character.
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; ELIXIR.DRV font table for HP lll Si printer
; Bitstream fonts

; BX113006 HEXXBP Swiss721-BoldSWA

; Symbol Set:Roman-8 Fixed Pitch Scale (7.0) Upright Bold Uni
vers

HEO7BP \(8U\(s1p7.0v0s3b4148T

; BX113006 HEXXBP Swiss721-BoldSWA

; Symbol Set:Roman-8 Fixed Pitch Scale (8.0) Upright Bold Uni
vers

HEO8BP \(BU\(s1p8.0v0s3b4148T

; BX113006 HEXXBP Swiss721-BoldSWA
; Symbol Set:Roman-8 Fixed Pitch Scale (11.0) Upright Bold Uni

vers
HE11BP \(8U\(s1p11.0v0s3b4148T

User Defined Shading Patterns

Specify the exact shading used for Light, Medium and
Dark shading patterns printed on your HP printer. En-
ter the shading pattern table to use in the [Selected
Table] option or click on the [Shading] button and se-
lect one in the Select Shading Table dialog box.

The format for each entry is:
shade shading call

where shade is Light, Medium or Dark and shading
call is the HP shading call for that shade.

The following example shows a sample user defined
shading table. Records beginning with a semicolon
are comments only.

; The following is a working example of user defined
; shading table
; The program does some syntax checking

LIGHT \*c.g12W000001000004000888002200
MEDIUM \*c.g12W000001000004000888aa2255
DARK \*¢.g12W000001000004000855ddaadd
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Inverse Fonts

Uses reversed fonts which are resident on the printer.
Enter a font inversion table in the [Selected Table] op-
tion or click on the [Inverse] button and select one in
the Select Inversion Table dialog box.

A font inversion table contains a list of font names. If
there is a match for a font when the Elixir HP driver
prints your form, the reverse font on the printer is used
and the printer font is not downloaded.

The following example shows a sample font inversion
table. Records beginning with a semicolon are com-
ments only.

; This is an example of a Font Inversion Table
; All text printed with the fonts listed below will be printed
; in white on a black background

TR20BP
HE24BP
SY12NP

Create as Macro/Macro ID Number

Stores your form on the HP printer as a macro under
the number entered in the [Macro ID number] option.
You can then print the form by sending down the ap-
propriate escape sequence to execute the macro.

Using the Print Special dialog box

The Print Special dialog box allows you to print to an
XES proof printer without using a Windows driver.

XDP proof printing is only available if the following
key(s) are attached: ElixiSys Desktop, ElixiSys Desk-
top for HighLight Color, ElixiSys Converter for XDP,
ElixiForm/ElixiSys and HighLight Color Plus.

To proof print a form on an XES proof printer:

1. Select [Print Special] from the File menu.
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The Print Special dialog box displays.

Frinter Prnter Poit
XES 2700 = LT
KES 4045 LB T2

+ KES 4235 LET3
RES 4700

Prnt to File

Input Traw Dutput Trap: Page Copies:
i i n]

Sides Printed: Printer Options:
+ Simplex * . Prnt
Buplex Store on Printer
Buplex-Inverted Both

, Constant
Feset after this page

Format: Printer Font Loading:
*ASCH * . Always

EBEDIC dnce

SmartBox Mever

UDK Escape Character: Page Shift
Xehii: [0 ]
Yhift [0 |

Figure 2-7. Print Special dialog box

2. Select/enter print options, then click on [OK].

The Print Special dialog box contains the following op-
tions. Options that do not apply to your printer are
grayed out.

Printer
Select your output printer; [XES 2700], [XES 4045],
[XES 4235], [XES 4700].

The 4045 printer does not print characters in cell posi-
tions below HEX 20.

Printer Port
Select the printer port: [LPT1], [LPT2], [LPT3].

Print to File

ElixiForm creates a print file with a .PRN extension.
The stem name of the file is formname.PRN where
formname is the name of the currently loaded form.
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The output .PRN files are written to the following
directories:

Printer Output directory
XES 2700 \ELIXIR\PRINTS\X27PRINT

XES 4045 \ELIXIR\PRINTS\X45PRINT
XES 4235 \ELIXIR\PRINTS\X42PRINT
XES 4700 \ELIXIR\PRINTS\X47PRINT

Input Tray
Enter the input tray number.

Output Tray
Enter the output tray number.

Page Copies
Enter the number of copies

Sides Printed
Select the sides for printing:

® [Simplex] - single-sided printing

® [Duplex] - two-sided printing with the second page
turned over sideways

® [Duplex-Inverted] - two-sided printing with the
page turned over top to bottom

Printer Options
Select the printer options:

® [Print] - sends your file to the printer

® [Store on printer] - stores your file on the printer
hard disk for future use

® [Both] prints your form and then stores it on the
printer.

® [Constant] - stores the form in the printer's mem-
ory until the printer is turned off. Only one page
can be stored in this way.
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Format
Select the output format:

® [ASCII] - produces ASCII output for writing to disk

e [EBCDIC] - produces EBCDIC output for Xerox
printers connected to your PC via coaxial cable
and a protocol converter

® [SmartBox] - for PCs connected to the printer
through a SmartBox or Agile protocol converter

Printer Font Loading

When you proof print your file, all proof printer ver-
sions of the fonts used in the form must be resident
on the proof printer.

Select one of the following font load options:

® JAlways] - downloads fonts every time form
printed

® [Once] - downloads fonts as soft fonts identified
by index number; fonts then managed by and ac-
cessed through the Windows Control Panel

® [Never] - calls the index number of soft fonts re-
siding on printer; no new font are downloaded

If you select [Once] or [Never], make sure to use the
same font list in your form as on the printer; if not, the
index number may represent a different font.

Font (.FNT) files are independent of print (.PRN) files
and are written to the following directories:

Printer Output directory
XES 2700 \ELIXIR\PRINTS\X27PRINT

XES 4045 \ELIXIR\PRINTS\X45PRINT
XES 4235 \ELIXIR\PRINTS\X42PRINT
XES 4700 \ELIXIR\PRINTS\X47PRINT

UDK Escape Character

Enter the ASCII representation of the UDK escape
character used in your XES file for printing on a Xerox
4045 or 2700 printers (default is decimal 27).

2-38

ELIXIFORM USER GUIDE



ELIXIFORM BASICS

Page shift
Enter the number of dots to shift your printer output
horizontally or vertically:

®  [Xshift] - image moves horizontally
® [Yshift] - image moves vertically

Use a negative shift value to shift the print output to

the left, or up; and a positive value to shift your print
output right, or down.

Printing a disk print file

To print a form that has been written to disk, exit Elixi-
Form and display the DOS prompt. Specify the direc-
tory of the print file, and use the DOS COPY
command to copy the .PRN file to your active parallel
port (for example, LPT1).

COPY filename.PRN LPT1 <Enter>
where filename is the stem name of the disk file.

Use the COPY/B command when printing HP PCL
files from disk.

Editing multiple forms

ElixiForm allows you to group multiple form files to-
gether for editing with the document editing feature.
An Elixir document is a group of Elixir forms (.ELX)
referenced in a text file with a .DAT extension and re-
sides in the Elixir Documents folder.

Elixir document files are created/edited with any stan-
dard text editor or with the Elixir Desktop. See your
Elixir Desktop for AFP User Guide for more
information.

To load a .DAT file:

1. Select [Open DAT File] from the File menu.
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The Open Dat File dialog box displays.

2. Select the document to open, then click on

[OK].

To select .DAT file form(s) to edit:

1.

Select [Load Form] from the File menu.

The Load Forms from Dat File dialog box
displays.

Select the form(s) to edit, then click on [OK].

Select [Merge Form Group] from the File menu to
merge pages/forms on top of the currently loaded
form. Select the form(s) to merge, then click on
[OK].

Select [Close DAT File] from the File menu to re-
turn to single page/form loading mode. Select
[Filing Options] from the System menus to set the
default directory for .DAT files.

Fast keys

Fast keys are available for many ElixiForm operations.
See the "Keyboard shortcuts" appendix for a complete
listing.

Exiting ElixiForm

To exit ElixiForm and return to the Desktop either:

press <Alt> + <F4>

select [Exit] from the File menu

double-click on the [Close] button (the top left cor-
ner of the screen).

2-40

ELIXIFORM USER GUIDE



3. Menu bars

This chapter provides information on the ElixiForm
and Work area menu bars.

ElixiForm menu bar

The ElixiForm menu bar contains the File, System,
Window, and Help menus. Select a menu to display
its options, then select an option from the pull-down
menu.

File menu

The File menu contains the following options:

New Form <F9>

Select form defaults in the Page Properties dialog
box. See the "ElixiForm Defaults" chapter for more
information on the Page Properties dialog box.

Load Form <F8>

Select an existing form to open in the Load Form dia-
log box.

Save Form <Ctrl> + <S>

Saves your open form under the original name speci-
fied in the Page Properties dialog box. See the "Elixi-
Form Defaults" chapter for more information on the
Page Properties dialog box.

For a form being saved for the first time, enter a name
in the Save Form As dialog box.
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Save Form As <F7>

Enter a new file name to save the open form under in
the Save Form As dialog box.

Rename/Move Form

Rename and/or change the path of an existing form in
the Rename/Move Form dialog box.

Delete Form

Select a form to delete in the Delete Form dialog box.

Merge Form Group

Select a group to add to the current form in the Load
Form Group dialog box. See the "ElixiForm basics"
chapter for more information on form groups.

Save Form Group

Select a group on an existing form to save as a form
file in the Save Form Group dialog box.

Load Form Template

Select a form template to load onto the current form in
the Load Form Template dialog box. The template is
only a visual guide for designing new form elements
around. It does not become part of the form when the
form is saved.

Proof printing a form that includes one or more tem-
plates also prints the templates. If you want to proof
print a form without the templates, save and reload
the form without the templates, then proof print the re-
loaded form. See the "ElixiForm basics" chapter for
more information on loading form templates.

Remove Form Template

Removes all templates from the current form.
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System menu

Open Dat File

Select the .DAT file to open in the Open Dat File dia-
log box. A .DAT file is a group of Elixir forms (.ELX)
referenced in a text file with a .DAT extension.

See the "ElixiForm basics" chapter for more informa-
tion on editing multiple forms.

Close Dat File

Closes the open .DAT file.

Import Text

Select text to import into the current form in the Import
Text dialog box. See the "Text operations" chapter for
more information on importing text.

Print

Select PCL 4 or compatible printer defaults in the Print
dialog box. See the "ElixiForm basics" chapter for
more information on printing.

Print Special

Select XES printer defaults in the Print Special dialog
box. See the "ElixiForm basics" chapter for more in-
formation on printing.

Exit

Exits the current ElixiForm session.

The System menu contains the following options:

Usage Switches

Select display defaults in the Usage Switches dialog
box. See the "ElixiForm defaults” chapter for more in-
formation on the Usage Switches dialog box.
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Window menu

Filing Options

Select filing defaults in the Filing Options dialog box.
See the "ElixiForm defaults" chapter for more informa-
tion on the Usage Switches dialog box.

Reset to Defaults

Resets all Toolbox options to their default values.

Save Configuration

Saves the current ElixiForm session configuration in
the  drive:\ELIXIR\DESKTOP\SYSTEM\JOBDES.INI
and drive:\ELIXIR\DESKTOP\SYSTEM\FBW.INI files.

The Window menu contains the following options. A
check mark appears in the menu next to the selected
option.

Tile

Maximizes all open windows, with the Toolbox display-
ing to the left of the Work area.

Form <Ctrl> + <F4>

Displays the Toolbar, Work area, and Work area
menu bar. Select this option a second time to hide
these features.

Toolbox <F10>

Displays the Toolbox. Select this option a second
time to hide the Toolbox. See the 'ElixiForm basics"
chapter for more information on the Toolbox.
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Help menu

Displays on-line Help for ElixiForm’s windows, dialog
boxes and operations. Help is also available by click-
ing on a dialog box’s [Help] button. See the "Introduc-
tion" chapter for more information on on-line help.

Work area menu bar

The Work area menu bar contains the Edit, Tools,
View, and Options menus. Select a menu to display
its options, then select an option from the pull-down
menu.

Edit menu

The Edit menu contains the following options.

Undo <Ctrl> + <Z>

Cancels the most recent action performed.

Redo <Shift> + <Ctrl> + <Z>

Cancels the most recent Undo operation.

Cut <Ctrl> + <X>

Moves the selected text to the Windows Clipboard.

Copy <Ctrl> + <C>

Copies the selected text to the Windows Clipboard.

Paste <Ctrl> + <V>

Inserts cut or copied text from the Windows Clipboard.

Select All <Ctrl> + <A>

Selects all elements on the current form. This allows
you to delete, copy, or move the elements.
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Tools menu

Deselect All <Ctrl> + <A>

Deselects all previously-selected elements.

Delete <Del>

Deletes the selected element(s) from a form.

Delete All <Ctrl> + <Del>

Deletes all selected elements from a form.

Find <Alt> + <F3>

Enter the text string to search the open form for in the
Find text dialog box. See the "Text operations" chap-
ter for more information on the Find text dialog box.

Find Next <F3>

Finds the next occurrence of the text string entered in
the Find text dialog box. See the "Text operations"
chapter for more information on the Find text dialog
box.

Find Previous <Shift> + <F3>

Finds the previous occurrence of the text string en-
tered in the Find text dialog box. See the "Text opera-
tions" chapter for more information on the Find text
dialog box.

Replace

Enter the text to search for and the text which re-
places it in the Replace Text dialog box. See the
"Text operations" chapter for more information on the
Replace text dialog box.

The options in this menu provide an alternate way to
activate the Toolbox or Toolbar for the tool selected:
Select, Line, Path, Box, Circle, Text, and Image. The
currently selected Toolbox or Toolbar displays with a
check.
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View menu

Spell Check

Checks the spelling in the active form.

Options menu

The options in this menu provide an alternate way to
activate the Toolbar options: Ruler, Grid, and Long
Crosshair.

The Options menu contains the following options:

Snap to Grid <F5>

Forces placement of lines, paths and boxes to the
grid.

GEM Forms Load Defaults

For forms created using Elixir's ElixiForm product
prior to version 3.0, select GEM form display defaults
in the GEM Forms Load Defaults dialog box. See the
"ElixiForm defaults" chapter for more information on
the GEM Forms Load Defaults dialog box.

Page Properties

Select page defaults in the Page Properties dialog
box. See the "ElixiForm defaults" chapter for informa-
tion on the Page Properties dialog box.
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Page Databasing

Select page databasing defaults in the Page Databas-
ing dialog box.

Page databasing places form documentation informa-
tion on a form and stores with the form until it is
changed or deleted. It does not print.

See the "ElixiForm defaults" chapter for more informa-
tion on the Page Databasing dialog box.

Text/Font Options

Select text and font defaults in the Text and Font Op-
tions dialog box. See the "ElixiForm defaults" chapter
for more information on the Text and Font Options
dialog box.

Character Mapping

Select keyboard-entered, imported text, or spell
checker character mapping options in the Character
Mapping Options dialog box.

The Character Mapping dialog box contains the fol-
lowing options:

Keyboard Mapping
Select an option for mapping characters entered via
the keyboard:

®* [None] - use Windows ANSI mapping; select this
option if you work with ATM or True Type fonts

e |[OEM] - remaps ANSI keystrokes to DOS
mappings

® [OEMI/ISO] - remaps ANSI character strokes to
DOS ISO mappings

® [KMP] - translates keystrokes using customized
tables

When you select [KMP], the [Windows] and [Elixir] op-
tions display:
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Windows

Select the character map for the current keyboard
layout from the drop-down list. Most users should
select TIOOANSI. If you are using an Eastern
European version of Windows, you should select
T10EEURO.

Elixir
Select the setting that matches your DOS code
page from the drop-down list. This is the charac-

ter map used by Elixir fonts. To check your DOS
code page, go to the DOS prompt and type:

CHCP <Enter>

The active code page displays.

Text Import Mapping

Select a translation option for characters imported
from an external text file. All mappings (except when
[KMP] is selected) translate to the standard Windows
character set.

[NONE] - when importing or pasting a Windows
text file

[OEM] - when importing or pasting a DOS text file

[OEM/ISQ] - when importing a DOS text file from
a non-US DOS environment

[1ISO] - when importing or pasting a DOS text file
that has mapped European characters

[KMP] - uses custom translation tables:

When you select [KMP], the [Text File] and [Elixir] op-
tions display:

Text File
Select the source text file's character map from
the drop-down list.
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Elixir

Select translation character map for the target
text from the drop-down list. To check your DOS
code page, go to the DOS prompt and type:

CHCP <Enter>

The active code page displays.

Text Paste Mapping

Select a translation option for characters imported
from an external text file. All mappings (except when
[KMP] is selected) translate to the standard Windows
character set.

[NONE] - when importing or pasting a Windows
text file

[OEM] - when importing or pasting a DOS text file

[OEM/I1SQ] - when importing a DOS text file from
a non-US DOS environment

[1ISO] - when importing or pasting a DOS text file
that has mapped European characters

[KMP] - uses custom translation tables:

When you select [KMP], the [Text] and [Elixir] options
display:

Text
Select the source text file's character map from
the drop-down list.

Elixir

Select translation character map for the target
text from the drop-down list. To check your DOS
code page, go to the DOS prompt and type:
CHCP <Enter>

The active code page displays.
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Spell Checker Mapping
Select a spell checker character mapping option:

®* [None] - use Windows ANSI mapping; select this
option if you work with ATM or True Type fonts

e |[OEM] - remaps ANSI characters to DOS
mappings

e [OEMI/ISO] - remaps ANSI characters to DOS
ISO mappings

® [KMP] - translates keystrokes using customized
tables

When you select [KMP], the [Windows] and [Elixir] op-
tions display:

Windows

Select the Windows character map from the drop-
down list. Most users should select TI00ANSI. If
you are using an Eastern European version of
Windows, you should select TLOEEURO.

Elixir
Select the setting that matches the mapping of

the Elixir fonts used in the form currently being
spell checked.

Spell Check Options

Select spell checking defaults in the Spell Check Op-
tions dialog box. See the "Text operations" chapter
for more information on the Spell Checker.

Template Options

Select form template defaults in the Template Options
dialog box. See the "ElixiForm basics" chapter for
more information on the Template Options dialog box.
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This chapter contains procedures for setting ElixiForm
defaults. Although you can change settings for each
form, you will probably find that you can keep the
same defaults for most of your forms.

User preferences

Grid <F4 >

This section describes the Toolbar grid, rulers and
long crosshair options. These options are used to ob-
tain precise form element measurement and place-
ment within the Work area.

ol

The grid helps you place and align form and data ele-
ments accurately. It overlays the Work area to allow
exact placement of elements, but does not print.

Displaying/hiding the grid

To display the grid in your Work area either:
® click on the Toolbar Grid Display icon

® press <F4>

® select [Grid] from the View menu

A check mark appears in the View menu next to the
selected option.

Select this option a second time to remove the grid.

Right-click on the Toolbar Grid Display icon to display
the Grid Setting dialog box.

ELIXIFORM USER GUIDE 4-1



ELIXIFORM DEFAULTS

Selecting grid properties

To select grid properties:
1. Right-click on the Grid icon in the Toolbar.

The Grid Setting dialog box displays.

e T
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Figure 4-1. Grid Setting dialog box
2. Select/enter grid options, then click on [OK].

The Grid Setting dialog box contains the following op-
tions. Fields in this dialog box may or may not display,
depending on the options selected.

Grid units
Enter the number of grid units displayed per unit of
measure. Default is 10 x 6 grid units per inch.

Grid step
Enter a grid step value to define the distance between
grid points.

Grid units and Grid step units of measure are defined
by your selection in the [Ruler measure] option. The
size of the grid units or grid step dimensions entered
above are maintained, even though the value may
change based upon the current unit of measure.
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You can enter grid dimensions using either the [Grid
units] or [Grid step] options, but not both.

Ruler measure

Select the unit of measure for display: [Inches], [CM],
[MM], [Dots], [Points], or [Pels]. Your selection also
changes the [Ruler measure] option in the Ruler Op-
tions and Page Properties dialog boxes.

Graphic Ruler in Grid Units
The graphic ruler reflects the values specified in the
[Grid units] option.

For example, if the [Grid units] option is set to 8.00 per
1 inch for the horizontal setting and 6.00 per 1 inch for
the vertical setting, the horizontal graphic ruler dis-
plays 8 divisions (grid units) per inch and the vertical
graphic ruler displays 6 divisions (grid units) per inch.

Digital Ruler in Grid Units
The digital ruler reflects the values specified in the
[Grid units] option.

See the [Graphic Ruler in Grid Units] option for an
example.

Grid Snap to
Select a snap to option:

® [Full Grid] - form elements snap to grid points

® [Half Grid] - form elements snap to grid points
and to points halfway between grid points

In both instances, all elements resize to fit the grid.

Grid Color
Select the grid color: [Black], [Dark Shade], or
[Green].

Snap mouse speed
Select the mouse’s snap speed: [Slow], [Moderate], or
[Fast].
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Rulers <F3>

Show Grid
Displays the grid in the Work area. Select this option
a second time to remove the grid.

Snap to Grid
Form elements snap to full grid or half grid points.

You can also select the [Snap to Grid] option by click-
ing on the Toolbar Snap to Grid icon or selecting
[Snap to Grid] from the Options menu. See the
"Snapping elements to the Grid" section in this chap-
ter for more information.

E Inches

The ElixiForm toolbar contains two rulers:

®  Graphic ruler
® Digital ruler

Graphic ruler

To display the graphic ruler either:

® click on the Ruler icon in the Toolbar
e select [Ruler] from the View menu

A check mark appears next to the option in the
View menu when selected.

Digital ruler

The digital ruler displays the horizontal and vertical po-
sition of the screen pointer.

When [Snap to Grid] is selected, the digital ruler
shows only the coordinates of the grid points nearest
to the screen pointer.

To display the position of an element relative to the
form, select the Select/Edit tool and move the cursor
to any area on the element. A second digital ruler dis-
plays in the Toolbar, displaying the horizontal and ver-
tical start coordinates of the element. A third digital
ruler shows element width and depth.
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Rulers not part of the saved or printed form.
To select graphic ruler options:
1. Right-click on the Ruler icon.

The Ruler Options dialog box displays.

gﬁﬁmﬁcm | i Gnd Units
¥ Ditlnde i B Dot
.

Figure 4-2. Ruler Options dialog box
2. Select display options, then click on [OK].

The Ruler Options dialog box contains the following
options:

Ruler measure

Select the display unit of measure: [Inches], [CM],
[MM], [Dots], [Points] or [Pels]. Your selection also
changes the [Ruler measure] option in the Grid Set-
ting and Page Properties dialog boxes.

Ruler color
Select the ruler color: [Light Gray] (may be [White] on
some monitors), [Dark Gray] or [Green].

Graphic ruler <F3 >
Displays the graphic ruler along the top and left edges
of the Work area.

Digital ruler
Displays the position of the screen pointer relative to
the top left corner of the Work area (0,0).
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in Grid Units

Displays the corresponding ruler in the units of meas-
ure entered in the [Grid Units] option in the Grid Set-
ting dialog box.

Long crosshair <F6 >

The long crosshair helps you to more precisely place
form elements about the work area.

EF‘_" To use the long crosshair:

1. Click on the Long Crosshair icon in the
Toolbar.

2. Place cursor onto the desired location in
Work area.

The long cross hair displays vertically and hori-
zontally from the cursor.

Zoom in/out
The zoom in feature allows you to move about the
form in magnified view:
Feae o[l [ |
35
j| 12|~ Figure 4-3. Magnified view
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To zoom in on (magnify) an area of the Work area,
click on the [+] button on the right side of the Zoom
icon in the Toolbar. The highest magnification is [8x].

To zoom out on (reduce the magnification of) an area
of the Work area, click on the [-] button on the left side
of the Zoom icon in the Toolbar. The lowest reduction
is [-8x].

You can also use the <+> and <-> keys on the nu-
meric keyboard to zoom in and out.

Keyboard zoom in/out controls

ElixiForm support the following keys strokes for zoom-
ing infout:;

<+> (numeric keypad) to zoom in

<-> (numeric keypad) to zoom out

arrow keys to pan form about the screen
<Home> to pan to the top left of the form
<End> to pan to the bottom left of the form
<Ctrl> + <PgDn> to pan to bottom right of form
<Ctrl> + <PgUp> to pan to top right of form
<PgUp> to scroll up

<PgDn> to scroll down.

Page settings

This section describes procedures for setting form
page default values.

Selecting page properties

The Page Properties dialog box displays when a new
form loads.

To change displayed default values:

1. Select [Page Properties] from the Options
menu.

The Page Properties dialog box displays.
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Figure 4-4. Page Properties dialog box
2. Select/enter default values, then click on [OK].

The Page Properties dialog box contains the following
options:

Page size

Select the overlay’s page size. The width and length of
the page display below this field in the units of meas-
urement specified in the Units of Measure field.

[8.5 x 11] - U.S. letter size

[8.5 x 14] - U.S. Legal size

[11x17]-11x 17 inches

[A4] - 8.27 x 11.69 inches

[A3] - 11.69 x 16.54 inches

[Custom] - nonstandard size; enter a width and
height (maximum 17 inches x 17 inches)

If you change the page size of an existing form, some
form elements may extend beyond the page bound-
ary. If this happens, the Objects Off Page dialog box
displays when you click on [OK]. See the "Exceeding
form page size limits" section for more information on
the Objects Off Page dialog box.

4-8
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Switch
Changes the page orientation by reversing the width
and height of the page.

Units of measure

Select the unit of measurement for the graphic and
digital rulers and the selected page: [Inches], [CM],
[MM], [Dots], [Points], or [Pels].

Your selection also changes the Ruler measure option
in the Ruler Options and Grid Settings dialog boxes.

Color mode
Select the color mode supported by your output
printer:

e [Black and White] - the Color options do not dis-
play in the Toolbox

® [Highlight Color] - uses the options selected
below:

- [Catalog] - select your printer’'s catalog from
the drop-down list

- [Printer Palette] - select your printer's color
palette from the drop-down list

- [Ink Dominance] - select the dominant color
(if colors overlap):

— [Default] - prints the dominant ink color,
depending on your printer's default

— [Black] - prints black on color

— [Color] - prints in the currently selected
color in the

® [Full color] - uses color for borders, interior fills,
texts and graphics, if supported by your printer

® [XDP Grays] - uses black or gray shades
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Page Offset

Enter offset values used when converting Elixir-format
forms (.ELX) to AFP overlay format (.OVE). This shift
does not display on screen.

e [Xoffset] - output shifts right by the units specified
in the Units of measure field

® [Yoffset] - output shifts down by the units speci-
fied in the Units of measure field

Exceeding form page size limits

When you change the size or orientation of an existing
form, some form elements may extend beyond the
page boundary.

If this happens, the Objects Off Page dialog box
displays.

x‘*‘"‘“’

Figure 4-5. Objects Off Page dialog box

The Objects Off Page dialog box lists (by type) all
form elements that extend beyond the page bounda-
ries. For each object, select an action, then click on
[OKT:

Delete
Deletes the object from the form.

Ignore
Increases the page size to accommodate the object.

4-10

ELIXIFORM USER GUIDE



ELIXIFORM DEFAULTS

Move in
Moves the object inside the page boundaries. Form
objects may now overlap.

Clip
Eliminate only that portion of object that is off page.

Page databasing

The Page Databasing dialog box displays when select
[New Form] from the File menu. The entered informa-
tion stores with the form until it is changed or deleted,
but does not print with the form.

To edit databasing information:

1. Select [Page Databasing] from the Options
menu.

The Page Databasing dialog box displays.

Short Page Dezscnplion:

Fage Version: D Page Hevision: |:| LocaliD: _‘

Long Page Comments:

Stare DatelTime Stamp
Date Format [+ WM/DDAYY [ Vo/MM/DD || DOMHAY] o | |
Time Format: [+ 12 Hour am/pm e

L]

Figure 4-6. Page Databasing dialog box
2. Select/enter information, then click on [OK].

The Page Databasing dialog box contains the follow-
ing options:
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Short Page Description
Enter a short description (maximum 60 characters) for
the form.

Page Author
Enter the user ID (maximum 8 characters).

Made for
Enter the name of the customer (maximum 13
characters).

Page Version
Enter the version number (maximum two characters).

Page Revision
Enter the form revision or modification identifier (one
character only).

Local ID

Enter a name for the form (maximum 8 characters).
This name is used as a comment in the [Made for]
option.

Long Page Comments

Enter comments for the form (maximum 240 charac-
ters). Use the mouse to move to another line or any
place within the comments box. Comments save with
each form until they are changed or deleted.

Store Date/Time Stamp
Assigns a date or time stamp to the form after output
datastream generation.

Date Format
Select the month/day/year/ format for the date pro-
vided by the [Store Date/Time Stamp] option.

sc:
Enter a date separator character (default /).

Time Format
Select a time format; [12 Hour am/pm] or [24 Hour].

sc:
Enter a time separator character (default ;).

4-12
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Text and font options

To specify form text and font defaults:

1. Select [Text/Fonts Options] from the Options
menu.

The Text and Font Options dialog box displays.

Texl ond Fant Oplions
ol Desntoy Hptons:
e tatienan |5 apaees
:F;wﬁw i
im i
Eont otons
Fant Preference:  tenteaiw

. '

Join Tout Using

fewt Paste Untian:

Accepied Dliphomd Foman
n Ouler of Preference:

¥ Bich Teut Fommat
¥ Plan Text
¥ Unicwde Main 1ent

Figure 4-7. Text and Font Options dialog box
2. Select/enter information, then click on [OK].

The Text and Font Options dialog box contains the fol-
lowing options:

Text Display Options

Text Tab Length

Enter the text tab length. The initial default setting is 5.
Tab length is based on the width of the space charac-
ter in the active font.

The tab length setting applies to all tabs on the current
form (including those previously entered).
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Text Display Options

Text Formatting Compatibility and Grid Step Pre-
cision

Select the text formatting and grid precision for the
current form:

e [GEM] - uses original boxed text formatting of
forms created in ElixiForm prior to version 3.0;
the internal grid step precision is set to 0.1 dots

®* [Windows] - uses Windows boxed text formatting;
the internal grid step precision is set to 0.01 dots

Text Display Options
Tag Display
Prints the data tags included in Elixir forms.

®* [None] - does not print the data tags

®* [Replace Char] - prints the data tag field length
and replacement characters

® [Tag Name] - prints the data tag's field name

See your Elixir DataMerge User Guide or Elixir Docu-
Tag User Guide for more information.

Font Options
Font Preference
Select a default font type: [Screen] or [Elixir].

Font Options
Sort Font List
Alphabetically sorts the font list.

Text Import Options

Lock position

Locks text imported from an ASCII file in its initial po-
sition in the Work area. Subsequent text blocks are
positioned directly underneath the first text block.
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Text Import Options

Separate paragraphs

Allows you to place imported text blocks at different
locations on the form. Paragraphs separated by two
carriage returns create separate blocks you can place
separately. See the "Text operations" chapter for
more information on importing text.

Join Text Using
Select the mode for grouping text blocks to create a
single block:

® [Spaces] - each text block displays under the pre-
vious text block; original line beginnings and end-
ings are maintained

e [Justify] - joined text displays as one continuous
paragraph; the left- and right-most character posi-
tions determine the width of the text block

* [Relatives] - each text block retains its position
relative to the previous text block

To take out unwanted spaces or perform paragraph
formatting operations, deselect, then reselect the
[Text - Word Wrapping] option in the Text toolbox.
See the "Text operations” chapter for more
information.

Keyboard Input Options

Filter control codes on input

Prevents inadvertent keyboard entry of control codes,
such as characters below decimal 32 (a space).

RTF Paste Options
Select RTF import options:

® [Paste Fonts] - maintains font(s) specified in the
imported text file

® [Paste Colors] - maintains color(s) specified in the
imported text file
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GEM form defaults

For forms created using ElixiForm prior to version 3.0,
use the GEM Forms Load Defaults dialog box to se-
lect text formatting, grid step precision and color mode
settings. These settings then apply to all subsequently
loaded GEM forms.

To change settings for the currently loaded GEM form
only, see the "Selecting page properties" and "Text
and font options" sections.

To select GEM form defaults:

1. Select [GEM Forms Load Defaults] from the
Options menu.

The GEM Forms Load Defaults dialog box
displays.

CEMEarn Lod Dot/

Bt fines by Hollwidth
Tes Fomatton Lonniiulte sl el Sten Precoon
Colos Wode

.
%
E
.
%
.

Figure 4-8. GEM Forms Load Defaults dialog box
2. Select display options, then click on [OK].

The GEM Forms Load Defaults dialog box contains
the following options:

Options in this dialog box may or may not display, de-
pending on the options selected.
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Extend Lines by Halfwidth

Displays horizontal and vertical lines with extensions
equal to half the line thickness at each end. Affects
the printed output only.

Text Formatting Compatibility and Grid Step Pre-
cision

Select the text formatting and grid precision for loaded
GEM forms:

* [GEM] - uses original boxed text formatting of a
form created in ElixiForm prior to version 3.0; in-
ternal grid step precision set to 0.1 dots

® [Windows] - (default) uses Windows boxed text
formatting; internal grid step precision set to 0.01
dots

Your selection is written to the Elixir SYSTEM.INI
file. This formatting affects all GEM forms loaded
afterwards.

Color Mode
Select the display color for loaded GEM forms:

* [Black & White] - GEM form displays in black and
white

® [Highlight Color] - GEM form displays with the op-
tions selected below:

- [PAL palette] - select an internal PAL palette
from the drop-down list

- [Catalog] - select your printer’'s catalog from
the drop-down list

- [Printer Palette] - select your printer's color
palette from the drop-down list

® [Full Color] - GEM form displays with the PLF pal-
ette selected from the drop-down list in the [PLF
palette] option
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® [XDP Grays] - uses black or gray shades

Configuring the system

ElixiForm allows you to configure your system and to
save the configuration for subsequent work sessions.

Setting usage defaults

To select ElixiForm usage settings:

1. Select [Usage Switches] from the System
menu.

The Usage Switches dialog box displays.

iﬁm ¥, Show Guick Help
| Edondine balobwish @ Show Fom Dimensions

i Show Lines as WYSIWYS:

Ul Rocobtion:

Figure 4-9. Usage Switches dialog box

2. Select display options, then click on [OK].

The Usage Switches dialog box contains the following
options:

Save State on Exit
Saves the current menu and option settings when you
exit ElixiForm.

Extend Lines by Halfwidth

Displays horizontal and vertical lines with extensions
equal to half the line thickness at each end. Affects
the screen display only - lines print as drawn.
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Filing options

Show Quick Help
Displays a short description of any icon that your cur-
sor passes over in the Message area.

Show Form Dimensions
Display the dimensions of the current form in the up-
per right hand corner of the screen.

Show Lines as WYSIWYG
Select a display resolution:

® [240DPI] - lines and shape borders display as
WYSIWYG on high-resolution monitors.

® [300DPI] - displays lines at 300 dpi and shape
borders at 240 dpi

® [OFF] - for low resolution monitors such as VGA.
Light and medium lines and borders may display
as the same thickness on low resolution monitors
if this option is not selected.

ElixiForm allows you to specify default directories for
forms, screen fonts, Elixir images, screen images,
texts, tags and Elixir-format documents. Entered in-
formation saves to your SYSTEM.INI file.

To specify default filing information:

1. Select [Filing Options] from the System menu.

The Filing Options dialog box displays.
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Figure 4-10. Filing Options dialog box

2. Select/enter filing information, then click on
[OK].

The Filing Options dialog box contains the following
options:

Autosave

Enter a time interval from 1 to 9 minutes in the Save
interval field to automatically save your currently active
form. The back-up form saves as AUTOBACK.ELX in
the default forms directory.

Make Backup File (with .BAK extension)

Creates a back-up copy (.BAK) of the form which is
overwritten only when you select [Save] from the File
menu. The [Autosave] option does not overwrite this
file.

The back-up file writes to the default forms directory
and has the same stem name as the original file with
a .BAK extension.
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Load Last Form
Automatically loads the form you last worked on when
you start a new ElixiForm session.

Write PostScript File on Form Save
Creates a PostScript file in the directory specified in
the [Doc. Directory] option when the Form saves.

Forms Directory

Enter the directory for Elixir-format form files (.ELX) or
click on the [Browse] button and select one from the
Select Forms directory dialog box. Default is
drive:\ELIXIR\FORMS\ELIXIR\DEMO.

Screen Fonts Directory

Enter the directory for Elixir-format screen font files
(.FNT) and width tables (WDT) or click on the
[Browse] button and select one from the Select
Screen Fonts directory dialog box. Default is
drive:\ELIXIR\FONTS\SCREEN\DEMO. See the "Text
operations" chapter for more information on screen
and other fonts.

Elixir Images Directory

Enter the directory for Elixir-format image files (.LP3)
or click on the [Browse] button and select one from
the Select Elixir Images directory dialog box. Default is
drive:\ELIXIR\PICS\PRINTER. See the "Images"
chapter for more information on images.

Screen Images Directory

Enter the directory for Elixir-format screen image files
(.LW8) or click on the [Browse] button and select one
from the Select Screen Images directory dialog box.
Default is drive:\ELIXIR\PICS\SCREEN. See the "Im-
ages" chapter for more information on screen images.

Texts Directory

Enter the directory for imported ASCII text files (.TXT)
or click on the [Browse] button and select one from
the Select Texts directory dialog box. Default is
drive:\ELIXIR\TEXTS.
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Tags Directory

Enter the directory for tag files ((.TAG) or click on the
[Browse] button and select one from the Select Tags
directory dialog box. Tag files are used with DocuTag
for external tag files called for in a form. Default is
drive:\ELIXIR. See your Elixir DocuTag for AFP User
Guide for more information.

Elixir Documents Directory

Enter the directory for the Elixir-format documents
(.DAT) or click on the [Browse] button and select one
from the Select Elixir Documents directory dialog box.
Default is drive:\ELIXIR\DOCS\DOCLIST.

Resetting to defaults

To reset Toolbox options to default values:

1. Select [Reset to Defaults] from the System
menu.

2. Click on [OK].

Saving a configuration

To save the configuration settings specified above,
select [Save Configuration] from the System menu.

The configuration saves for the next time you open
ElixiForm. If the font and screen directories change in
the Elixir Desktop, these changes apply next time
ElixiForm loads.
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5. Lines and boxes

This chapter describes how to draw and edit lines and
boxes, with references made to options in the Line
and Box tools in the Toolbox.

Line display

The following section provides information about line
display.

Setting the screen display

Screen refresh

If you are using a low resolution monitor such as VGA,
you should set the [Show Lines as WYSIWYG] option
in the Usage Switches dialog box to [Off]; if you do
not, thin lines and borders may display the same
thickness as medium lines and borders.

See the "ElixiForm defaults" chapter for more in-
formation.

After a screen refresh, overlapping lines and boxes
may not display or print in the "front to back" order in
which they were drawn. For example, a shaded box
drawn on top of an existing line may display with the
line on top of the box after a screen refresh operation.
This is due to the page resorting method (from top left
to bottom right) required by certain printers.
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To prevent elements refreshing to an incorrect "front
to back" order, avoid drawing elements that overlap.
For example, to draw a box with lines extending from
its borders, connect individual lines to the border of
the box instead of drawing the box on top of a line that
extends beneath and beyond its borders.

Drawing lines

ElixiForm allows you to draw vertical, horizontal and
free lines. You can also specify line thickness, style
and color by selecting options from the Line Toolbox.

To display the Line Toolbox, select the Toolbox Line
tool or select [Line] from the Tools menu.

Figure 5-1. Line toolbox

To start and end a line at grid points, click on the Tool-
bar [Show Grid] and [Snap to Grid] options.

If you want the line to snap to grid mid-points as well
as to grid points, set the [Grid Snap] option in the Grid
Setting dialog box to [Half Grid]. See the "ElixiForm
basics" chapter for more information.
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To draw a line:

1. Position the screen pointer in the Work area
where you want the line to begin, then press
and hold the mouse.

2. Drag the screen pointer across the Work area.
A line displays.

3. To end the line, release the mouse.

The line locks into position.

4. Select line properties from the Line toolbox.

The Line toolbox contains the following options:

Line Direction

Select a direction for the line: [Horizontal only], [Verti-

H cal only], [Horizontal and Vertical] or [Free].
= =|mm| Line Width

Select a width for the line: [Thin] 2 dot, [Medium] 4 dot

or [Thick] 6 dot line widths. You can also click on the

up or down scroll arrow to increment line width by one

dot, or click on the current width display and enter a

new line width value up to 99 dots.

[ ===[x:xs| Line Style

Select a style for the line: [Solid], [Dashed] or [Dot-

ted].

Line Color
If your printer supports color:

jﬂ 1. Select the [Color] option.

If you cannot see the color option, select the Page
Properties dialog box [Full Color] option.

The Color dialog box displays.
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2. Select a color, then click on the [Color]
button.

The selected color displays in the bottom half of
the icon.

For information on copying colors or shades to
the local palette, see the appropriate tabbed sec-
tion for your printer.

3. Place the cursor in the Work area and draw a
line.

The line displays in the color you selected.

All subsequently drawn lines display the same
color until you select another color. Click on the
[Save] button to save line color selections with the
form.

Sticky Lines <Ctrl> + <L>

When you select the [Sticky Lines] option in the
Select/Edit toolbox, perpendicular connected lines
stick together when you either move one of the lines
or change line size. Lines connected to form the sides
of boxes also remain attached when you either move
or resize the box. If you deselect the [Sticky Lines] op-
tion, only the selected line is affected by subsequent
line moves or size changes.

You must select either the [Horizontal only] or [Vertical
only] option in the Toolbox when moving sticky lines.
This requirement does not apply when moving or
resizing boxes.

To create sticky lines:

1. Select the [Sticky Lines] option, then select a
line and press <Ctrl>+<L>.

2. Select a line movement restriction option:
[Horizontal only] or [Vertical only].

3. Resize a box either horizontally by moving its
left or right side or vertically by moving its top
or bottom side.
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4. Release the mouse button.

The sticky line or box locks into position.

Drawing boxes

ElixiForm allows you to create split boxes (for exam-
ple, one box evenly divided or split into two or more
boxes), shaded boxes and boxes with varying borders
and styles.

To draw a box:

1. Select the Box tool in the Toolbox.

The Box toolbox displays.

Figure 5-2 Box toolbox

2. Position the screen pointer in the work area
where you want a box corner.

3. Press and hold the mouse button.

4. Drag the screen pointer to form the shape of a
box.
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5.

Release the mouse button to finish the box.

You can use the arrow keys to pan around the
screen when drawing a box that exceeds work
area boundaries.

Select box properties from the Box toolbox.

Select one of the following options to cor-
respond to above width and style selections:

Border Lines
Select to set the width and style of box borders
(and diagonals, if selected).

Horizontal Lines
Select to set the width and style of horizontal
splits in a box (see Box Splits, below).

Vertical Lines
Select to set the width and style of vertical splits
in a box (see Box Splits, below).

When shape completed, toggle the Path -
Finish Drawing option to [Done] or
double-click in the Work area.

The Box toolbox contains the following options:

Box - Predefined Shape

Select the box corner style: [All corners square], [All
corners rounded], [Top rounded/bottom square], [Top
square/bottom rounded], [Left rounded/right square],
or [Left square/right rounded].

Box - Positioning Center/Top Left

Select the top half of this option to center the top left
corner of the box on grid coordinates. Select the bot-
tom half of the option to snap the top left corner of the
box flush to grid coordinates.

Box - Shape Oblong/Square

Select the top half of this icon to draw boxes as rec-
tangles. Select the bottom half of this icon to draw
boxes as squares.
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Box - Diagonals

Select the diagonal line pattern for inside the box:
[None], [Left] ,[Right], or [Both]. Each option displays
a sample box.

Custom Line/Border Thickness

Specify a value (in dots) by clicking on the up or down
arrows, or click in the numeric display box and enter a
value (maximum 99 dots). Specify [0] to apply an in-
visible border to a shaded box. Unshaded boxes
must have a border width of [1] or higher.

You can also select: [Thin], [Medium], or [Thick] box
line widths.

Box - Line Style
To set the box line style, select the [Solid], [Dashed] or
[Dotted] option.

Box - Line Thickness and Style
Select width and style options:

® [Border Lines] - sets the width and style of the box
border

® [Horizontal Lines] - sets the width and style of the
horizontal box splits

® [Vertical Lines] - sets the width and style of the
vertical box splits

Select the [Horizontal Lines] and [Vertical Lines] op-
tions to apply box splits using the [Box Splits -
Horizontal/Vertical] option.

Box - Horizontal Spilit
Select the number of equal horizontal portions to di-
vide the box into by clicking on the up or down arrows.

You can also select the [Box Splits] option and enter
the number of portions in the numeric display box next
to each option. The minimum value is 1 (hollow) and
the maximum value is 40.
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Box - Horizontal Split - ON/OFF
Enables the [Box - Horizontal Split] option. Select this
option a second time to disable this feature.

Box - Vertical Split
Select the number of equal vertical portions to divide
the box into by clicking on the up or down arrows.

You can also select the [Box Splits] option and enter
the number of portions in the numeric display box next
to each option. The minimum value is 1 (hollow) and
the maximum value is 40.

Box - Vertical Split - ON/OFF
Enables the [Box - Vertical Split] option. Select this
option a second time to disable this feature.

Box - Color
If your printer supports color:

1. Select the [Color] option.

If you cannot see the color option, select the Page
Properties dialog box [Full Color] option.

The Color dialog box displays.

2. Select a color, then click on the [Color]
button.

The selected color displays in the bottom half of
the icon.

For information on copying colors or shades to
the local palette, see the appropriate tabbed sec-
tion for your printer.

3. Place the cursor in the Work area and draw
box.

The box displays in the color you selected.

All subsequently drawn boxes display the same
color until you select another color. Click on the
[Save] button to save box color selections with
the form.

5-8
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Box - Fill Color

Right-click to select a box fill color from the palette in
the Color dialog box, then click on the [Close] button.
The selected box fill color displays in the bottom half
of the icon.

Object Fill Pattern/Shading

Right-click to select a box shade pattern from the Pat-
tern dialog box. To select a shade, click on a shade
pattern. All the boxes you draw contain this shading
until you change it using the same procedure. Select
the white shade box for no shading.

10 FIT r|r'|r'| Box - Corner Radius _
Select an option for the radius of the corners. Cus-

tomize the radius by clicking on the up or down arrow
to increase or decrease the corner radius by one pel.
The maximum value is 299 pels.

The [Corner Radius] option does not apply when all
corner styles are 90 degrees.

Editing lines or boxes

To change the properties of a form element, you must
first select it.

To select an element:

L} 1. Select the Select/Edit tool in the Toolbox.

2. Right-click on the element to edit.
The element's Toolbox displays.

Boxes display around or inside the element to
show it is selected.
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Changing size

You can change the size of a selected form element
by entering new dimension coordinates or manually
modifying it directly on the form.

Changing dimension coordinates

To change dimension coordinates:

1.28
162 1. Select the Toolbox Current Object - Start
Coordinates area.

Lk 4

If you cannot click on this area, select the element
again, then right-click.

2. Backspace over the current values or press
the <Del> key to delete the current values,
enter new coordinate values, then press
<Enter>.

The element adjusts to the new coordinates.

Manually

To change size manually:

1. Place the cursor on one of the boxes around
the element.

The cursor changes to a double-ended arrow.

2. Drag the cursor until the element reaches the
new size, then release the mouse button.

Changing element attributes

To change an element's attributes:
1. Select an element.
To change the attributes of multiple elements,

shift-click on each element or use the group fea-
ture described in the "ElixiForm basics" chapter.
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2,

Select the desired option(s) from the Line or
Box toolbox.

The properties apply to the selected element(s).

Moving lines or boxes

You can move a line or box about the Work area
manually or by changing its dimension coordinates.

Manually

To move a line or box manually:

Rl
acfl

Select the Toolbox Select/Edit tool.

Select the direction for moving: [Horizontal
only], [Vertical only] or [Free].

Select the element to move.

Boxes display around the element to show it is
selected.

Click and drag the selected element to a new
position, then release the mouse button.

The screen pointer changes to a hand when you
select the element. If it does not, the element
may be too small. If this happens, press and hold
<Ctrl> you move the cursor over the element.

The line or box locks in the new position.
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Changing dimension coordinates

To move form element using dimension coordinates:

Select the Toolbar Current Object - Start
Coordinates area.

If you cannot click on this area, select the element
again, then right-click.

Backspace over the current values or press
the <Del> key to delete the current values,
enter new coordinate values, then press
<Enter>.

The line or box moves to the new coordinates.

If the sticky lines option is selected, connecting
lines and lines attached to the sides of boxes re-
main attached when one of the lines or the box is
moved. See the "Sticky Lines" section for more
information.

Copying lines or boxes

8

k
i
+

To copy form element:

1.
2,

Select the Toolbox Select/Edit tool.
Select the Toolbox [Copy] option.

Select the direction for copying: [Horizontal
only], [Vertical only] or [Free].

Select the element to copy.

Select the desired number of copies (99 maxi-
mum) by clicking on the up or down arrows or
entering a new number.

Holding down the <Ctrl> key while clicking on the
arrows increases or decreases the value dis-
played by 10.

5-12

ELIXIFORM USER GUIDE



LINES AND BOXES

Deleting lines or boxes

To delete a form element:

L} 1. Select the Toolbox Select/Edit tool.

2. Select the element to delete, then press <Del>.

To restore an element, immediately after deletion ei-
ther select the Toolbar Undo icon or select [Undo]
from the Edit menu.
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6. Text operations

This chapter describes ElixiForm text operations.

Creating text

You can create form text using either Elixir screen,
TrueType or ATM fonts. You can insert text either by
entering text directly from the keyboard or by import-
ing text from an ASCII file.

Apply text properties by selecting options from the
Text toolbox.

A To display the Text toolbox, select the Text tool or pull
down the Tools menu and select [Text].

Figure 6-1. Text toolbox
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Entering text from the keyboard

To enter text directly from the keyboard:

1.

Select the text attributes from the Text
toolbox.

Select the [Text - Load Font List] option.
The Load Font List dialog box displays.
Select a font list, then click on [OK].

The selected font(s) list displays in the Font Pre-
view Panel.

Select a font list, then click in the Work area
where you want the text to appear.

Enter characters from the keyboard, then
right-click when done.

Entered text displays in the Work area.

Moving a block before finish entering text

To move a text block before you finish entering text:

1.
2,
3.

4,

Press and hold down the <Ctrl> key.
Place the cursor on the text block.

Click and drag the text block to a new
location.

Release the mouse button to place the text.

To move a text block after you finish entering text, see
the "Moving text" section in this chapter.

6-2
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Specifying text attributes

L=

ab o

i

Select Text toolbox options to specify text attributes.
The Text toolbox contains the following options:

Text Direction
Select a text display direction:

® [Across] - left to right
e [Down] - top to bottom
® [Back] - right to left

® [Up] - bottom to top

Text - Inter-character/Inter-word Spacing
Select a display spacing option:

® [Inter-character] - justifies all text blocks by in-
creasing or decreasing the amount of space be-
tween characters. This makes the form easier to
read when converted to OGL, but takes longer for
the form to print.

® [Inter-word] - justifies all text blocks by increasing
or decreasing the amount of space between
words.

These options are global features. Selected options
apply to all text blocks on the form.

Text - Word Wrapping

Wraps text between the boundaries set in the [Col-
umn Width] option. You can also select the [Box Text]
option and draw a visual box on your form to contain
the text. Select this option when text is justified.

Text - Remove Redundant Spaces

Removes redundant spaces, relative shifts and car-
riage returns from text blocks that have the Text -
Word Wrapping option selected.

Text - Split String
Splits a single block of text into two separate text
blocks.
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= e

Text - Justification

== gpecify the justification for each text block: [Left Justi-

H

i
fie
s

fication], [Center Justification], [Right Justification], or
[Full Justification].

The [Wrap Text] and [Box Text] or [Column Width] op-
tions must be selected for text justification.

Text - Positioning

When the [Wrap text] option is selected, you can
specify the vertical positioning of a text block: [Top],
[Center] or [Bottom].

Use this option with [Text Justification] and [Box Text]
to place text in nine positions within the box.

Text - Lines per Inch

Specify a vertical lines per inch (LPI) value by clicking
on the up or down arrows or click in the numeric dis-
play box and enter a number. Press and hold <Ctrl>
while clicking to increase/decrease the value by 1.0.
This value you affects the current block of text and
any subsequent blocks of text entered using the same
font.

To return the lines per inch to the default for the cur-
rent font, use the down arrow to decrease the LPI
value to [0] or press <Del>.

Text - Lines per Inch - ON/OFF
Enables the Text - Lines per Inch option. Select this
option a second time to disable this feature.

Text - Color

If supported by your printer, you can apply color to a
text block. Color selection applies to the whole text
block, rather than a single word.

Select a text color from the palette in the Color dialog
box, then click on the [Close] button. The selected
color displays in the bottom half of the icon.

6-4
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To apply color to a text block:
1. Select the [Color] option.
The Color dialog box displays.
2. Select a color, then click on [OK].

3. Position the cursor in the work area, then
enter text.

The selected color applies to entered text, and
continues for all subsequent text blocks until you
select another color.

To apply color to existing text blocks:

1. Select the text to apply color to, then
right-click.

2. Select the [Color] option.
The Color dialog box displays.
3. Select a color, then click on [OK].

DocuTag/DataMerge - Data Tags - ON/OFF
Displays the Data Tagging dialog box which allows
you to add data tags to forms for use with Elixir's
DocuTag or DataMerge products. Select this option a
second time to disable this feature.

See your Elixir DocuTag User Guide or Elixir Da-
taMerge User Guide for more information on creating
data tags and tag lists.

Column Width and Height

Specify the width and height for a text block by click-
ing on the up or down arrows or click in the numeric
display boxes and enter a number. Press and hold
<Ctrl> while clicking to increase/decrease the value by
1.0. Values that exceed the form limits are not
accepted.
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You must select the [Wrap] text option when using
these options. When these options are set to [0.00],
text entered is bound only by the width and height of
the form.

Select the [Box Text] option along with these options
to display a visual guide box with the width and height
dimensions you specify.

Text - Draw Column Box Boundaries

Select this option after selecting the [Box Text] option
to define column boundaries for text by drawing a vis-
ual box in the Work area. Place the cursor in the
Work area and press and hold down the mouse but-
ton. Drag the box that displays and release the
mouse button at the bottom right of the box. This box
does not print.

Select the [Wrap Text] option to wrap text at the
boundary of the text box defined by this option. Select
the [Text Positioning] option to position text within the
text box.

Text - Set Column Width/Height to Define Box -
ON/OFF

Select this option when using the [Draw Text Box] or
[Column Width] and [Column Height] options to enter
text in predefined areas or "boxes." Select this option
a second time to enter free text which is bound only by
the width and height of the form.

Box boundaries are defined by entering values in the
[Column Width] and [Column Height] options or by
drawing a box manually using the [Draw Text Box]
option.

Boxed Text/Free Text (toggle)

ElixiForm allows you to enter text in predefined areas
or "boxes." You can define the box boundaries by en-
tering dimension values for the column height and
width or by drawing a box manually.

To enter dimension values:

1. Select the [Box Text] option.
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2. Enter values for the [Column Width] and
[Column Height] options, then click in the
work area.

A text box with the specified boundaries displays.
To draw a text box manually:
1. Select the [Box Text] option.
Select the [Draw Text Box] option.

3. Place the cursor in the Work area and hold
down the mouse button.

4. Drag the box and release the button at the
bottom right of the box.

This box is not the same as one you draw using
the Box tool; rather, it is a visual aid for defining
the column width and height for a text block only.

5. Select the [Wrap text] option, then select text
positioning to [Top], [Center] or [Bottom].

6. Enter text in the box; press <Enter> to insert
carriage returns and begin new paragraphs.

7. When finished entering text, right-click.

Font Type
Click on this button until the desired font type displays:

® [f] - Elixir-version fonts
® [T]- True Type fonts
® [a]- ATM fonts

Text - Add/Remove Font from List
Select a font action. The dialog box that displays de-
pends on your selection in the [Font Type] option.

® [+] - displays the Add Fonts, Select True Type
fonts, or Select ATM fonts dialog box; select a
font(s) to add to the current Font List, then click
on the [ADD] button
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You can select the Elixir-version of the font to add
(either .HDR or .FNT) from the drop-down list in
the Add Fonts dialog box.

® |[-] - displays the Replace Font, Select True Type
Fonts, or Select ATM Fonts dialog box; select a
font(s) to remove from the current Font List, then
click on the [DEL] button. If the font is in use on
the form, select a replacement font from the Re-
place Font dialog box.

Text - Load Font List/Merge Font List/Save Font
List
Select a Font List action:
E2FIE e [down arrow] - displays the Load Font List dialog
box

® [double arrows] - displays the Merge Font List dia-
log box; add fonts to the current font list by load-
ing another font list

® [up arrow] - displays the Save Font List dialog
box; enter a new file name for the current font list,
or rename an existing font list

Text - Soft Keyboard

Enters characters that are not available on a standard
keyboard. See the "Text operations" chapter for more
information on using the soft keyboard.

[] xoaess8C Font Preview Panel

assmccanseteg| Displays the fonts available in the current Font List.
[&] =ma@7sac | Click on the up or down arrow or use the scroll bar to
askBecedD el scroll through the list to change the current font.

Fonts in use on a form are denoted by a diamond
character to the left of the font name.

Font list

ElixiForm allows you to select a font from the current
list or one loaded from a new list. You can also merge
and save font lists.

ElixiForm has a limit of 16 fonts per form.

6-8 ELIXIFORM USER GUIDE



TEXT OPERATIONS

[&] =Badss8C
AaAMECCADLEFFg

IE x®BaBrhac

afAbkBcldDe

[#] =Ba1557C
aMpBcCd0asfrg O

Selecting

When you open a new form, the current font list dis-
plays in the Font Preview Panel, with the current font
selected.

A font list file (.LST) contains a listing of TrueType,
ATM and Elixir-format screen font files, and is stored
in the screen fonts directory defined in the Filing Op-
tions dialog box. During installation, the default
screen fonts directory is
driveAELIXIR\FONTS\SCREEN\DEMO.

When you open a new form, the default font list
(DEFAULT.LST) displays in the Preview Panel of the
Toolbox. This file is loaded into the Elixir screen fonts
directory during installation.

The [Text - Load Font List/Merge Font List/Save Font

List] option allows you to select a new font list or
merge lists and save it with a new name.

Loading

To load a different font list:

1. Select [down arrow] in the [Text - Load Font
List/Merge Font List/Save Font List] option.

The Load Font List dialog box displays.
2. Select a font list file (.LST), then click on [OK].
The font list displays in the Font Preview Panel.

3. Select a font, then click on [OK].

Merging

You can merge the current font list with other font
lists, or add individual fonts from other lists.

To merge a font list with the current font list:

1. Select [down arrow] in the [Text - Load Font
List/Merge Font List/Save Font List] option.

The Merge Font List dialog box displays.
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1|+

2. Select the font list to merge, then click on

[OK].

The fonts add to the current font list.

Customizing

You can create and save your own custom font lists
for particular forms or groups of forms.

To save a custom font list:

1.

Click on the up arrow under the [Font List]
option.

The Save Font List dialog box displays.

Enter a new or existing file name, then click
on [OK].

Adding fonts

To add fonts to the current font list:

1.

Click on the [Font Type] option until the
desired font type (a=ATM, T=TrueType or
f=Elixir) displays.

Select the [Add Font] ([+]) option.

Depending on [Font Type] selected, either the Se-
lect ATM Fonts, Select TrueType Fonts or Add
Fonts dialog box displays.

Select the font to add, then click on [OK].

Repeat these steps for each font type you want to
add.
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Removing fonts

To remove a font from the current list:

1.

Select the font name in the Font Preview
Panel.

Click on [-].

The font removes from the list. You cannot re-
move a font that is in use on your form.

You can also use <Ctrl> + <-> to delete all un-
used fonts from the list.

Entering non-standard characters

o

-

A

The soft keyboard allows you to enter characters that
are not available on a standard keyboard.

To type an extended character:

1.

Click in the Work area where you want the
character to appear.

Select the [Soft Keyboard] option.

The soft keyboard displays.

Figure 6-2. Soft Keyboard

Select character(s) from the soft keyboard.
The character(s) displays at the selected position.

Select the [Soft Keyboard] option a second
time, when finished.

You can also access the non-standard keyboard char-
acters by pressing <Alt> and entering the correspond-
ing decimal value using the numeric keypad.
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The soft keyboard displays characters in the current
font size, so smaller fonts may be difficult to read. You
can change the current font to a larger point size, edit
using the soft keyboard, then change the text block
back to the smaller font after editing.

Importing text

ElixiForm allows you to import ASCII text as a com-
plete file or as separate text blocks (separated by two
carriage returns) from the directory specified in the Fil-
ing Options dialog box. Default is
drive:\ELIXIR\TEXTS.

You can change the attributes of an imported text
block by selecting the attributes from the Text tool be-
fore importing each block.

Before you import text, you must:

®  Copy the ASCII file to the texts directory specified
in the Filing Options dialog box

® Assign the ASCII file a .TXT extension

®  Separate paragraphs (or text blocks) with two car-
riage returns

Importing complete text blocks

To import text as a complete block:

1. Select the Text tool in the Toolbox.
The Text toolbox displays.

2. Select one of the following options:

[Locked text] - the text block loads directly be-
low the previous block

[Free text] - the text block loads wherever you
click the screen pointer.
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The Message area displays the current setting.

3. Select text attributes option(s) in the Text
toolbox.

4. Select [Text/Font Options] from the Options
menu.

The Text and Font Options dialog box displays.

5. Deselect [Import Text Options - Separate
paragraphs], then click on [OK].

6. Select [Import Text] from the File menu

The Import Text dialog displays the files in the
drive:\ELIXIR\TEXTS directory.

7. Select the file you want to load, then click on
[OK].

8. Press and hold the screen pointer to display
the first text block.

- To scroll through the text blocks, continue
holding down the mouse button.

- To scroll to the previous text block, press
<F3>.

- To scroll to the next text block, press <F4>.

9. Drag the text and release the left mouse
button to place the first text block on the
form.

10. Click to display and place the next text block.
11. Click on [OK] when done.

When an ASCII file is imported, the complete file
attaches to the cursor for positioning unless the
[Import Text Options - Lock position] option is se-
lected. In that case, the text file attaches to the
previous cursor position in the Work area.
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The selected font size and the amount of loaded
text determines whether or not the whole ASCII
file can fit on a form.

Importing text as separate blocks

To import text as separate blocks:

1.

Select the Text tool in the Toolbox.
The Text toolbox displays.
Select one of the following options:

[Locked text] - the text block loads directly be-
low the previous block

[Free text] - the text block loads wherever you
click the screen pointer.

The Message area displays the current setting.

Select text attributes option(s) in the Text
toolbox.

Select [Import Text] from the File menu

The Import Text dialog displays the files in the
drive:\ELIXIR\TEXTS directory.

Select the file you want to load, then click on
[OK].

Press and hold the screen pointer to display
the first text block.

To scroll through the text blocks, continue
holding down the mouse button.

To scroll to the previous text block, press
<F3>.

To scroll to the next text block, press <F4>.
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7. Drag the text and release the left mouse
button to place the first text block on the
form.

8. Click to display and place the next text block.

9. Click on [OK] when done.

Importing text into a box

When importing text into a text box, you must define
the text box size first. See the "Specifying text attrib-
utes" section for information about boxed text.

Text imported into a box does not retain original car-
riage returns. To maintain the original carriage re-
turns, make sure the [Box Text] and [Wrap Text]
options are deselected.

Data tags

Ef’

ElixiForm allows you to add, edit and view Data tags
for use with DocuTag or DataMerge software.

See your DocuTag User Guide or DataMerge User
Guide for detailed information.

Editing text

When editing text, the name of the font used to create
the text highlights in the Font Preview Panel. You
must select a text block before you can edit it.

To select a text block:

1. Select the Toolbox Select/Edit tool.
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You can also change to select mode by right-
clicking on the text. However, if you are still in add
text mode, this right-click ends text entry; you
must right-click again to change to select mode.

Place the cursor on the text block you want to
edit, then right-click.

The Text toolbox displays.

See the "Keyboard shortcuts" section for use when
editing text.

Changing text attributes

Changing fonts

To change the attributes of a selected text block, se-
lect Text toolbox icons. Each new attribute applies to
the selected text block.

To change the font in a text block:

1.

Select the text block, then right-click.
The Text toolbox displays.

Place the cursor at the beginning of the text
block.

Select a font from the Font Preview Panel.

The new font applies to all text in the text block.

When you change the font as described above, a hid-
den control character adds before the changed text
which contains font information. You can delete this
character to change the text back to its original font.
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Replacing fonts

To replace every occurrence of a font:

1. Select the font to replace in the Font Preview
Panel.

2. Select [-] in the [Text - Add/Remove Font from
list] option.

Depending on font type being replaced, the Select
ATM font, Select TrueType font or Replace Font
dialog box displays.

3. Select a replacement font, then click on [OK].

If the replacement font is not currently in use on
the form, all occurrences of the font are replaced
by the new font.

If you click on [-] and the font is not in use in the docu-
ment, the font removes from the font list. See "Adding
or removing a font" for more information on removing
a font.

Applying multiple fonts to a text block

When editing text, the name of the font used to create
the text highlights in the Font Preview Panel. If multi-
ple fonts are used, the highlighted font changes as
you place the cursor on different fonts.

All fonts in the text block must have the same orienta-
tion. To use a font with a different orientation, place
the cursor at the beginning of the text block and apply
the orientation to all fonts within the block.

To change a font location to the end of the text block:
1. Select the text block, then right-click.

2. Place the cursor where you want the new font
to start, then click.
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Joining text

3.

Select a font from the Font Preview Panel.

All text after the cursor changes to the selected
font.

To change the font of a word or phrase in a text block:

1.
2,

Select the text block, then right-click.
Select the word or phrase to change.

Select a new font from the Font Preview
Panel.

The selected text displays in the new font.

ElixiForm allows you to rejoin text separated during
form conversion to .ELX format.

To join text:

1.

Select [Text/Font Options] from the Options
menu.

The Text and Font Options dialog box displays.

Select a [Join Text Using] option: [Spaces],
[Justify] or [Relative], then click on [OK].

See the "ElixiForm defaults" chapter for informa-
tion on the Text and Fonts Options dialog box.

Group the text you want to join.

See the "ElixiForm basics" chapter for information
about defining a group.

Select the [Join Text] option.

The text in the group joins.
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Splitting text

To split a text block into two separate blocks:

1.

Select the text block to split, then right-click.
The Text toolbox displays.

Place the cursor where you want to split the
text.

Select the [Text - Split String] option in the
Text toolbox.

The text splits and the cursor displays in the up-
per left corner of the new text block.

See the "Moving text" section for information on repo-
sitioning the text block.

Moving text

You can move a text block either before or after enter-
ing text.

Manually

To manually move a text block:

Rl 4
ol

Select the Toolbox Select/Edit tool.

Select the direction for moving: [Horizontal
only], [Vertical only] or [Free].

Select the text block to move.
The cursor changes to a hand.

Click and drag the text block to where you
want it on the form.

Release the mouse button to accept the text
position.
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Changing dimension coordinates

You can also move the text block by entering new di-
mension coordinates:

LT 128
x 1.62 1. Select the Toolbar Current Object - Start
Coordinates area.
If you cannot click on this area, select the line
again, then right-click.

2. Backspace over the current values or press
the <Del> key to delete the current values,
enter new coordinate values, then press
<Enter>.

The text adjusts to the new coordinates.
Copying text
To copy a text block:
Ri 1. Select the Toolbox Select/Edit tool.
% 2. Select the Toolbox [Copy] option.
:’Iiﬂ 3. Select the direction for copying: [Horizontal
only], [Vertical only] or [Free].

4. Select the text block to copy.

Brackets appear around the text to show it is se-
lected.

1:|% 5. Enter a value or click on the up or down
arrows to select the number of copies
between 1 and 99.
Hold down the <Ctrl> key while clicking on the ar-
rows to increase or decrease the value by 10.
You can also backspace over the value and enter
a new value from the keyboard.

6. Drag the block of text in the direction you
want to place the copies.
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7.

Release the mouse button at the desired loca-
tion.

The copies lock into position in the Work area.

Cutting, copying and pasting text

ElixiForm uses hot-keys to cut and paste selected

text.

To cut or copy and paste text:

R 1.

P w N

o

Deleting text

Select the Toolbox Select/Edit tool.
Right-click on the text block.
Select the text to be cut or copied.

Press <Ctrl> + <X> to cut text; press <Ctrl> +
<C> to copy text.

Right-click to end text selection.
Select the Toolbox Text tool.
Click the cursor at the new location.

Press <Ctrl> + <V> to paste text.

To delete text:

To

Select the text block.
Press <Del>.
The selected text block deletes.

restore deleted text, immediately select [Undo]

from the Edit menu, click on the Toolbar Undo icon or
press <Ctrl> + <Z>.
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Finding/replacing text

ElixiForm allows you to replace occurrences of
word(s) on a form and to find text and non-standard
keyboard characters.

Finding

To find text:
1. Select [Find] from the Edit menu.
The Find Text dialog box displays.

2. Enter the tes to find in the [Find Text] option,
then click on the [Find] button.

To find non-standard keyboard characters:
1. Select [Find] from the Edit menu.
The Find Text dialog box displays.

2. Enter the decimal value (from the Windows
character mapping table) of the character in
the [Find Text] option, then click on the [Find]
button.

The Find Text dialog box contains the following
options:

Find Text
Enter a search text string or select a previously-used
one from the drop-down list.

Case Sensitive
Searches for text with the same capitalization as the
text in the [Find Text] option.

Whole Words
Searches for complete words that match the text in
the [Find Text] option.

For example, searching for “the” returns only “the” -
not words containing “the”, such as "there”.
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Find
Searches the open form for the text selected/entered
in the [Find Text] option.

Cancel
Closes the Find Text dialog box.

Help
For future implementation.

Once a Find session has been performed, pressing
<Ctrl> + <F3> finds the next occurrence of the
searched for text; pressing <Ctrl> + <Shift> + <F3>
finds the previous occurrence of the text.

Replace

To replace occurrences of a word:
1. Select [Replace] from the Edit menu.
The Replace Text dialog box displays.

2. Select/enter search and replace options, then
click on the [Replace] or [Replace All] button.

The Replace Text dialog box contains the following
options:

Find text
Enter a search text string or select a previously-used
one from the drop-down list.

Replace by
Enter a replacement text string or select a previously-
used one from the drop-down list.

Case Sensitive
Searches for text with the same capitalization as the
text in the [Find text] option.

Whole Words
Searches for complete words that match the text in
the [Find text] option.
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For example, searching for “the” returns only “the” -
not words containing “the”, such as "there”.

Replace
Replaces the current instance of the [Find text ] option
text with the [Replace by] option text.

Replace All
Replaces all instances of the [Find text] option text
with the [Replace by] option text.

Cancel
Closes the Replace Text dialog box.

Help
For future implementation.

Spell checking

If installed, the ElixiForm Spell Checker option allows
you to identify misspelled words in your form.

Spell checking is not available for forms converted to
Xerox format with [Optimize] selected on output, as
optimization does not maintain the originally-entered
text stings.

Setting defaults

To set spell check defaults:

1. Select [Spell Check Options] from the Options
menu.

The Spell Check Options dialog box displays.
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Spell Check Options ]
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Edit |

| __| Spell Check Typing

Figure 6-3. Spell Check Options dialog box
2. Select spell check options, then click on [OK].

The Spell Check Options dialog box contains the fol-
lowing options:

Language
Select the language to use from the drop-down list.

Dialect/mode
Select the dialect/mode for the selected language
from the drop-down list.

Lexicon Supplements
Select a terminology dictionary:

® [Business/Insurance/Finance] - contains busi-
ness, insurance, or financial terminology

® [Medical] - contains medical terminology
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® [Legal] - contains legal terminology
® [Science] - contains scientific terminology

Processing Correction Defaults
These options are used only when errors are found:

® [Provide Alternatives If Not Found] - provides al-
ternative words if a word is not found in the
database

® [Provide Alterns. From Personal Dictionary] - pro-
vides alternative words from active personal dic-
tionaries after alternatives from the active
database are retrieved

e [Perform Space Insertion] - inserts spaces be-
tween incorrectly spaced words; For example, the
string "andthe" is corrected to "and the".

®* [Remove Final Period] - strips the final period
from a word before it is submitted for correction

Personal Dictionaries
Displays the dictionary files (*.RD) available for use.

New
Enter a name for the new personal dictionary in the
Create Personal Dictionary dialog box.

Add

Select an existing personal dictionary (*.?D) dictionary
to add to the Personal Dictionaries field in the Add
Personal Dictionary dialog box.

Remove
Removes the selected dictionary from the Personal
Dictionaries field.

Edit
Edits entries in the dictionary selected in the Personal
dictionaries field.

Click on the [Add], [Delete], or [Replace] button to per-
form the appropriate action for the word that displays
in the Edit word field in the Edit Personal Dictionary
dialog box.
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Spell Check Typing

Activates the spell check option after a word is typed.
Once a word is entered and the space bar is de-
pressed, the word is spell checked.

Using the Spell Checker

The Spell Checker checks all text in the current form
for misspelled words.

To use the ElixiForm Spell Checker:
1. Click on the Toolbar Spell Check icon.

If Spell Checker does not recognize a word, the
Spell Check dialog box displays. The unrecog-
nized word displays in the [Edit] option; the possi-
ble correct word displays in the [Guess] option.

2. If the word displayed in the [Guess] option is
not correct, select an alternative word from
the drop-down list.

3. If the word is not found in the drop-down list,
place cursor in the [Edit] option, backspace
over the misspelled word, then enter the
correct spelling.

4. Select one of the following options:

Replace
Replaces the misspelled word with the [Edit] op-
tion text.

Replace All
Replaces all instances of the misspelled word
with the [Edit] option text.

Ignore
Ignores the first occurrence of the text in the [Edit]
option.

Ignore All
Ignores all occurrences of the text in the [Edit]
option.
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Stop
Stops spell checking and closes the Spell Check
dialog box.

A 'beep’ indicates when a spell check operation
completes.
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7. Images

Depending on your version of ElixiForm, you can
place Elixir-format two-tone color, full-color, and
black-and-white images into your form.

Screen versions of images have .LW8 extensions and
reside in the drive\ELIXIR\PICS\SCREEN directory.
Printer versions of images have .LP3 extensions and
reside in the drive \ELIXIR\PICS\PRINTER directory.

See the ElixiGraphics User Guide for more informa-
tion about creating Elixir-format images.

Loading an image

You can load a maximum of 16 images or logos to a
form. The size allowed for an image depends upon
the amount of available Windows memory and the ca-
pability of your printer.

% To add an image to your form:

1. Select the Image tool in the Toolbox.

The Image toolbox displays.
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Figure 7-4. Image toolbox

If an image is already loaded, the image name,
coordinates, and an image preview also display.

@ 2. Select the Toolbox [Load Image] option.
The Load Image dialog box displays.
3. Select an image, then click on [OK]
4. Press and hold the mouse button.
The image attaches to the screen pointer.

5. Position the image on the form, then release
the mouse button.

The image locks into place.

Foreground and background colors

Although colors may display on the screen, the fore-
ground and background color options do not apply to
all ElixiForm products. For more information about
color and your printer, see the appropriate appendix
for your printer.
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Editing images

Editing images in ElixiForm is limited to changing the
background and foreground color of the image for us-
ers with printers that support color printing.

Changes to the actual image must be done using

ElixiGraphics. See the ElixiGraphics User Guide for
more information about creating Elixir-format images.

Changing image colors

To change the background and foreground color of an
image:

L“‘ 1. Select the Select/Edit tool in the Toolbox.

2. Right-click on the image to edit.
The Image toolbox displays.
jﬂ 3. Select the [Color] option.
The Color dialog box displays.
4. Perform one of the following:

Click on a color to change the foreground
color.

Right-click on a color to change the back-
ground color.
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Moving an image

You can move an image on your form either manually
or by entering new position coordinates.

Manually

To move an image manually:

Rl 4

2,

Select the Select/Edit tool in the Toolbox.
Select the image to move.

Select the direction for moving: [Horizontal
only], [Vertical only] or [Free].

Click and drag the image to the new location.
Release the mouse button

The image locks into position.

Changing dimension coordinate

To move an image by entering new dimension coordi-

nates:
LT 128
x 162 1. Select the Toolbar Current Object - Start
Coordinates area.
If you cannot click on this area, select the line
again, then right-click.

2. Backspace over the current values or press
the <Del> key to delete the current values,
enter new coordinate values, then press
<Enter>.

The image moves to the new coordinates.
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Copying an image

To copy an image:

Rl 4.

2,

Select the Toolbox Select/Edit tool.

Select the image to copy.

Boxes appear around the image when selected.
Select the Toolbox [Copy] option.

Click on the up and down arrow to specify
number of copies.

Select the direction for copying: [Horizontal
only], [Vertical only] or [Free].

Click and drag the image in the direction you
want the duplicate images to display.

Release the mouse button to lock the images
in place.

Deleting an image

To delete an image:

1.

2,

Select the Toolbox Select/Edit tool.

Select the image you want to delete, then
press <Del>.

To immediately undo the delete operation, either click
on the Toolbar Undo icon or select [Undo] from the
Edit menu
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HighLight color printers

This chapter describes options that apply to ElixiForm
supplied with the HighLight Option and Plus products.
These options affect the application of colors to form
elements and printing forms on Xerox HighLight Color
Laser Printing System printers (4850 and 4890).

How colors print

Xerox HighLight Color printers use proprietary tech-
nology to print with black plus one other color (red,
green, or blue dry ink toners) and white (the paper
color). These printers are also full black-and-white
printers.

Highlight color printing is the process of printing dots
of primary colors very close to each other. Only one
primary color toner may be used in the printer at any
time. The printer's highlight color capability allows it to
produce the black and the second color in their pure
form, and also to produce tints and shades of these
primary colors.

The pure colors are called hues or highlight colors. To
print different shades of a color, black dots are added
during printing. The higher the density of black dots,
the darker the shade. To print different tints of a color,
less color pixels are applied to the paper, which in-
creases the white component. The lower the density
of the color pixels, the lighter the tint. The different
combinations of color and black dots and white paper
produce different shades and tints of a color. These
shades and tints (including the pure highlight color)
are specified in a printer palette.
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Similarly, the different shades and tints of a color that
can be used for creating and displaying form elements
on a screen are described in a PC palette.

Color palettes

Xerox catalog

This section describes PC palettes, their relationship
to Xerox HighLight Color printer palettes, and how to
create and print color form elements.

Xerox HighLight Color printers use XEROX and
XEROX1 catalogs. The XEROX catalog contains the
RED, BLUE and GREEN palettes, and is used on the
4850 or the 4890 printer. The XEROX1 catalog con-
tains the RED1, BLUE1 and GREENL1 palettes and is
used on the 4890 printer.

See the following section for information about printer
palettes.

Xerox printer palettes

The colors that can be used for printing on a Xerox
HighLight Color printer are defined in a printer palette.
The printer palette file name can contain up to 15
characters.

A printer palette contains more than 100 ink names
(colors). Each color is described by a combination of a
highlight color toner (pure red, blue, or green) with
black ink and white (paper color) which defines the
shade and tint of the color.

ElixiForm supports the following printer palettes on the
4850 and 4890 printers: RED, GREEN, and BLUE,
and supports the following printer palettes on the 4890
printer: RED1, GREEN1 and BLUEl. See the
"Printer/PC palette values tables" section in this chap-
ter for more information.

HLC-2
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PC palette

The tint of a color is determined by the density of the
highlight color toner dots (pixels) on paper. 100% den-
sity corresponds to the pure highlight color and 0%
corresponds to white. Decreasing the density pro-
duces lighter tints of the highlight color.

The shade of a color is determined by the density of
black ink dots mixed with the color.

For example, the color R17 in the RED printer palette
is defined as follows: R17 =17 O.

The first number after the color name is the color den-
sity and shows 17% of full saturation. When printing,
17% of the area to be colored contains highlight color
dots, which produces a lighter tint of the color.

The second number is the darkness or black compo-
nent of the color. In the example, none of the area to
be printed in color will contain black dots.

To create an Elixir form that can be converted and
printed on a HighLight Color printer, a pattern file cor-
responding to the printer palette, described in the
"Xerox printer palettes" section, must exist on the PC
as follows:

* The PC patterns are in
drive\ELIXIR\DESKTOP\SYSTEM\PATTERNS\,
where drive: is the hard disk drive where Elixi-
Form is installed. The files that contain the way
these patterns display in ElixiForm have .INK
extensions.

® The PC patterns are ASCII files that contain a list
of ink names.
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Applying highlight color to a form

You can apply only black and the selected highlight
color to lines, images and text. Patterns are used only
to fill boxes.

The [Color] and [Fill] options in the Toolbox display the
selected color.

Lines, box borders, text and images

To apply a highlight color to lines, box borders, text
and images:

1. Pull down the Options menu and select [Page
Properties].

The Page Properties dialog box displays.

2. Make sure the [HighLight Color], [Catalog],
[Printer palette] and [Ink dominance] options
are selected.

See the "ElixiForm defaults" chapter for more in-
formation about the Page Properties dialog box
and options.

3. Click on [OK].

4. Select the Line, Box, Text or Image tool to
display the Toolbox.

ﬂﬂ 5. Select the [Color] option.

The color palette displays black and the selected
highlight color.

Figure HLC-1. Color palette.
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6. Select either black or the highlight color to
apply to any lines, box borders or text you
create on the form.

See the "Graphics" section in this chapter for in-
formation about highlight color images.

You can replace all occurrences of the highlight color
by selecting another highlight color in the Page Prop-
erties dialog box. However, only one highlight color
can be used per form.

Box fills
ElixiForm allows you to fill a box with black, a highlight
color or a pattern.
All highlight color patterns available on HighLight
Color printers are supplied with ElixiForm and are in-
stalled in the
drive\ELIXIR\DESKTOP\SYSTEM\PATTERNS
sub-directory.
To fill a box:

E! 1. Select the Box tool in the Toolbox.

To change the fill pattern of an existing box, se-
lect the box then click on the selected box with
the right mouse button.

E === 2. Selectthe [Pattern] option in the Toolbox.

The local pattern palette displays.

Figure HLC-2. Local pattern palette
3. Click on [Palette].

The remote pattern palette displays.
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mﬁ*

k] ] (e

Figure HLC-3. Remote pattern palette

Click on the down arrow and select the
highlight color palette.

Click on the patterns you want to use in your
form. You can also drag and drop the
patterns from the remote palette to the local
palette.

The patterns are copied to the local palette.

If you want to use a previously saved palette,
select [Load] to replace the current palette or
[Merge] to merge with the current palette, and
select a palette from the Load or Merge
Pattern Palette dialog box.

The patterns display in the local palette.

Select a pattern for the box fill.

Place the cursor in the work area and draw a
box.

If an existing box is selected, the fill pattern of that
box changes when you select a new pattern.

If you want a pattern filled box without a border, set
the [Border Width] option to [O].

If you want to draw a box without a fill, select the [Hol-
low] option in the local palette.

The palette is saved with your form when you select
[Save].

To remove a pattern from the local pattern palette,
click on a pattern and press <Del>.

HLC-6
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Replacing box fills

ElixiForm allows you to replace patterns in the local
pattern palette by dragging and dropping patterns
from the local or remote pattern palette windows. If
the pattern is in use on the form, all elements using
that pattern are replaced with the replacement pattern.

To replace a pattern in the local pattern palette:

1. Select the [Pattern] option.
The local pattern palette displays.

2. If you are replacing a pattern with a pattern
from the remote palette, click on [Palette].

The remote pattern palette displays.

3. Select the pattern you want to use from the
local or remote pattern palette, and drag and
drop it on top of the pattern you want to
replace.

Note that you cannot replace the predefined black
or highlight color.

4. If the pattern is currently in use on your form,
you are prompted to confirm that you want to
replace all occurrences of that pattern with
the new pattern.

Note that if you use a pattern in your local palette to
replace another pattern in your local palette, the total
number of patterns in the palette is reduced.

If you drag a pattern from the remote palette to the lo-
cal palette and do not drop it on another pattern, the
pattern from the remote palette is simply added to
your local palette.

Saving a local palette

If you want to save the local palette for use in another
form, click on [Save] in the local palette. The Save
Pattern Palette dialog box displays. Enter a name for
the palette and click on [OK].
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Loading a previously saved palette

To use a previously saved palette, select [Load] to re-
place the current palette or select [Merge] to merge
the previously saved palette with the current palette,
and then select a palette from the Load or Merge Pat-
tern Palette dialog box.

Displaying color forms

If you have a color VGA monitor, all color elements
display the colors applied to them. If you have a
monochrome monitor, color elements display in black
(note that on a monochrome monitor, ElixiForm dis-
plays the name of a loaded color form with an asterisk
* next to the form name).

Displaying selected elements only

To alternately display all elements, only black ele-
ments, or only color elements, press <Alt> + <F9>,
<Alt> + <F9> is a three-way toggle that allows you to
display elements selectively.

Graphics

The following section provides information for using
graphics in a highlight color form.

Adding color to black-and-white graphics

If the graphic on your form is black-and-white, you can
set the foreground to a highlight color.

To add a highlight color to a black-and-white graphic:

HLC-8
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1. Click on the graphic with the right mouse
button.

The graphic is selected and the Image toolbox
displays. (If the Image toolbox does not display,
click on the image again with the right mouse but-
ton).

]

Jﬂ 2. Select the [Color] option.

The color palette displays the pure highlight
colors.

3. Select a color.

The foreground color changes to the selected
color.

Converting color graphics to .LGO and .IMG

If your form contains graphics, you must convert each
Elixir-format graphic to either a Xerox format logo
(.LGO) or to a Xerox format image (.IMG) and include
it with the converted form. You can convert the form to
either .FSL or .FRM formats. Converting the form to
.FRM format saves you having to compile the .FSL
source file on the printer.

This section assumes you are familiar with using Elixi-
Graphics with highlight color. See the ElixiGraphics
User Guide for more information.

The color (two-plane) Elixir graphic you import into a
form contains graphic components in black and color
planes.

The foreground color and background color options
correspond to the black and color planes in the
graphic (one of them is always black).

If the PC palettes used to create the graphic and the
form are the same, the background and foreground
colors correspond to the black and color planes used
in creating the graphic. If the palettes are different, the
color displayed is the color in the ElixiForm palette
that corresponds to the position of the highlight color
in the ElixiGraphics palette.
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For example, assume that the highlight color used for
the color plane in ElixiGraphics is RED and is the 6th
color in the ElixiGraphics palette (R17). When you
load the graphic in ElixiForm, the color displayed in
the submenu will be the 6th color in the ElixiForm pal-
ette. Note that if there is no corresponding position in
the ElixiForm palette the color will print as black.

You can change the colors within the plane by clicking
on the patterns as long as either the foreground or
background color is set to black; the other can be any
color in the PC palette. You can also switch the black
plane to color as long as you also switch the color
plane to black.

To change the color of the graphic color plane (for ex-
ample from RED to BLUE), select a different palette.

You can also change the color to any of the colors
listed in the current PC palette and display it on the
screen (if you have a color VGA monitor), but the
color portion of the graphic will print using only the
pure highlight color toner.

If you change the color of a graphic on a form and
convert the graphic to .LGO format, the form will not
print correctly. When changing the color, always con-
vert the graphic to .IMG format.

To add different shades and tints of color to the
graphic, use ElixiGraphics to add textures to the
graphic by loading one of the highlight color patterns.
Each pattern contains ink names (textures) which you
can apply to the graphic. See the ElixiGraphics User
Guide for more information.

Paper sizes

Xerox Highlight Color printers support printing on 8.5 x
11 inches, 8.5 x 14 inches, and A4 (8.27 x 11.69
inches) paper.
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Proof printing on full color printers

You can proof print highlight color forms on the 4700
full color printer using the HighLight Color Replicant
Palettes for the 4700. However, the highlight color
used in images may not look identical to the highlight
color used in lines, boxes or text.

See the "4700 Printers" chapter for more information.

Printer/PC palette values tables

The following tables list the colors (inks) in the RED,
GREEN, BLUE, RED1, GREEN1 and BLUE1 color
palettes used on Xerox HighLight Color printers. High-
light color tint and shade values are listed for the col-
ors in each printer palette, and RGB percentage
values are listed for the corresponding RED, GREEN,
BLUE, RED1, GREEN1 and BLUE1 PC color palettes.
The RGB value information applies to PC palettes
only, and is included as a guideline to help users cali-
brate their PC palette RGB values so screen colors
emulate printed colors as closely as possible.

The PC palettes supplied with HighLight Option, and
Plus products are written to:
drive\ELIXIR\DESKTOP\SYSTEM\PATTERNS

®  The first column is the color (or ink) name.

® The second column, tint, is the highlight color
density percentage, and corresponds to the tint
(lightness) of a highlight color. The number is the
percentage of the color area covered with high-
light color pixels.

®  The third column, shade, is the percentage of the
color area covered with black pixels, and corre-
sponds to the shade (darkness) of a highlight
color.
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® The fourth, fifth, and sixth columns for PC pal-
ettes are the red (R), green (G), and blue (B) per-
centage values of the brightest screen colors
(100%), which when combined produce screen
versions of each palette color.

Inks for the XEROX (4850) catalog contain the color
initial (R=Red, B=Blue, G=Green) reference with the
percentage and the Black (K=Black) reference with
the percentage i.e. R47K53, B22K33, G10K15. The
ful  call out for the ink is  written:
XEROX.RED.R47K53.

Inks for the XEROX1 (4890) catalog contain the per-
centage of HLC (not specific to the color H=highlight
color percentage) and the black reference. The only
way you know what HLC is being called out is by the
rest of the reference i.e. XEROX1.RED.H47K53,
XEROX1.BLUE.H22K33, XEROX1.GREEN.H10K15.

HLC-12
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XEROX RED Palette: printer/PC values

Color Name tint shade R G B
KO 0 0 100 100 100
K1 0 1 99 99 99
K3 0 3 97 97 97
K9 0 9 91 91 91
K15 0 15 85 85 85
K23 0 23 77 77 77
K34 0 34 66 66 66
K45 0 45 55 55 55
K55 0 55 45 45 45
K65 0 65 35 35 35
K74 0 74 26 26 26
K84 0 84 16 16 16
K90 0 90 10 10 10
K95 0 95 5 5 5
K100 0 100 0
R1K94 1 94
R1K92 2 92
R3K86 3 86 14 11 11
R4772 4 72 28 24 24
R4K80 4 80 20 16 16
R4K82 4 82 18 14 14
R6K51 6 51 49 43 43
R6K61 6 61 39 33 33
R6K89 6 89 11 5 5
R8K19 8 19 81 73 73
R8K31 8 31 69 61 61
R8K42 8 42 58 50 50
ROK62 9 62 38 29 29
ROK72 9 72 28 19 19
R10 10 100 90 90
R10K7 10 7 93 83 83
R10K22 10 22 78 68 68
R11K2 11 2 98 87 87
R11K48 11 48 52 41 41
R11K82 11 82 18 7 7
R12K4-0 12 40 60 48 48
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XEROX RED Palette: printer/PC values

Color Name tint shade R G B
R12K77 12 77 23 11 11
R13K18 13 18 82 69 69
R14K28 14 28 72 58 58
R15K21 15 21 79 64 64
R15K67 15 67 33 18 18
R16K1 16 1 99 83 83
R17 17 0 100 83 83
R17K7 17 7 93 76 76
R17K73 17 73 27 10 10
R17K75 17 75 25 8 8
R18K57 18 57 43 25 25
R21K45 21 45 55 34 34
R22K1 22 1 99 77 77
R24K27 24 27 73 49 49
R25K5 25 5 95 70 70
R25K18 25 18 82 57 57
R25K63 25 62 38 13 13
R25K64 25 64 36 11 11
R27K56 27 56 44 17 17
R28K59 28 59 41 13 13
R29K57 29 57 43 14 14
R32K1 32 1 99 67 67
R32K46 32 46 54 22 22
R32K50 32 50 50 18 18
R33 33 0 100 67 67
R34K3 34 3 97 63 63
R34K37 34 37 63 29 29
R36K43 36 43 57 21 21
R37K27 37 27 73 36 36
R38K18 38 18 82 44 44
R40K1 40 1 99 59 59
R40K37 40 37 63 23 23
R41K4 41 4 96 55 55
R43 43 0 100 57 57
R43K33 43 33 67 24 24
R44K23 44 23 77 33 33
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HIGHLIGHT COLOR PRINTERS

XEROX RED Palette: printer/PC values

Color Name tint shade R G B
R44K41 44 41 59 15 15
R48K3 48 3 97 49 49
R5-K14 50 14 86 36 36
R50K28 50 28 72 22 22
R52 52 0 100 48 48
R52K20 52 20 80 28 28
R52K33 52 33 67 15 15
R57K1 57 99 42 42
R59 59 100 41 41
R59K11 59 11 89 30 30
R60K23 60 23 77 17 17
R61K17 61 17 83 22 22
R66K11 66 11 89 23 23
R66K22 66 22 78 12 12
R69K?2 69 2 98 29 29
R70 70 0 100 30 30
R72K13 72 13 87 15 15
R73K13 73 13 87 14 14
R75K2 75 2 98 23 23
R76 76 0 100 24 24
R76K13 76 13 87 11 11
R80 80 0 100 20 20
R85 85 0 100 15 15
R86K2 86 2 98 12 12
R91 91 0 100 9 9
R100 100 0 100

ELIXIFORM USER GUIDE

HLC-15



HIGHLIGHT COLOR PRINTERS

XEROX GREEN Palette: printer/PC values

Color Name tint shade R G B
KO 0 0 100 100 100
K1 0 1 99 99 99
K3 0 3 97 97 97
K9 0 9 91 91 91
K15 0 15 85 85 85
K23 0 23 77 77 77
K34 0 34 66 66 66
K45 0 45 55 55 55
K55 0 55 45 45 45
K65 0 65 35 35 35
K74 0 74 26 26 26
K84 0 84 16 16 16
K90 0 90 10 10 10
K95 0 95 5 5 5
K100 0 100
G1K94 1 94
G2K82 4 80 14 18 14
G2K85 4 82 14 18 14
G2K87 3 86 11 14 11
G2K92 2 92 6 8 6
G3K35 8 31 61 69 61
G3K45 8 42 50 58 50
G3K53 6 51 43 49 43
G3K66 6 61 33 39 33
G3K73 4 72 24 28 24
G4K19 8 19 73 81 73
G4K24 10 22 68 78 68
G4K89 6 89 5 11 5
G5 10 90 100 90
G5K5 11 87 98 87
G5K10 10 83 93 83
G5K66 9 62 29 38 29
G6K76 9 72 19 28 19
G7K24 15 21 64 79 64
G7K50 11 48 41 52 41
G8K17 13 18 69 82 69
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HIGHLIGHT COLOR PRINTERS

XEROX GREEN Palette: printer/PC values

Color Name tint shade R G B
G8K29 14 28 58 72 58
G8K83 11 82 7 18 7
G9 17 0 83 100 83
G9K41 12 40 48 60 48
G9K77 12 77 11 23 11
G11K1 16 1 83 99 83
G11K7 17 7 76 93 76
G12K67 15 67 18 33 18
G13K60 18 57 25 43 25
G13K75 17 73 10 27 10
G13K777 17 75 8 25 8
G16K5 25 5 70 95 70
G16K28 24 27 49 73 49
G16K39 22 37 41 63 41
G16K44 21 45 34 55 34
G17K1 22 1 77 99 77
G17K19 25 18 57 82 57
G19 23 0 77 100 77
G20K60 27 56 17 44 17
G21K63 25 62 13 38 13
G22 33 0 67 100 67
G22K64 25 64 11 36 11
G24K58 29 57 14 43 14
G24K61 28 59 13 41 13
G25K1 32 1 67 99 67
G25K52 32 50 18 50 18
G26K3 34 3 63 97 63
G26K46 32 46 22 54 22
G27K20 38 18 44 82 44
G27K26 37 27 36 73 36
G28K37 34 37 29 63 29
G21K43 36 43 21 57 21
G33 43 0 57 100 57
G33K1 40 1 59 99 59
G33K2 41 4 55 96 55
G33K41 40 37 23 63 23
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HIGHLIGHT COLOR PRINTERS

XEROX GREEN Palette: printer/PC values

Color Name tint shade R G B
G35K35 43 33 24 67 24
G36K23 44 23 33 77 33
G37K43 44 41 15 59 15
G41 52 0 48 100 48
G42K2 48 3 49 97 49
G42K14 50 14 36 86 36
G43K30 50 28 22 72 22
G45K20 52 20 28 80 28
G48 59 0 41 100 41
G48K2 57 1 42 99 42
G42K12 59 11 30 89 30
G49K33 52 33 15 67 15
G52K18 61 17 22 83 22
G56K22 60 23 17 77 17
G59K12 66 11 23 89 23
G62 70 0 30 100 30
G62K24 66 22 12 78 12
G63K1 69 2 29 98 29
G66K16 72 13 15 87 15
G67K2 75 2 23 98 23
G72 76 0 24 100 24
G73K16 76 13 11 87 11
G76K9 73 13 14 87 14
G80 80 0 20 100 20
G84K7 86 2 12 98 12
G86 85 0 15 100 15
G94 91 0 9 100 9
G100 100 0 100
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HIGHLIGHT COLOR PRINTERS

XEROX BLUE Palette: printer/PC values

Color Name tint shade R G B
KO 0 0 100 | 100 100
K1 0 1 99 99 99
K3 0 3 97 97 97
K9 0 9 91 91 91
K15 0 15 85 85 85
K23 0 23 77 77 77
K34 0 34 66 66 66
K45 0 45 55 55 55
K55 0 55 45 45 45
K65 0 65 35 35 35
K74 0 74 26 26 26
K84 0 84 16 16 16
K90 0 90 10 10 10
K95 0 95 5 5 5
K100 0 100 0
B1K96 1 94
B2K20 8 19 73 73 81
B2K93 2 92 6 6 8
B3K75 4 72 24 24 28
B3K83 4 80 16 16 20
B3K85 4 82 14 14 18
B3K88 3 86 11 11 14
B4K65 6 61 33 33 39
B5K25 10 22 68 68 78
B5K42 8 42 50 50 58
B5K50 51 43 43 49
B5K90 89 5 5 11
B6 10 0 90 90 100
B6K32 31 61 61 69
B6K75 72 19 19 28
B8K3 11 87 87 98
B8K7 10 83 83 93
B9K17 13 18 69 69 82
BIK71 9 62 29 29 38
B11K38 12 40 48 48 60
B11K48 11 48 41 41 52
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HIGHLIGHT COLOR PRINTERS

XEROX BLUE Palette: printer/PC values
Color Name tint shade R G B
B12 17 0 83 83 100
B12K21 15 21 64 64 79
B12K29 14 28 58 58 72
B12K83 11 82 7 7 18
B13K77 12 77 11 11 23
B15K68 15 67 18 18 33
B16K1 16 1 83 83 99
B16K4 17 7 76 76 93
B16K77 17 75 8 8 25
B18K59 18 57 25 25 43
B18K75 17 73 10 10 27
B19K51 24 27 49 49 73
B20K45 21 45 34 34 55
B22K36 22 37 41 41 63
B23 23 0 77 77 100
B23K3 25 5 70 70 95
B24K18 25 18 57 57 82
B25K1 22 1 77 77 99
B27K62 25 62 13 13 38
B27K64 25 64 11 11 36
B28K56 27 56 17 17 44
B29K60 29 57 14 14 43
B30 33 0 67 67 100
B31K61 28 59 13 13 41
B34K1 32 1 67 67 99
B34K2 34 3 63 63 97
B34K44 32 46 22 22 54
B34K51 32 50 18 18 50
B37K33 34 37 29 29 63
B38 43 0 57 57 100
B38K17 38 18 44 44 82
B38K23 37 27 36 36 73
B39K40 36 43 21 21 57
B42K40 40 37 23 23 63
B43K1 40 1 59 59 99
B45K1 41 4 55 55 96
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HIGHLIGHT COLOR PRINTERS

XEROX BLUE Palette: printer/PC values
Color Name tint shade R G B
B45K31 43 33 24 24 67
B49K1 48 3 49 49 97
B49K19 44 23 33 33 77
B49K2 44 41 15 15 59
B51 52 0 48 48 100
B51K14 50 14 36 36 86
B54K27 50 28 22 22 72
B58K17 52 20 28 28 80
B59 59 0 41 41 100
B61K32 52 33 15 15 67
B63K1 57 1 42 42 99
B64K10 59 11 30 30 89
B67K22 60 23 17 17 77
B69K14 61 17 22 22 83
B74 70 0 30 30 100
B75K11 66 11 23 23 89
B76K2 69 2 29 29 98
B76K22 66 22 12 12 78
B82K14 72 13 15 15 87
B83 76 0 24 24 100
B83K17 76 13 11 11 87
B85K1 75 2 23 23 98
B87KS8 73 13 14 14 87
B89 80 0 20 20 100
B91K9 86 2 12 12 98
B96 85 0 15 15 100
B98 91 0 9 9 100
B100 100 0 100

ELIXIFORM USER GUIDE

HLC-21



HIGHLIGHT COLOR PRINTERS

XEROX1 RED Palette: printer/PC values
Color Name R G B
HOKO 100 | 100 100
H100 91 0 1
H12
97 79 81
H12K1
98 75 77
H12K3
94 72 74
H12K61 19 1 1
H13K6
89 64 66
H13K73 1 . 6
H16
99 75 77
H16K1
98 69 71
HI6KI15 73 48 50
H16K24
59 36 38
H16K9 77 53 54
H17K19 65 42 44
H19K3 95 63 65
H19K30 51 30 32
H20K10 82 51 53
H20K39 40 22 23
H20K51 27 12 13
H20K6 90 57 59
H23 99 62 65
H23K1 98 60 63
H23K58 21 7 8
H24K15 72 39 41
H26K3 95 54 57
H27K6 89 48 51
H30K 100 54 57
H30 98 54 57
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HIGHLIGHT COLOR PRINTERS

XEROX1 RED Palette: printer/PC values
Color Name R G B

H30K1 80 39 42
H30K10 59 25 27
H30K23 26 7 8
H32K19 65 29 31
H32K28 50 19 21
H32K3 96 47 50
H33K40 39 13 14
H35K15 73 30 33
H35K43 34 9 10
H38 100 45 48
H38K1 99 42 46
H38K30 46 14 16
H39K17 67 25 27
H39K21 61 21 23
H4 98 89 90
H40K5 91 37 40
H41K9 84 31 34
H43K3 96 37 40
H44K30 47 12 13
H45 100 36 40
H46K12 78 25 28
H46K22 58 15 16
H46K4 91 33 36
H48K15 71 20 22
H48K24 54 11 13
H48K8 84 26 28
H49K1 99 33 36
H4K1 96 87 88
H4K13 74 65 67
H4K18 65 58 59
H4K25 61 54 55
H4K3 93 83 84
H4K33 47 41 42
H4K42 37 32 33
H4K52 27 23 24
H4K6 88 79 80
H4K9 76 70 71
H52K12 75 19 21
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HIGHLIGHT COLOR PRINTERS

XEROX1 RED Palette: printer/PC values
Color Name R G B

H52K3 96 27 30
H53K15 71 14 17
H54K1 98 28 31
H54K4 92 24 27
H56K19 62 11 13
H58 99 25 29
H59K?2 96 22 25
H5K62 19 16 17
H62K7 86 16 18
H64K11 76 12 15
H68K4 91 15 17
H69 98 19 21
HB69K1 97 16 19
HB69K11 76 8 10
HB9K?2 94 15 17
HBK79 8 5 6
H70K6 83 10 12
H73 97 14 17
H76K3 91 9 11
H77K1 96 10 12
H77K5 85
H7K73 11 9
H8 99 81 83
H80K?2 91 7 9
H82 95 10 12
H82K1 94 7 9
H82K3 90 6 8
H86K?2 83 4
H89K1 93 4
H8K1 97 82 83
H8K13 74 60 62
H8K18 68 54 56
H8K3 93 77 79
H8K6 88 71 74
H8K9 77 65 66
H90 94 4 6
HOK25 56 45 46
HOK32 49 38 39
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HIGHLIGHT COLOR PRINTERS

XEROX1 RED Palette: printer/PC values
Color Name R G B
HOK42 36 27 29
HOK51 28 21 22
K1 98 98 98
K100 0 0 0
K13 74 74 74
K18 64 64 64
K25 57 57 57
K3 93 93 93
K33 44 44 44
K42 35 35 35
K52 25 25 25
K6 88 88 88
K64 17 17 17
K73 10 10 10
K86 5 5 5
K9 82 82 82
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HIGHLIGHT COLOR PRINTERS

XEROX1 GREEN Palette: printer/PC
values

Color Name R G B
HOKO 100 100 100
H100 0 52 21
H12 78 94 86
H12K1 76 92 84
H12K3 71 88 79
H12K61 18 23 20
H13K6 68 83 75
H13K73 12 16 14
H16 73 92 82
H16K1 71 90 81
H16K15 51 67 59
H16K24 40 54 47
H16K9 60 78 69
H17K19 45 59 52
H19K3 63 86 74
H19K30 35 49 42
H20K30 51 72 61
H20K39 25 36 30
H20K51 18 27 22
H20K6 57 80 68
H23 64 88 76
H23K1 63 87 74
H23K58 13 21 16
H24K15 44 63 53
H26K3 53 81 66
H27K6 49 77 62
H30 55 84 69
H30K1 51 82 66
H30K10 41 68 53
H30K23 28 49 37
H30K52 13 24 18
H32K19 32 54 42
H32K28 22 42 31
H32K3 45 77 59
H33K40 18 33 25
H35K15 33 60 45
H35K43 14 29 21
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HIGHLIGHT COLOR PRINTERS

XEROX1 GREEN Palette: printer/PC
values

Color Name R G B
H38 46 81 62
H38K1 42 79 58
H38K30 19 38 28
H39K17 28 54 40
H39K21 23 47 33
H4 92 98 95
H40K5 38 72 53
H41K9 33 65 47
H43K3 32 73 50
H44K30 14 36 24
H45 39 78 56
H46K12 28 61 42
H46K22 17 44 28
H46K4 30 69 47
H48K15 23 54 36
H48K24 16 41 27
H48KS8 25 63 42
H49K1 30 73 49
H4K1 89 96 93
H4K13 70 75 73
H4K18 61 65 63
H4K25 55 60 58
H4K3 86 92 89
H4K33 44 48 47
H4K42 34 37 36
H4K52 28 31 30
H4K6 81 87 84
H4K9 77 83 80
H52K12 21 56 36
H52K3 25 69 44
H53K15 16 49 31
H54K1 26 71 46
H54K4 23 66 42
H56K19 13 45 27
H58 26 71 46
H59K2 20 66 40
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HIGHLIGHT COLOR PRINTERS

XEROX1 GREEN Palette: printer/PC
values

Color Name R G B
H5K62 21 23 22
H62K7 16 58 34
HB64K11 15 53 31
H68K4 15 61 35
H69 18 66 39
HBE9K1 15 64 36
HBE9K11 10 50 27
HBE9K2 14 62 35
HB6K79 12 14 13
H70K6 12 56 31
H73 13 62 34
H76K3 9 57 29
H77K1 10 61 32
H77K5 9 54 28
H7K73 15 17 16
H8 86 96 92
HB80K2 8 56 28
H82 9 60 30
H82K1 7 58 29
H82K3 6 55 26
H86K2 5 55 25
HB89K1 4 55 25
H8K1 82 94 88
H8K13 64 72 69
H8K18 58 67 63
H8K3 78 91 84
H8K6 74 86 80
H8K9 71 81 76
H90 3 56 25
HI9K25 47 56 52
HIK32 41 48 45
HIK42 31 36 33
HIK51 25 31 28
K1 98 98 98
K100 0 0 0
K13 74 74 74
K18 64 64 64

HLC-28
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HIGHLIGHT COLOR PRINTERS

XEROX1 GREEN Palette: printer/PC
values

Color Name R G B
K25 57 57 57
K3 93 93 93
K33 44 44 44
K42 35 35 35
K52 25 25 25
K6 88 88 88
K64 17 17 17
K73 10 10 10
K86 5 5 5
K9 82 82 82
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HIGHLIGHT COLOR PRINTERS

XEROX1 BLUE Palette: printer/PC values
Color Name R G B
HOKO 100 | 100 100
H100 0 16 54
H12 77 86 96
H12K1 74 84 94
H12K3 67 77 90
H12K61 15 18 21
H13K6 64 74 85
H13K73 10 12 14
H16 71 82 95
H16K1 68 79 93
H16K15 48 56 67
H16K24 37 45 55
H16K9 57 67 80
H17K19 42 50 61
H19K3 57 70 87
H19K30 32 39 48
H20K10 47 59 74
H20K39 23 29 36
H20K51 15 20 26
H20K6 54 67 82
H23 63 76 92
H23K1 60 74 90
H23K58 10 14 20
H24K15 39 50 65
H26K3 49 64 84
H27K6 44 59 78
H30 55 70 89
H30K1 51 66 87
H30K10 37 51 70
H30K23 25 36 52
H30K52 10 15 23
H32K19 29 41 57
H32K28 20 30 44
H32K3 42 59 81
H33K40 14 23 33
H35K15 29 42 60
H35K43 11 18 28
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HIGHLIGHT COLOR PRINTERS

XEROX1 BLUE Palette: printer/PC values
Color Name R G B
H38 43 61 85
H38K1 37 56 82
H38K30 15 24 38
H39K17 25 38 56
H39K21 20 33 50
H4 91 95 99
H40K5 32 49 74
H41K9 26 42 65
H43K3 27 46 74
H44K30 11 21 36
H45 36 56 83
H46K12 25 40 63
H46K22 14 27 46
H46K4 25 44 72
H48K15 18 33 56
H48K24 11 23 41
H48K8 19 37 64
H49K1 27 48 78
H4K1 89 93 98
H4K13 67 71 74
H4K18 60 64 67
H4K25 55 58 61
H4K3 83 88 93
H4K33 45 48 51
H4K42 33 35 38
H4K52 25 27 29
H4K6 79 84 89
H4K9 77 80 82
H52K12 17 33 58
H52K3 21 41 73
H53K15 13 29 53
H54K1 24 44 75
H54K4 20 39 68
H56K19 10 24 46
H58 23 44 76
H59K2 17 37 69
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HIGHLIGHT COLOR PRINTERS

XEROX1 BLUE Palette: printer/PC values
Color Name R G B
H5K62 18 20 22
H62K7 12 30 60
HB4K11 11 28 56
H68K4 12 31 63
H69 17 38 72
H69K1 12 33 68
HB9K11 7 24 52
HB9K?2 10 29 63
H6K79 11 11 12
H70K6 9 26 57
H73 13 33 68
H76K3 6 24 58
H77K1 9 29 65
H77K5 6 23 55
H7K73 13 14 16
H8 84 91 98
H80K2 5 23 58
H82 8 28 65
H82K1 4 23 59
H82K3 4 21 56
H86K2 3 21 56
H89K1 3 21 57
H8K1 83 89 96
H8K13 62 67 74
H8K18 54 60 66
H8K3 75 83 91
H8K6 71 79 87
H8K9 68 75 83
H90 3 22 59
HOK25 48 53 59
HOK32 40 44 50
HOK42 31 34 39
HOK51 22 25 28
K1 98 98 98
K100 0 0 0
K13 74 74 74
K18 64 64 64
K25 57 57 57
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HIGHLIGHT COLOR PRINTERS

XEROX1 BLUE Palette: printer/PC values
Color Name R G B
K3 93 93 93
K33 44 44 44
K42 35 35 35
K52 25 25 25
K6 88 88 88
K64 17 17 17
K73 10 10 10
K86 5 5 5
K9 82 82 82
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4135 printers

This chapter describes the process for printing large
paper sizes on Xerox 4135 Laser Printing System
printers.

Xerox 4135 printers support printing on paper sizes 8
x 10 inches to 11 x 17 inches, including A4 (8.27 x
11.69 inches), and A3 (11.69 x 16.54 inches) paper.
You can specify custom paper sizes in the Page Prop-
erties dialog box described in the "ElixiForm defaults"
chapter.

If any of your form dimensions are over 14 inches, see
the "Large paper sizes" section for more information.

Large paper sizes

Creating a form

The 4135 printer requires special handling of re-
sources when printing a form on a page where either
the height or width is over 14 inches, for example 11"
X 17" or A3.

The following sections describe how to create and
print a form using large paper sizes.

Create your form in ElixiForm exactly as you want it to
be printed. For example, to create a landscape 11" x
17" form, select the [11 x 17] and [Landscape] options
in the Page Properties dialog box and use landscape
fonts and graphics on your form.

Resource orientation

When you print a large sized form on a 4135 printer,
the printer requires portrait versions of your fonts and
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4135 PRINTERS

graphics to print a landscape form, and landscape
versions of your fonts and graphics to print a portrait
form.

You can create these different versions in one of two

ways, depending on the naming convention you use
for your resources.

Resources using the Xerox naming convention

The Xerox naming convention is where the suffix indi-
cates the orientation of the font or graphic: P repre-
sents portrait (for example HE12BP), L represents
landscape (for example HEO7NL), | represents in-
verse portrait (for example HE12NI) and J represents
inverse landscape (for example HE12BJ).

If you are using the Xerox naming convention, you
must make sure that all four orientations of each font
and graphic used in your document exist on your
Xerox printer. Use the ElixiSys Desktop to create all
orientations if they do not already exist. See your Elix-
iSys Desktop User Guide for information about creat-
ing these versions of each font or graphic.

Note that you do not have to edit the P2LFONTS.LST

or the INVFONTS.LST mapping file if your fonts and
graphics conform to the Xerox naming convention.

Resources using non-Xerox nhaming conventions

If you are not using the Xerox naming convention (as
described in the previous section), you must do the
following:

1. Make sure that all fonts and graphics are
converted to Xerox format before converting
Elixir forms to Xerox output format.

See your ElixiSys Desktop User Guide for infor-
mation about converting resources.
files written to the drive:\ELIXIR directory

during installation.

See the following "Mapping files" section for more
information.

4135-2
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4135 PRINTERS

Mapping files

There are two mapping files written to the
drive:\ELIXIR directory during installation:
P2LFONTS.LST for mapping portrait fonts and graph-
ics to landscape fonts and graphics, and
INVFONTS.LST for mapping portrait or landscape
fonts and graphics to inverse portrait or inverse land-
scape fonts and graphics.

Each line in the mapping file must contain the stem
name of a font or graphic used in your form, followed
by a space and the stem name of the font or graphic it
is mapped to. All entries must be in upper-case
letters.

[}
If you are printing a landscape or portrait form,
edit the P2LFONTS.LST file so that each portrait
font or graphic is mapped to a landscape version
of that font or graphic.

For example:

GRAPHX GRAPHY
FONTA FONTB

where GRAPHX is a portrait graphic and GRA-
PHY is a landscape version of that graphic, and
FONTA is a portrait font and FONTB is a land-
scape version of that font.

Note that portrait fonts and graphics are always in
the left column and landscape fonts and graphics
are always in the right column.
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4135 PRINTERS

e |[f you are printing an inverse form, edit the

INVFONTS.LST file so that each landscape font
or graphic is mapped to an inverse landscape
version of that font or graphic, and each portrait
font or graphic is mapped to an inverse portrait
version of that font or graphic.

For example:

GRAPHS GRAPHU
FONTZZ FONTDD

where GRAPHS is a portrait graphic and GRA-
PHU is an inverse portrait version of that graphic,
and FONTZZ is a landscape font and FONTDD is
an inverse landscape version of that font.

Note that the upright font or graphic is always in
the left column and the inverse font or graphic is
always in the right column.

Note that you only have to edit the P2LFONTS.LST or
the INVFONTS.LST mapping file if your fonts and
graphics do not conform to the Xerox naming
convention.

4135-4
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4235 printers

This chapter describes the ElixiForm options that ap-
ply to ElixiForm for Xerox Distributed Printers and that
affect printing forms on Xerox Distributed printers with
gray-scale capability (such as the Xerox 4235 Laser
Printing System printer).

Creating forms with gray

ElixiForm allows you to use gray shades and gray pat-
terns in your form. The difference between a gray
pattern and a gray shade is that a gray pattern con-
sists of an ordered set of black and white pixels which
appear as gray when printed. A gray shade is a com-
bination of RGB values that display as gray and print
as one of the gray shades on a 4235 printer.

When designing forms for printing on a Xerox 4235
printer, set the [Color Mode] option in the Page Prop-
erties dialog box to [XDP Grays]. This allows you to
select the shades and patterns from the PC palette
that are capable of printing on an XDP printer. See
the "ElixiForm defaults" chapter for more information
about the Page Properties dialog box.

PC palettes

A PC palette is an ASCIl file stored in the
drive\ELIXIR\ADESKTOP\SYSTEM\PALETTES direc-
tory that contains a list of color names. When you ap-
ply a palette to a form, you can use the colors in that
palette for lines, text, box borders and box fills.

To print a form on a gray-scale printer, the palette file
must contain black, gray patterns and gray shades.
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4235 PRINTERS

Black

The first line of the PC palette is always BLACK.
Black is used for lines, text, and box borders and fills.

Gray patterns

The gray pattern names are LIGHT _GRAY, MEDI-
UM_GRAY, and DARK_GRAY and always appear on
the second, third and fourth line of a PC palette file.
Gray patterns are used for box fills.

Gray shades

A PC palette contains additional gray shades
(GRAY_1, GRAY_2 etc.) which can be used for lines,
text, and box borders and fills. The numbers following
the color names are RGB (Red, Green, and Blue) per-
centage values. The RGB values determine how the
screen versions of the colors display, and are chosen
to approximate the printed colors.

The following example shows the GRAY.PLF palette
included with ElixiForm.

BLACK 000000

LIGHT_GRAY 000000

MEDIUM_GRAY 000000

DARK_GRAY 000000

GRAY_193333 93333 93333 93333 93333 93333
GRAY_2 86666 86666 86666 86666 86666 86666
GRAY_3 80000 80000 80000 80000 80000 80000
GRAY_4 73333 73333 73333 73333 73333 73333
GRAY_5 66666 66666 66666 66666 66666 66666
GRAY_6 60000 60000 60000 60000 60000 60000
GRAY_753333 53333 53333 53333 53333 53333
GRAY_8 46666 46666 46666 46666 46666 46666
GRAY_9 40000 40000 40000 40000 40000 40000
GRAY_10 33333 33333 33333 33333 33333 33333
GRAY_11 26666 26666 26666 26666 26666 26666
GRAY_12 20000 20000 20000 20000 20000 20000
GRAY_13 13333 13333 13333 13333 13333 13333
GRAY_14 6666 6666 6666 6666 6666 6666
GRAY_15 000000

4235-2
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Applying a PC palette to a form

To apply a PC palette to a form:

1. Pull down the Options menu and select [Page
Properties].

The Page Properties dialog box displays.

2. Select [XDP Grays] as the selected color
mode.

See the "ElixiForm defaults" chapter for more in-
formation about the Page Properties dialog box.

3. Click on [OK].
]
Jﬂ 4. Select the Line, Box, Text or Image tool to
display the Toolbox and select the [Color]
option.

The local (color) palette displays.

Figure 4235-1. Local palette
5. Click on [Palette].

The remote palette displays the shades in the
gray palette.

Figure 4235-2. Remote palette
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6. Click on the gray shades you want to use in
your form. You can also drag and drop the
gray shades from the remote palette to the
local palette.

The gray shades are copied to the local palette
for use in your form.

If you want to load the whole palette, click on
[Load] or [Merge] in the local palette dialog box.

The local palette is saved with the form when you se-
lect [Save] to save the form.

To remove a shade from the local palette:

1. Place the cursor on the shade you want to
remove.

The name of the shade displays in the palette
message area.

2. Press the <Del> key.

Note that you cannot delete a shade that is in use
in your form.

3. The shade is removed from the local palette.

Use <Ctrl> + <Del> to delete all shades from the
palette.

See the following section for information on applying
gray-scales to form elements.

Applying gray to form elements

| ElixiForm allows you to use the left mouse button to

ﬁ apply gray shades to lines, text, box borders and use
the right mouse button to fill boxes with gray shades
or gray patterns. Note that when you apply color to
text, the whole text block is colored.

r
Jﬂ The [Color] and [Fill] options in the Toolbox display the
selected color.
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Select the color for an element before drawing it on
the form. If you want to apply a different color to the
element at a later time, select the element before se-
lecting a new color.

Lines, text and box borders

To apply a gray shade to a line, text or box border:

1. Select the Line, Text or Box tool in the
Toolbox.

If you want to change the color of an existing line,
text block, or box border, click on the selected
element with the right mouse button.

The Toolbox for that element displays.

r

Jﬂ 2. Select the [Color] option.
The local palette displays. If you want to add
more colors from the remote palette, see the "Ap-
plying a PC palette" section in this chapter.

3. Select a gray shade for the element.

4. Place the cursor in the work area and draw a
line or box, or enter text.

If you want to create a box without a fill, select the
[Pattern] option and click on the [Hollow] pattern. See
the following section if you want to create a box with a
fill.

Box fills
You can fill a box using a gray shade or a gray
pattern.
To fill a box with a gray shade:
|

| 1. Select the Box tool in the Toolbox.

If you want to change the fill color of an existing
box, click on the box with the right mouse button.
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&

The Box toolbox displays.
Select the [Color] option.

The local palette displays. If you want to add
more colors from the remote palette, see the "Ap-
plying a PC palette" section in this chapter.

Select a color for the box using the right
mouse button.

Place the cursor in the work area and draw a
box.

If an existing box is selected, the fill color of that
box changes when you click on a new color with
the right mouse button.

To fill a box with a pattern:

1.

Select the Box option in the toolbox.

If you want to change the fill color of an existing
box, select the box then click on the box with the
right mouse button.

Select the [Pattern] option.

The pattern palette displays.

Dark Gray

Figure 4235-3. Pattern palette

Select a pattern for the box using the left
mouse button.

Place the cursor in the work area and draw
box.

If an existing box is selected, the fill pattern of that
box changes when you click on a new pattern.

If you want a pattern filled box without a border, set
the border width to [0]

4235-6
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Creating boxes with different fill and border colors

You can create a box with a fill of one gray shade, and
a border of another gray shade as follows:

1. Create a filled box with a border of the same
fill color.

2. With [Snap] deselected, create a slightly
bigger unfilled box around the filled box.

3. Set the border color of the unfilled box to a
color different from the first box.

The two boxes display together as a box with a full-
color fill (the first box) and a different full-color border
color (the border of the second box).

Replacing gray shades

ElixiForm allows you to replace gray shades in the lo-
cal palette by dragging and dropping gray shades
from the local or remote palette windows. If the gray
shade is in use on the form, all elements using that
gray shade are replaced with the replacement gray
shade.

To replace a gray shade in the local palette:
ﬂﬂ 1. Select the [Color] option.
The local palette displays.
2. If you are replacing a gray shade with a gray
shade from the remote palette, click on

[Palette].

The remote palette displays.
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3. Select the gray shade you want to use from
the local or remote palette, and drag and drop
it on top of the gray shade you want to
replace.

Note that you cannot replace the predefined black
color.

4. |If the gray shade is currently in use on your
form, you are prompted to confirm that you
want to replace all occurrences of that gray
shade with the new gray shade.

Note that if you use a gray shade in your local palette
to replace another gray shade in your local palette, the
total number of gray shades in the palette is reduced.

If you drag a gray shade from the remote palette to
the local palette and do not drop it on another gray
shade, the gray shade from the remote palette is sim-
ply added to your local palette.

Printer considerations

Note the following considerations for printing forms on
a 4235 printer.

Large paper sizes

Xerox 4235 printers support printing on 85 x 11
inches, 8.5 x 14 inches, 11 x 17 inches, A4 (8.27 x
11.69 inches), and A3 (11.69 x 16.54 inches) paper.

You can specify custom paper sizes in the Page Prop-
erties dialog box described in the "ElixiForm defaults"
chapter.

If any of your form dimensions are over 14 inches, see
the following sections before printing forms.

4235-8
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Creating forms for large paper sizes

ElixiForm 11" x 17" and A3 paper size options auto-
matically compensate for the printer rotation. There-
fore, when creating a 11" x 17" or A3 form, select
[Portrait] orientation when creating a portrait form and
[Landscape] orientation when creating a landscape
form.

Portrait/landscape font mapping table

To print large paper size forms requires that you re-
map your landscape and portrait fonts using a font
mapping table. This font mapping table is stored in
drive\AELIXIR\P2LFONTS.LST.

The default P2LFONTS.LST file is written to the
drive\ELIXIR directory during installation and contains
a list of the fonts used on an Elixir-format form.

Each line contains the stem name of a portrait or in-
verse portrait font, followed by a space, and the stem
name of the same font in landscape, or inverse land-
scape orientation, both in upper case characters.

For example:

HEQ7NP HEO7NL
HEO8OP HEO8OL
HE12NI HE12NJ
HE12BI HE12BJ

The suffix indicates the orientation of the font:

® P represents portrait.

® | represents landscape.

® | represents inverse portrait.

® Jrepresents inverse landscape.

Edit this file so that each portrait font on your form is
mapped to a landscape version of that font, and each
inverse portrait font is mapped to an inverse land-
scape version of this font.
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Inverse font mapping table

Graphics

If your print job includes printing in tumble mode, you
must edit the INVFONTS.LST file to include each font
on your form.

The INVFONTS.LST is an ASCII file that you create in
the drive\ELIXIR directory.

Each line consists of the stem name of the landscape
or portrait font, a space, and the stem name of the
same font in inverse landscape or inverse portrait
orientation.

For example:

HEO7NL HEOQ7NJ
HEO8OL HE080J
HE12NP HE12NI
HE12BP HE12BI

The suffix indicates the orientation of the font:

P represents portrait.

L represents landscape.

| represents inverse portrait.

J represents inverse landscape.

Gray shades do not apply to graphics. Graphics print
in black-and-white, regardless of the graphic fore-
ground or background colors.

Font conversions

Before sending your print job to a Xerox printer, use
the Desktop Converter described in the ElixiSys Desk-
top User Guide to convert the Elixir-format fonts used
in your forms to Xerox 2700 or 3700 fonts (the Xerox
4235 uses both types). Using these fonts enables the
use of demonstration and line draw fonts in your
forms.

® Use 2700 fonts when downloading your form.

4235-10
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e Use 3700 fonts for direct load via the printer
floppy drive.

Printer setup

Make sure the printer is set up for 8-bit ASCII and for
CRILF line endings. See the Xerox 4235 Laser Print-
ing System User Guide for more information.

Printing from the ElixiSys Desktop

You can use the Desktop Printers icon to print to the
Xerox 4235 printer. You can also print a form as a job
using page and job print tickets to specify printing in-
formation. See the ElixiSys Desktop User Guide for
more information.
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This chapter describes features included with Elixi-
Form to enable full-color form composition for printing
on the Xerox 4700 Color Document Printer.

Creating a full-color form

Constructing a full-color form is the same as con-
structing any other form except that you can use a full-
color palette to apply colors to form elements.

When designing color forms for printing on a 4700
printer, set the [Color Mode] option in the Page Prop-
erties dialog box to [Full Color]. This allows you to se-
lect the shades and patterns from a PC palette that
are capable of printing on a Xerox 4700 Color Docu-
ment printer. See the "ElixiForm defaults" chapter for
more information.

PC palettes

Color palettes

This section describes PC palettes and how to create
and print color forms.

To create an Elixir form that you can convert and print
on a 4700 printer, a PC palette file must be con-
structed according to the following rules:

® The PC palette file extension is .PLF for full-color
palettes, or .PAL for highlight color palettes.
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The PC palette is in
driveAELIXIR\DESKTOP\SYSTEM\PALETTES),
where drive: is the hard disk drive on which Elixi-
Form is installed. The default palette for full-color
users is COLOR.PLF. You can also use
GRAY.PLF for printing grays.

The PC palette is an ASCII file that on each line
includes a color name, the corresponding screen
RGB percentage values, followed by the corre-
sponding printer RGB values. Lines in the file are
separated by carriage return/line feeds.

The PC palette starts with the lines BLACK,
LIGHT_GRAY, MEDIUM_GRAY, DARK_GRAY,
and can contain up to 27 additional colors (31 to-
tal). See the "Example: COLOR palette file" sec-
tion in this chapter for more information.

The PC palette color has no corresponding COLOR
printer palette.

You can construct a PC palette by using an ASCII edi-
tor and following the above rules.

Example: COLOR palette file

One of the PC palettes included with the full-color ver-
sion of ElixiForm is COLOR.PLF (the same as
SAMPLE.PLF), an ASCII file containing the following
lines:

BLACK
LIGHT_GRAY

DARK_GRAY
RED

GREEN
BLUE

CYAN
YELLOW
MAGENTA

000000 000000 000000 000000 000000 000000
075000 075000 075000 075000 075000 075000
MEDIUM_GRAY 050000 050000 050000 050000 050000 050000
025000 025000 025000 025000 025000 025000
090000 000000 000000 079820 -001900 000000
000000 050000 015000 -007800 025210 004100
020000 000000 045000 004026 -002700 033810
000000 054000 070000 -014580 030900 079850
100000 090000 000000 105569 088650 -008300
100000 000000 070000 083266 -003900 041420

4700-2
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The first three numbers following a color name are the
screen RGB (Red Green, and Blue) percentage val-
ues for the color. These numbers determine how the
color displays on a color VGA monitor.

The next three numbers are the printer RGB percent-
age values. These numbers determine how the color
is printed on a 4700 printer. These numbers are cho-
sen to approximate the screen colors.

For example, the color RED is followed by 090000
000000 000000 079820 -001900 000000. This means
that the screen and printer version of RED contains
the following RGB values:

® The screen red component is the 90% of the
brightest possible red on the screen.

® The screen green component is 0% of the bright-
est possible green on the screen.

® The screen blue component is 0% of the brightest
possible blue on the screen.

® The printed red component is 100% of the bright-
est possible red on the paper.

® The printed green component is 0% of the bright-
est possible green on the paper.

®  The printed blue component is 0% of the brightest
possible blue on the paper.

The printer RGB values in COLOR.PLF have been
found to most closely match the corresponding screen
RGB values.

If printer RGB values are not specified for a color, the
screen RGB values are used for printing.

If neither screen nor printer RGB values are specified
for a color, internal default values are applied. See
your ElixiSys Desktop User Guide for information
about the Palette Editor and internal default values

You can assign any color in the current PC palette to
text, lines, box borders, and box fills.
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Applying a PC palette to a form

To apply a PC palette to a form:

1. Pull down the Options menu and select [Page
Properties].

The Page Properties dialog box displays.

2. Make sure [Full Color] is the selected color
mode and click on [OK].

r
Jﬂ 3. Select the Line, Box or Text tool in the
Toolbox and select the [Color] option.

The local palette displays.

o

Figure 4700-1. Local palette
4. Click on [Palette].

The remote palette displays.

Figure 4700-2. Remote palette

5. Click on the down arrow and select a palette.
The colors for that palette display.
6. Click on the colors you want to use in your

form. You can also drag and drop the colors
from the remote palette to the local palette.
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The colors are copied to the local palette for use
in your form.

7. If you want to use an existing palette, select
[Load] to replace the current palette or
[Merge] to merge with the current palette, and
select a palette from the Load or Merge Color
Palette dialog box.

The colors display in the local palette.

The local palette is saved with your form when you se-
lect [Save].

Saving a local palette

If you want to save the local palette for use in another
form, click on [Save] in the local palette. The Save
Color Palette dialog box displays. Enter a name for
the palette and click on [OK].

Loading an existing palette

To use an existing palette, select [Load] to replace the
current palette or select [Merge] to merge the previ-
ously saved palette with the current palette and then
select a palette from the Load or Merge Color Palette
dialog box.

Removing a color from a local palette

To remove a color from the local palette:

1. Place the cursor on the color you want to
remove.

The name of the shade displays in the palette
message area.

2. Press the <Del> key.

Note that you cannot delete a shade that is in use
in your form.

3. The color is removed from the local palette.

Use <Ctrl>+<Del> to delete all colors from the palette.
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Applying colors to form elements

a8

ElixiForm allows you to use the left mouse button to
apply colors to lines, text blocks, images and box bor-
ders, and use the right mouse button to fill boxes with
colors or gray patterns. Note that when applying color
to text, the whole text block is colored.

The [Color] and [Fill] options display the selected
color.

Select the color for an element before drawing it on
the form. If you want to apply a different color to the
element at a later time, select the element before se-
lecting the new color.

Lines, text, images and box borders

To apply a color to a line, text or box border:

1. Select the Line, Text or Box tool in the
Toolbox.

If you want to change the color of an existing line,
text block, or box border, select the element with
the right mouse button.
The Toolbox for that element displays.

2. Select the [Color] option.
The local (color) palette displays. If you want to
add more colors from the remote palette, see the
"Applying a PC palette" section in this chapter.

3. Select a color for the element.
If an existing element is selected, the color ap-
plies to the selected element when you click on
the new color with the right mouse button.

4. Place the cursor in the work area and draw a
line or box, or enter text.

If you want to create a box without a fill, select the
[Pattern] option and select the [Hollow] pattern. See

4700-6
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the following section if you want to create a box with a
fill.

Box fills

You can fill a box using a color or using a gray pattern.
To fill a box with a color:
g 1. Select the Box tool in the Toolbox.

If you want to change the fill color of an existing
box, click on the box with the right mouse button.

The Box toolbox displays

jﬂﬁ 2. Select the [Color] option.

The local (color) palette displays. If you want to
add more colors from the remote palette, see the
"Applying a PC palette" section in this chapter.

3. Select a color for the box using the right
mouse button.

If an existing box is selected, the fill color of that
box changes when you click on a new color with
the right mouse button.

4. Place the cursor in the work area and draw a
box.

To fill a box with a pattern:
g 1. Select the Box tool in the Toolbox.

If you want to change the fill color of an existing
box, click on the box with the right mouse button.

2. Select the [Pattern] option.
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The pattern palette displays.

Dark Gray

Figure 4700-3. Pattern palette

Select a pattern for the box using the left
mouse button.

If an existing box is selected, the fill pattern of that
box changes when you click on a new pattern.

Place the cursor in the work area and draw
box.

If you want a pattern filled box without a border, set
the border width to [O].

Creating boxes with different fill and border colors

You can create a box with a full-color fill of one color,
and a full-color border of another color as follows:

1.

Create a filled box with a border of the same
fill color.

With [Snap] deselected, create a slightly
bigger, hollow box around the filled box.

Set the border color of the unfilled box to a
color different from the first box.

The two boxes display together as a box with a full-
color fill (the first box) and a different full-color border
color (the border of the second box).

4700-8

ELIXIFORM USER GUIDE



4700 PRINTERS

Converting full-color graphics

If the graphic on your form is full-color, you cannot
change the foreground and background colors using
ElixiForm. Changing the color options to modify full-
color graphics may produce unpredictable results.

The DAYNIT.LP3 graphics file is a full-color file in-
cluded at installation as a sample file.

Replacing colors

ElixiForm allows you to replace colors in the local pal-
ette by dragging and dropping colors from the local or
remote color palette windows. If the color is in use on
the form, all elements using that color are replaced
with the replacement color.

To replace a color in the local palette:
1. Select the [Color] option.
The local palette displays.

2. If you are replacing a color with a color from
the remote palette, click on [Palette].

The remote color palette displays.

3. Select the color you want to use from the
local or remote palette, and drag and drop it
on top of the color you want to replace.

Note that you cannot replace the predefined black
color.

4. |If the color is currently in use on your form,
you are prompted to confirm that you want to
replace all occurrences of that color with the
new color.

Note that if you use a color in your local palette to re-
place another color in your local palette, the total num-
ber of colors in the palette is reduced.
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If you drag a color from the remote palette to the local
palette and do not drop it on another color, the color
from the remote palette is simply added to your local
palette.

Printer considerations

Note the following considerations for printing forms on
a 4700 printer.

Paper sizes
The 4700 printer does not print to the edge of a physi-
cal page. The width of the non-printing area for the
top, bottom and sides of a page depends upon the
page size and orientation. The following table shows
the sizes of the non-printing area for supported paper
sizes in millimeters.
Paper Orient- Non- Non- Non- Non-
Size ation printing printing | printing | printing
Bottom Top Right Left
A4 Portrait 2.0 2.0 6.5 10.0
A4 Land. 6.5 10.0 2.0 2.0
A3 Portrait 6.5 10.0 2.0 2.0
A3 Land. 2.0 2.0 6.5 10.0
85x 11| Portrait 2.0 2.0 6.5 10.0
85x11| Land. 6.5 10.0 2.0 2.0
8.5x 14 | Portrait 6.5 10.0 2.0 2.0
84x14| Land. 2.0 2.0 6.5 10.0
11x17 | Portrait 6.5 10.0 2.0 2.0
11x17 | Land. 2.0 2.0 6.5 10.0
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Xerox 4700 printers support printing on 85 x 11
inches, 8.5 x 14 inches, 11 x 17 inches, A4 (8.27 x
11.69 inches), and A3 (11.69 x 16.54 inches) paper.

You can specify paper sizes from the Page Properties
dialog box described in the "ElixiForm defaults"
chapter.

If any of your form dimensions are over 14 inches, you
must edit the P2LFONTS.LST file and set the page
shift to avoid printing in unsupported margins. See the
following two sections.

Portrait/landscape font mapping table

If your job includes oversize (over 14 inches in either
direction) paper, use an ASCIl editor to edit the
P2LFONTS.LST file in the drive:\ELIXIR directory.

The default P2LFONTS.LST file is written to the
drive\ELIXIR directory during installation and contains
a list of fonts used on an Elixir-format form.

Each line of the file starts with the portrait font stem
name, followed by a space, and followed by the stem
name of the same font in landscape orientation, both
in upper case characters.

For example:

HEQ7NP HEO7NL
HEO8OP HEO8OL
HE12NI HE12NJ
HE12BI HE12BJ

The suffix indicates the orientation of the font:

P represents portrait.

L represents landscape.

| represents inverse portrait.

J represents inverse landscape.

Edit this file so that each portrait font on your form is
mapped to a landscape version of that font.
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Page shift

You can avoid printing in unsupported margins by
specifying -75 in the [Xshift] option in the Printer dialog
box. See the "ElixiForm basics" chapter for more
information.

Font conversions

Before sending your print job to a Xerox printer, use
the Desktop Converter, described in the ElixiSys
Desktop User Guide, to convert the Elixir-format fonts
in your forms to Xerox 2700 or 3700 fonts. Using 2700
or 3700 fonts enables the use of demonstration and
line-draw fonts in your forms.

® Use 2700 fonts for downloading your form

® Use 3700 fonts for direct load via the printer
floppy drive.

Input tray number remapping

Note that the 4700 printer remaps input tray number
information received from page print tickets, job print
tickets, and the ELX2XES and FORMPRN stand-
alone utilities as follows:

Input tray number 4700 printer tray
#1 High capacity feeder tray #3
#2 Internal tray #1
#3 Internal tray #2
#4 Internal tray #2

4700-12
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Printer setup

Make sure that the printer is set up for 8-bit ASCII and
for CR/LF line endings. See the Xerox 4700 Color
Document Printer Operation Guide for more
information.

Printing from the ElixiSys Desktop

To print to the Xerox 4700 full-color printer you can
use the Desktop Printer icon. You can also print a
form as a job using page and job print tickets to spec-
ify printing information. See the ElixiSys Desktop User
Guide for information.

Proof printing HighLight Color forms

You can print highlight color forms on the 4700 full-
color printer using the 4850 HighLight Color replicant
palettes for the 4700. The replicant palettes are
RED.PLF, BLUE.PLF and GREEN.PLF and corre-
spond to the RED.PAL GREEN.PAL and BLUE.PAL
files for the 4850.

These palettes allow you to use the 4700 as a proof
printer for the 4850. You may create or modify addi-
tional palettes using the Palette Editor described in the
"Palette Editor" appendix.

Note that although the replicant palettes provide a
close match on the 4700 printer to the actual 4850
inks, forms that are proof printed on the 4700 may not
look identical to the forms printed on the 4850. Print-
ing the color sample palettes will provide samples of
how the 4850 inks print on the 4700. For more infor-
mation on printing the 4700 color palettes, refer to the
Xerox 4700 color document printer operator guide.
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Displaying color forms

If you have a supported monochrome monitor, color
elements display in black. A full-color form has an as-
terisk * next to the form name when loaded in Elixi-
Form on a monochrome monitor.

Displaying selected elements only

To alternately display all elements, only black ele-
ments, or only color elements, press <Alt> + <F9>,
This fast key is a three-way toggle that allows you to
display elements selectively.
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Keyboard shortcuts

This appendix lists keyboard shortcuts (fast keys) in

ElixiForm.
Command
Copy
Crosshair on/off
Cut

Delete

Delete all

Exit

Grid on/off

Help

Hide work area
Hide/show data tags
Load form
Lock/free text
New form
Paste

Quick save
Redo

Ruler on/off

Action
<Ctrl> + <C>
<F6>
<Ctrl> + <X>
<Del>

<Ctrl> + <Del>
<Alt> + <F4>
<F4>

<F1>
<Ctrl> + <F4>
<Ctrl> + <T>
<F8>

<F11>

<F9>
<Ctrl> + <V>
<Ctrl> + <S>
<Shift> + <Ctrl> + <Z>

<F3>
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Save form

Save form as
Screen refresh
Select/unselect all
Shift element down
Shift element left
Shift element right
Shift element up
Snap to grid

Sticky lines
Toolbox show/hide

Undo

Text editing keys:
Copy text

Cut text

Delete character left
Delete character right
Delete next word
Delete previous word
Delete to end of line

Delete to end of
text block

Find
Find Next

Find Previous

<Ctrl> + <S>

<F7>

<*> (on the numeric keypad)
<Ctl> + <A>

<Ctrl> + <down arrow>
<Ctrl> + <left arrow>
<Ctrl> + <right arrow>
<Ctrl> + <up arrow>
<F5>

<Ctrl> + <L>

<F10>

<Ctrl> + <Z>

<Ctrl> + <C>
<Ctrl> + <X>
<Backspace>
<Del>

<Ctrl> + <Del>
<Ctrl> + <Bksp>

<Ctrl> + <K>

<Ctrl> + <E>
<Alt> + <F3>
<F3>

<Shift> + <F3>

A-2
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Find Selected (forward) <Ctrl> + <F3>

Find Selected (reverse) <Ctrl> + <Shift> + <F3>

Insert/Overwrite toggle <Ins>

Lock/Free text

Move cursor down
one line

Move cursor left
one character

Move cursor right
one character

Move cursor up
one line

Move cursor left
one word

Move cursor right
one word

Move cursor to
end of line

Move cursor to
start of line

Move cursor to
end of block

Move cursor to
start of block

Paste text

Show/hide data tags

<F11>

<Down arrow>

<Left arrow>

<Right arrow>

<Up arrow>

<Ctrl> + <Left arrow>

<Ctrl> + <Right arrow>

<End>

<Home>

<Ctrl> + <End>

<Ctrl> + <Home>
<Ctrl> + <v>

<Ctrl> + <T>
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Numeric display box keyboard shortcuts

The following fast keys are used for editing numbers
in numeric display boxes (such as the tool width op-
tion). Numbers are entered from right to left, similar to

a pocket calculator.

For all but the first two fast keys, you must first acti-
vate edit mode by clicking in the display box.

Change decimal
value

Change integer value

Define value as
negative

Delete number
(setto 0)

Delete right digit
Edit (toggle)

End integer and start

decimal value
Finish editing
Reset

Reset and
finish editing

Zoom/Pan controls:

Pan left
Pan up
Pan right
Pan down

Zoom in

Click on arrows (where
provided)

<Ctrl> + click on arrows

<Del>
<Bksp>

Left click

<.> (dot)
<Enter>

<Alt> + <Bksp>

<Esc>

<Left arrow>
<Up arrow>
<Right arrow>
<Down arrow>

<+>

A4
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Zoom out <->

Top left of form<Home>

Bottom left of form <End>

Top right of form <Ctl> + <PgUp>
Bottom right of form  <Ctrl> + <PgDn>
Scroll up <PgUp>

Scroll down <PgDn>

Locate; redraw
with new center point ~ <*>

The above fast keys use the keys on the numeric key-
pad with <Num Lock> off.
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Conversion chart

You can convert forms created in ElixiForm to differ-
ent formats using the ElixiSys Desktop. The following
chart shows the supported conversions.

ELIXIR

to

HP
PCL

PS

PDF

to

XGF

2700

to

404

to

4235

4700

to

ELIXIR

HP PCL

PS

PDF

XGF

2,700

4,045

4,235

4,700

4075

FSL

X | X[ XX [ X]|X]|X]|X]X

4075
FRM
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CONVERSION CHART

MET X X X| X
FsL X X| X| X
FRM X X X| X
Color X X[ X| X
FsL

Color X X X| X
FRM

XSOP X X X| X
Images

...Continued on next page
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4075 | 4075 MET | FSL FRM Color Color | XSO | Image

FSL | FRM TO TO TO FSL FRM TO

TO
TO | TO TO TO

ELIXIR X | X X

HP PCL

PS

PDF

XGF

2,700

4,045

4,235 X

4,700

4075 | --- X X X
FSL

4075 --- X X X

FRM

MET _—

FsL X | X | X

FRM X -
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Color

FSL

Color

FRM

XSOP

Image
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Glossary

This glossary contains a list of the basic terminology
this manual uses.

Application: Any program you run on your PC. Elixir
applications are represented by icons on the
ElixiForm/ElixiSys Desktop. If an Elixir application is
not installed on your PC, its icon does not display.

Arrow: An arrow-shaped screen pointer used for se-
lecting objects.

Boxed text: Text on a form that is bound by a column
with a set height and width.

Button (on the screen): An area on the screen that
causes a response when you click on it. For example,
an [OK] button that accepts your entries when you
click on it in a dialog box.

Click, on an item: To momentarily press and release
the left mouse button with the screen pointer on an
item.

Close: To exit from a window, dialog box, application,
or the Desktop.

Close box: A small white box at the left of a window
header and at the left of the menu bar. Clicking a
close box on a window header closes the window.
Clicking a close box on the menu bar exits the
Desktop.

Command button: A button in a dialog box that con-
firms or cancels an action when you click on it. The
[Cancel] button cancels the command. The [OK] but-
ton confirms and executes the command and saves
the information you specified in a dialog box.
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Cursor: An "I"-shaped screen pointer used when en-
tering text in the form work area or in a dialog box.

Desktop: The Elixir Desktop working environment,
consisting of the menu bar, the screen area, and the
icons on the screen.

Dialog box: A rectangular box that displays and re-
qguests information. You enter information in fields in
the dialog box, and normally confirm your entries by
clicking on an [OK] button or by pressing <Enter>.

Directory: A list of hard disk or diskette contents.
Desktop directories are represented by folder icons.
Folder contents can be viewed pictorially, alphabeti-
cally, by icon, by size, or by date.

Dispatcher icon: The icon that stores and invokes a
number of DOS commands.

DOS: Disk Operating System, the collection of pro-
grams that gives control of a PC's resources to the
user.

Double-click: To press the left mouse button twice in
rapid succession, normally to open an icon.

Drag: To click on an item and move the item with the
mouse while holding down the left mouse button.

Drag and drop: Used to copy an object as follows:
click on an item on the screen, hold down the left
mouse button, move the mouse to move the screen
pointer to an icon, and release the mouse button.

Drop: To release the mouse button after dragging an
item to an icon.

Elixir folders: The folders represented by the four
top left icons on the Desktop: the Forms, Fonts,
Graphics, and Documents folders. Each of these fold-
ers contains an Elixir, Input, and Output folder.

Extension: The period and three characters following
a file name. An extension identifies the type of infor-
mation in a file. For example, .ELX indicates an Elixir
format form file.

GLOSSARY-2

ELIXIFORM USER GUIDE



GLOSSARY

Fast Keys: See Keyboard shortcuts.

File filter: The use of DOS wildcard characters to dis-
play only those files with selected name characteris-
tics in a window or dialog box. For example, to display
only files that begin with ABC in a directory of many
files you could enter ABC**. See also, Wildcard
character.

File name: The name of a file. The ElixiForm/ElixiSys
uses DOS file naming conventions. DOS file names
consist of a base (stem) name containing up to eight
characters and an extension of up to three characters.
Xerox centralized printer file names consist of a stem
name of up to six characters and an extension of up
to three characters.

Folder icon: The Desktop icon representing a DOS
directory. Folders allow you to quickly organize infor-
mation on the Desktop.

Format: To prepare a diskette so it can hold informa-
tion. Formatting a diskette erases the information on
the diskette.

Form elements: The individual lines, boxes, and text
that compose a form. You can create, change, move,
copy, delete, import, or load a form element.

Form template: A form loaded as an overlay or visual
guide only for the purpose of designing new form ele-
ments around it. A form template does not become
part of the form when the form is saved, only the new
elements added are saved with the form.

Free text: Text on a form that is not bound by a col-
umn with a set height and width. The width of the form
is the only restriction.

Grayed options: Grayed options are menu options
you cannot choose because they do not apply to your
current selection. Also called dimmed options.

Gray pattern: A pattern used for fills consisting of an
ordered set of black and white pixels which appears
as gray when printed.
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Gray scale color: A gray shade (color) used for box
fills and borders, lines, and text, which is composed of
a combination of RGB (Red, Green, and Blue) values
that display as gray and print as a gray shade (for ex-
ample GRAY_6) on a printer.

Gray shade: See Gray scale color.

Head to head: In duplex printing, when the page top
is printed in the same position on both sides of the

page.

Head to toe: In duplex printing, when the top of one
side of the page is printed in the same position as the
bottom of the other side of the page.

Highlight color: Pure red, green, or blue colors. Also
called hues.

Highlighted: A highlighted option appears darkened
on the screen, and indicates that it is selected.

Hue: Pure red, green, or blue colors. Also called high-
light colors.

Icon: A small, roughly rectangular-shaped symbol on
the Desktop that represents an application, a file, a
folder, or a peripheral device.

Importing files: The process of copying non-Elixir
format files from different storage media (such as a
hard disk, a diskette, or tape) to the appropriate Desk-
top input folder or to the form work area.

Information box: A white square at the right of the
menu bar identified with an "i". Clicking on the infor-
mation box displays information about the open Elixir
Desktop application.

Inverse Landscape: The orientation of fonts, logos,
or images on a page. See the definition for portrait for
a figure describing the orientation of fonts on pages.

Inverse Portrait: The orientation of fonts, logos, or
images on a page. See the definition for portrait for a
figure describing the orientation of fonts on pages.

Kerning: The process of adjusting the spacing be-
tween certain character pairs to enhance readability

GLOSSARY-4
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and to visually equalize the spacing among all charac-
ters within a line. The amount of space added or sub-
tracted between certain character pairs is dependent
upon the font and point size.

Keyboard shortcut: Also called Fast keys. A special
one- or two-key combination that allows you to exe-
cute an option without using the mouse. Keyboard
shortcuts are shown on each menu beside the name
of the option and are listed in the “Keyboard shortcuts”
appendix.

Landscape: The orientation of a page or the fonts, lo-
gos, or images on a page. A landscape page is nar-
rower on the sides than on the top. See the definition
of portrait for a figure describing the orientation of
fonts on pages.

Menu: A list of options from which you make a selec-
tion to perform an action. A menu displays when you
select a menu title from the menu bar or from a win-
dow header, or when you click on an option.

Menu bar: The horizontal bar displayed at the top of
the Desktop from which you access pull-down menus.

Menu titles: Text that identifies a menu, displayed in
a window header or on the menu bar.

Message area: A bar just below the menu bar that
displays error messages or information about the ac-
tivity you are performing.

Metacode: The 9700 printer series Xerox-format print
stream.

Mouse button: A button on the top of the mouse. The
Elixir Desktop supports a mouse with one button. If
your mouse has more than one button, use only the
left button.

Multi-select: Selecting more than one file or icon by
shift-clicking on them.
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Open a folder, Elixir file, application, or peripheral
device: 1.) Opening a folder icon displays a window
showing the contents of the folder. 2.) Opening an
Elixir file icon starts the application that created the file
and loads the file . 3.) Opening an application icon
starts the application. 4.) Opening a peripheral device
displays a dialog box allowing you to set the device
parameters.

Option: A word or phrase in a menu that you can
select.

Peripheral (device): A printer, scanner, or tape drive
connected to your PC.

Point: To move the mouse so the screen pointer (in
most cases an arrow) rests on the desired item.

Portrait: The orientation of a page; or the fonts, lo-
gos, or images on a page. A portrait page is narrower
on top than on the side (like pages in this book). See
the following figure for the orientation of fonts on
pages.

Portrait
)
o ] =] Landscape
g 8 £ g
3 = S )
< ] =¥ a_
=1 2 [
3 73 4 B
gl | =
9 (5]
® —
adeospue asraauy
JTe1}I0J ISIIAUYL

Orientation of fonts on Portrait (left) and
Landscape pages

Printer icon: An icon representing a proof printer con-
nected to your PC.
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Printer palette: An ASCII text file resident on a printer
that contains up to 99 ink names (colors). Each color
is described by its combination of highlight color ton-
ers (pure red, blue, or green) and values for the den-
sity of black ink and white (paper color) which define
the shade and tint of each color.

Pull-down menu: See menu.

Raster graphics: Pictures composed of hit maps,
where each element of the picture is a dot defined as
black or white.

Replaceable parameter: A parameter (usually %1)
used in commands to represent a selected file name.
The selected file name replaces the parameter during
certain operations.

Run: To execute or start an application.

Scanner icon: The icon representing a scanner con-
nected to your PC.

Screen pointer: A pointer shaped like an arrow that
displays on the screen, and which you can move by
rolling the mouse on a flat surface.

Screen version: The version of a color or font com-
posed such that its appearance on a screen display is
as close as possible to its appearance when printed.
For example, gray scale colors have RGB values for
screen versions of the color that best approximate the
color when printed.

Scroll: To move a directory list in a window so you
can view different parts of the list.

Scroll bar: A bar displayed on the right side of some
windows used for scrolling. The scroll bar contains a
scroll arrow, [+] and [-] buttons, and a slider bar that
moves within the scroll box.

Select: To click on an object, menu option, or form
element. A selected item appears highlighted.
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Shade: The property of a color based upon the den-
sity of black ink dots mixed with the pure color (red,
blue, or green). The higher the density of black dots,
the darker the color. Not related to "shades of gray" on
decentralized printers.

Shift-click: To click on an object while holding down
the <Shift> key. Usually used to select multiple
elements.

Slider bar: A bar in the scroll box at the side of some
windows that scrolls items in the window when you
drag it up and down.

Snap to: A function that causes form elements to
automatically align with the nearest grid point when a
grid is displayed in the form work area.

Tape icon: The icon representing a tape drive con-
nected to your PC.

Tint: The property of a color based upon the density
of color toner dots (pixels) applied to the paper during
printing. The lower the density of the color pixels, the
lighter the intensity of the color. 100% density corre-
sponds to a pure color, and 0% corresponds to white.
For example, sparsely spaced red pixels would ap-
pear as the color pink on a page.

Trashbin icon: The Trashbin icon is in the lower right
corner of the Desktop and represents a receptacle for
items you want to delete. You delete a file by dragging
it to the Trashbin icon.

UDK: (User Defined Key) a substitute escape charac-
ter defined by a user for specific print jobs

Unselect: To cause one or more selected (high-
lighted) icons or elements to not be selected any
more. The quickest way to do this is to click on an-
other area of the Desktop or form work area.

UserTools icon: The icon that links applications to
files.
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Utilities: Special-purpose applications with which you
can perform functions from the DOS prompt. For ex-
ample, the ELIXIDISK utility allows you to read, write,
and format Xerox printer format diskettes.

Wildcard character: A character in a file name, usu-
ally an asterisk (*), that specifies a matching set. For
example, *.EXE represents all files that end with the
.EXE extension.

Window: A rectangular area on your screen in which
you view information, such the contents of a folder. All
windows contain a window header. Some windows
have scroll bars along the right side.

Window header: The top of a window that displays
the DOS directory corresponding to the window con-
tents. Some window headers also show a close box
and a number of menu titles with pull-down menus.

Xerox-labeled files: Files containing 128-byte Xerox
headers, or labels.

XES: (Xerox Escape Sequences) The data stream
format recognized by Xerox decentralized printers
(such as 2700, 3700, 4045, 4235, and 4700).
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A

adding multiple fonts,
6-17

B

boilerplate, 1-1

box borders
applying color,
4700-6
applying gray,
4235-5

box fills, HLC-5, 4235-5

Box toolbox, 5-6
box -
border/horizontal/ver
tical line thickness
and style, 2-7
box - color, 2-7
box - corner radius,
2-8
box - fill color, 2-8
box - horizontal split,
2-7
box - line style, 2-7
box - positioning,
2-6
box - shape, 2-6
box - vertical split,
2-7

box predefined

Index

custom line/border
thickness, 2-6, 5-7
diagonals, 2-6
fill color, 5-9
horizontal split, 5-7
line style, 5-7
line thickness and
style, 5-7
object fill/pattern
shading, 5-9
object fill
pattern/shading, 2-8
positioning, 5-6
predefined shape,
5-6
shape
oblong/square, 5-6
vertical split, 5-8
with diagonal lines,
5-7

boxes, 5-1
border, 4235-7,
4700-8
changing attributes,
5-10
changing size, 5-10
color, 4235-7,
4700-8
copying, 5-12
deleting, 5-13
drawing, 5-5
editing, 5-9
fill, 4235-5, 4235-7,

shape, 2-6 4700-7, 4700-8
color, 5-8 moving, 5-11
corner radius, 5-9
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C

Character Mapping Op-
tions dialog box, 3-8
color

changing, 7-3

palette, 4700-1,

4700-2

printing, HLC-1
color mode, 4700-1
color palettes, 4700-1
column height, 6-5
column width, 6-5
constructing a color
form, 4700-1
conventions, 1-4
copying

boxes, 5-12

images, 7-5

lines, 5-12
crosshair, 4-6
Current object - Dimen-
sions, 2-15
Current object - Shape,
2-15
Current object - Start
Coordinates, 2-15

D

default
settings, 4-7
Delete Form dialog box,
3-2
deleting
boxes, 5-13
images, 7-5
lines, 5-13
deleting a form, 2-27
deleting elements, 6-21
Desktop
Help, 1-6
Help menu, 1-6
dialog box
Character Mapping
Options, 3-8
Delete Form, 3-2

Filing Options, 3-4,
4-20

Find Text, 3-6, 6-22
GEM Forms Load
Defaults, 3-7, 4-16
Grid Setting, 2-16,

Import Text, 3-3
Load Form, 3-1
Load Form Group,
3-2
Load Form Tem-
plate, 3-2
Objects Off Page,
4-8, 4-10
Open Dat File, 3-3
Page Databasing,
3-8, 4-11
Page Properties,
3-1, 3-7, 4-7
Print, 3-3
Rename/Move
Form, 3-2
Replace Text, 6-23
Replace text, 3-6
Ruler Options, 2-16,
4-5
Save Form As, 3-2
Save Form Group,
3-2
Spell Check Op-
tions, 3-11
Template Options,
2-22,3-11
Text and Font Op-
tions, 3-8, 4-13
Usage Switches,
3-3, 4-18
Digital ruler, 2-15, 4-4
DocuMerge, 6-15
DocuTag, 6-15

E

Edit menu, 3-5
Copy1 3'5
Cut, 3-5

INDEX-2
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Delete, 3-6
Delete All, 3-6
Deselect All, 3-6
Find, 3-6
Find Next, 3-6
Find Previous, 3-6
Paste, 3-5
Redo, 3-5
Replace, 3-6
Select All, 3-6
Undo, 3-5
editing
boxes, 5-9
images, 7-3
lines, 5-9
elements
adding, 2-23
applying color,
4700-6
displaying selected,
HLC-8
editing, 2-25
excluding, 2-26
grouping, 2-25
shifting, 2-25
ElixiForm menu bar, 3-1
File menu, 3-1
Help menu, 3-5
System menu, 3-3
Window menu, 3-4
exit, 1-9
exiting, 2-40

F

fast keys, 2-40

File menu, 3-1
Close Dat File, 3-3
Delete Form, 3-2
Exit, 3-3
Import Text, 3-3
Load Form, 3-1
Load Form Tem-
plate, 3-2
Merge Form Group,
3-2
New Form, 3-1

Open Dat File, 3-3
Print, 3-3
Remove Form Tem-
plate, 3-2
Rename/Move
Form, 3-2
Save Form, 3-1
Save Form As, 3-2
Save Form Group,
3-2

filing options, 4-19

Filing Options dialog

box, 3-4, 4-20

Find Text dialog box,

3-6, 6-22

font
adding multiple
fonts, 6-17
changing, 6-16
conversion, 4700-12
load font list, 6-9
merging a font list,
6-9
replace, 6-17

font conversions,

4235-10

Font list, 6-8
adding fonts, 6-10
customizing, 6-10
loading, 6-9
merging, 6-9
removing fonts, 6-11
selecting, 6-9

font mapping table,

4235-9, 4700-11
inverse, 4235-10
INVFONTS.LST,

4135-3
P2LFONTS.LST,
4135-3

Font Preview Panel,

2-13, 6-8

form
color, 4700-1,
4700-14
deleting, 2-27
designing for enve-
lope, 2-19
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designing new, 2-19
loading, 2-19
merged data, 2-19
modifying, 2-24
moving, 2-28
renaming, 2-28
reproducing existing,
2-19
saving, 2-24
template defaults,
2-22
template loading,
2-22
using color, 2-23

forms
grouping multiple,
2-39

free text, 6-6

FSL, 1-2

G

GEM forms, 2-21, 4-16
GEM Forms Load De-
faults dialog box, 3-7,
4-16
Graphic ruler, 2-15, 4-4
selecting options,
4-5
graphics, 4235-10
black and white,
HLC-8
color, HLC-9
converting, HLC-8,
4700-9
gray patterns, 4235-2
gray shades, 4235-2
applying to ele-
ments, 4235-4
removing, 4235-4
grid, 4-1
displaying/hiding,
4-1
selecting properties,
4-2
use grid/inch, 4-6
Grid display, 2-16

Grid Setting dialog box,

2-16, 4-1, 4-2

grouping form elements,

2-25

groups
defining, 2-26
merging, 2-21
multiple forms, 2-39
saving, 2-26

H

help, 1-3

Help, on-line, 1-6

Help menu, 1-6, 3-5

HighLight color
forms, HLC-8
palettes, HLC-4
printing, HLC-1
replicant palettes,
HLC-11

Image toolbox, 7-2
image- name, 2-14
image - color, 2-14
image - fill color,
2-14
image - load, 2-14
image - size, 2-14

images, 7-1
.LP3, 7-2
.LW8, 7-2
changing color, 7-3
copying, 7-5
deleting, 7-5
editing, 7-3
loading, 7-1
moving, 7-4
toolbox, 7-1

Import Text dialog box,

3-3

importing text
complete blocks,
6-12
into a box, 6-15

INDEX-4
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separate blocks,
6-14
input tray remapping,
4700-12
inserting data tags, 6-15
installation, 1-9
inter-character spacing,
6-3
inter-word spacing, 6-3
INVFONTS.LST, 4135-4

J

joining text, 6-18

K

keyboard
shortcuts, A-1

L

landscape, 2-30
Line toolbox, 5-3
custom line/border
thickness, 2-5
direction, 5-3
line - color, 2-5
line - direction, 2-5
line - style, 2-5
line color, 5-3
line style, 5-3
line width, 5-3
lines, 5-1
applying color,
4700-6
applying gray,
4235-5
changing attributes,
5-10
changing size, 5-10
color, 5-3
copying, 5-12
deleting, 5-13
direction, 5-3
displaying, 5-1
drawing, 5-2

editing, 5-9
moving, 5-11
style, 5-3
toolbox, 5-2
width, 5-3
Load Form dialog box,
3-1
Load Form Group dialog
box, 3-2
Load Form Template
dialog box, 3-2
loading
.DAT files, 2-39
.LP3 images, 7-2
.LW8 images, 7-2
form template, 2-22
GEM forms, 2-21
images, 7-1
new forms, 2-20
saved forms, 2-20
local palette
adding colors,
4700-4
adding shades,
4235-3
loading, HLC-8,
4700-5
removing colors,
4700-5
removing shades,
4235-4
saving, HLC-7,
4700-5
Long Crosshair, 2-17
Long crosshair, 4-6

mapping files, 4135-3
menu bar

ElixiForm, 3-1

Work area, 3-5
menu bars, 2-18
menus

Help, 1-6
merging groups, 2-21
modifying a form, 2-24
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move form, 2-28
moving
boxes, 5-11
images, 7-4
lines, 5-11
multiple forms
editing, 2-39

N

non-standard charac-
ters, 6-11

o)

Objects Off Page dialog
box, 4-8, 4-10
on-line Help, 1-6
on-line help, 1-6
Open Dat File dialog
box, 3-3
Options menu, 3-7
Character Mapping,
3-8
GEM Forms Load
Defaults, 3-7
Page Databasing,
3-8
Page Properties, 3-7
Snap to Grid, 3-7
Spell Check Op-
tions, 3-11
Template Options,
3-11
Text/Font Options,
3-8

P

P2LFONTS.LST, 4135-3
page databasing, 4-11
Page Databasing dialog
box, 3-8, 4-11

page properties, 4-7
Page Properties dialog
box, 3-1, 3-7, 4-7

page shift, 2-30, 2-39,
4700-12

palette, HLC-2
applying, 4235-3
gray-scale, 4235-2
PC, 4235-1
paper size, 2-40,
HLC-10, 4700-1
large, 4135-1
paper sizes, 4235-9,
4700-10
pattern palette, HLC-5
pattern palettes, 4700-8
patterns, 4235-2, 4700-7
PC palette, HLC-2,
4235-1, 4700-1
applying, HLC-4,
4235-2
applying a, 4700-4
PC palette RGB values,
HLC-11
portrait, 2-30
print
disk file, 2-30, 2-39
Print dialog box, 3-3
print special dialog box,
2-35
printer, 2-29
palette, HLC-2
PCL 4, 2-29
Xerox 4700,
4700-13
printer setup, 4235-11
printing, 4700-10
printing grays, 4235-1,
4235-8
proof printing, 2-28
on full color printers,
HLC-11, 4700-13
print special dialog
box, 2-35

R

Redo, 2-17
Rename/Move Form
dialog box, 3-2

rename form, 2-28
Replace Text dialog box,
3-6, 6-23
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replicant palettes,
HLC-11
ruler, 4-4
digital, 4-5
display units, 4-5
graphic, 4-5
Ruler Options dialog
box, 2-16, 4-5

S

Save Form As dialog
box, 3-2
save form group, 2-26
Save Form Group dialog
box, 3-2
saving a form, 2-24
saving a palette, 4700-5
Select toolbox
copy, 2-3
copy - horizontal dis-
tance, 2-4
copy - vertical dis-
tance, 2-4
delete, 2-3
group filter options,
2-3
movement selection,
2-4
number of copies,
2-3
sticky lines, 2-4
shades, HLC-1
shifting elements, 2-25
Show/hide Toolbox,
2-18
Snap to Grid, 2-16
soft keyboard, 6-11
Spell Check, 2-18, 3-7,
3-11
Spell Check Options dia-
log box, 3-11
Spell checking, 6-24
setting defaults,
6-24
using, 6-27
starting ElixiForm, 1-9
static data, 1-1

sticky lines, 5-4, 5-12
System menu, 3-3
Filing Options, 3-4
Reset to Defaults,
3-4
Save Configuration,
3-4
Usage Switches, 3-3

T

template, 2-22
defaults, 2-22
Template Options dialog
box, 2-22, 3-11
Docutag/dataMerge
- data tags, 2-11
text
applying color, 6-5,
4700-6
applying gray,
4235-5
attributes, 6-3
boxed, 6-6
color, 6-4
copying, 6-20
creating, 6-1
cut and paste, 6-21
deleting, 6-21
editing, 6-15
finding/replacing,
6-22
free, 6-6
importing, 6-12
joining, 6-18
justification, 6-4
moving, 6-19
options, 4-13
splitting, 6-19
Text and Font Options
dialog box, 3-8, 4-13
Text toolbox, 6-3
add/remove font
from list, 2-12, 6-7
boxed text/free text,
6-6
color, 6-4
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column width and
height, 6-5

data tage - on/off,
6-5

draw column box
boundaries, 6-6

f, 2-12, 6-7

font preview panel,
2-13, 6-8
intercharacter/interw
ord spacing, 6-3
justification, 6-4
lines per inch, 6-4
load font list, 6-8
load font list/merge
font list/save font
list, 2-13

merge font list, 6-8
positioning, 6-4
remove redundant
spaces, 6-3

save font list, 6-8
soft keyboard, 6-8
split string, 6-3

text - column height,
2-12

text - column width,
2-11

text - direction, 2-8
text - draw column
box boundaries,
2-11

text - inter-
character/inter-word
spacing, 2-9

text - justification,
2-10

text - lines per inch,
2-10

text - positioning,
2-10

text - remove redun-
dant spaces, 2-9
text - set column
width/height to de-
fine box, 2-12

text - soft keyboard,
2-13
text - split string, 2-9
text - text color, 2-10
text - word wrap-
ping, 2-9
text direction, 6-3
word wrapping, 6-3
tints, HLC-1
toolbar, 2-15
current object - di-
mensions, 2-15
current object -
shape, 2-15
current object - start
coordinates, 2-15
digital ruler, 2-15,
4-4
graphic ruler, 2-15,
4-4
grid display, 2-16
long crosshair, 2-17,
4-6
redo, 2-17
showr/hide toolbox,
2-18
shap to grid, 2-16
spell check, 2-18
undo, 2-17
zoom in/out, 2-17,
4-6
Toolbox
displaying, 3-4
toolbox, 2-2
box tool, 2-6
image, 7-1
image tool, 2-14
line, 5-2
line tool, 2-5
select tool, 2-3
text, 6-1
text tool, 2-8
Tools menu, 3-7
Box, 3-7
Circle, 3-7
Image, 3-7
Line, 3-7
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Path, 3-7
Select, 3-7
Spell Check, 3-7
Text, 3-7
U
UDK escape character,
2-38
Undo, 2-17

undo/redo, 2-27

usage switches, 4-18
Usage Switches dialog
box, 3-3, 4-18

user preferences, 2-24,
4-1

Vv

variable/fixed data, 1-1
View menu, 3-7
Grid, 3-7

Long Crosshair, 3-7

Ruler, 3-7

w

Window menu, 3-4
Form, 3-4
Tile, 3-4
Toolbox, 3-4
Work area, 2-1
Work area menu bar,
3-5
Edit menu, 3-5
Options menu, 3-7
Tools menu, 3-7
View menu, 3-7

X

Xerox 4135 printer,
4135-1
Xerox 4235 printer,
4235-1
Xerox 4700 printer,
4700-1

Xerox HighLight color
printers, HLC-1

Xerox naming conven-
tion, 4135-2

Y4

zoom, 2-40
Zoom in/out, 2-17, 4-6
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